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TimberScan Introduction and Overview
 

TimberScan is designed to automate the Accounts Payable approval process.

 
TimberScan is tightly integrated with Sage 300 CRE and data entry in TimberScan works like data entry in Sage 300 CRE. 

 
TimberScan is also very flexible, providing many advanced features and setup options. 

 
TimberScan provides for two major workflows in processing and approving invoices:

 
1.     Invoices are entered into TimberScan and get posted into Sage 300 CRE after they have been approved.  This method

is by far the most popular.

 
2.     Invoices are entered directly into Sage 300 CRE.  Scanning and approving is done in TimberScan.  Only approved

invoices can get paid because TimberScan controls the approval flag.

 
Both methods can be used concurrently; however most companies choose one method to make operations easier.

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Invoices Entered Directly into TimberScan
TimberScan is a batch oriented system increasing efficiency and productivity.

 

 
Think of this workflow as a separate pending approval system. Invoices and supporting documents are scanned.  They then

flow to data entry (or Capture and than data entry).  Invoices are coded in TimberScan. Approvers can complete or correct

coding if they have the security rights.  Approved invoiced are posted directly into Sage 300 CRE Accounts Payable. 

 
The main benefits of this process are as follows:

 
1.     Only approved invoices are in Sage 300 CRE. Unapproved invoices cannot be paid.

 
2.     Data entry staff can partially code invoices for an approver to finish the coding. 

 
3.     Approvers can change coding provided that they have the rights to do so.

 



 

 

The only disadvantage to this workflow is that invoices are not in Sage 300 CRE immediately.  Some clients want costs to

reflect upon receipt of the invoice.  However TimberScan offers an Accrual Option which will create an accrual journal entry

in Job Cost and/or GL. 



 

 

 
Invoices Entered into Sage 300 CRE First

This option is often used by clients that have the Sage 300 CRE Purchase Order module, Service Maintenance or

Residential Management module.

 

 

 
 



 

 

NOTE:  The main disadvantage to this workflow is that corrections can only be done in Sage 300 CRE.  If the approver

disagrees with the coding of an invoice they must reject it back to data entry.  Data Entry must correct it in Sage 300 CRE. 

Then it will flow back for approval.

 



 

 

Preparing Information for Routing Rules
It helps to have an Approver Organization Chart.  One example might be:

 
                                                        

  

 
In the example above there are two people who enter invoices:

 
• A project A/P person and a corporate A/P person.  The Project A/P person enters invoices for three project managers. 
• The Job 1 project manager needs approval from Job Approver A.  Job 2 project manager and Job 3 project manager need

approval from Job Approver B. 
• On the Corporate side there is a controller who approves overhead invoices and a human resources person who approves

insurance invoices. 
• The president is the last level of approval for all invoices in this example.

 
Note: We strongly recommend that you use a TimberScan consultant to help you define your various workflows.

 
 
 
 



 

 

TimberScan Buttons, Symbols and Shortcut Keys
 
This section explains special symbols and buttons in Timberscan as well as shortcut keys.

 
Page Edits – Use Page Edits to rotate or straighten an image (among other features) as well as add annotations. Page

Edits are usually located on the right side of your display screen:

 

Page Edit Symbols

 

               Add pen notation

               Highlight in yellow

               Add a “Sticky Note” to the image 

            Delete all annotations 

            Rotate image left 90 degrees

            Rotate image right 90 degrees



 

 

               Rotate image 180 degrees

               Despeckle – sharpen – the image

               Auto deskew or straighten image

            Manual deskew

            To black to white – turn image positive or negative

            Remove holes – can only be applied to black & white (not color) images

            Remove border

Acquire Buttons

The following buttons are available at the top of the Acquire screen:

Acquire Symbols

       Remove the current image page highlighted

          Remove all pages displaying in the Acquire screen (If you accidently brought in the wrong file you can

delete the entire                                          batch from Timberscan here.)

        Remove all markers made (to start over); can be used to remove checks and supporting documents,

not just invoices

             Move to the previous or next image

       Start a new invoice with the selected image

 



 

 

Floating Taskbar - The floating taskbar is available throughout Timberscan. Use it to navigate through multiple image

pages. A description of each icon appears when hovering the mouse over it.

 

 
Taskbar Symbols

      Pin the taskbar to your screen (to disable auto-hide)

      Move to the first page

      Move to the previous page

      Pan mode

      Zoom mode (in small, defined increments)

 

      Zoom out

 

      Zoom in

 

      Resize image to fit window

 

      View image at original size (super size)

 

      Next Page

 

      Last Page

 



 

 

Invoice Entry Buttons – Most of the same buttons display in Invoice Entry, Approve and Final Review. Some buttons

will/will not display depending on the user’s security.

 
The following buttons are available at the top of the screen:

 
Invoice Entry/Approve/Final Review Symbols

            Move to the previous or next invoice

 

               View the invoice in full screen mode (without data entry grid)

 

                 Remove a page of an invoice

 
 

                  Look up job history (in Timberscan and Sage 300 CRE)

 

                  Place an invoice on hold (limited by security)

 

                     Print the invoice

 

                  In Invoice Entry, route the invoice to a different company data folder or to a different data entry group;

in Approval, route                                              the invoice to a different approver; in Final Review, route to a different Final

Review group

 
 

                  Attach an additional image to the invoice (backup such as a packing slip, etc.)



 

 

 

               Add an internal note to the invoice that automatically pops up throughout the approval process

 

           View invoice notes or the invoice log

 

      View metadata pertaining to the invoice

 

     Select to maintain the size of the image in this and future entry sessions

 
 

     Select to display thumbnail images of the invoice on the left side window

 
The following buttons are available at the bottom of the Invoice Entry screen:

 
Invoice Entry Symbols

 

                    Add a joint vendor to the invoice

 

                    Display a list

 

             Calculate a tax percentage or tax amount (only available in a tax field)

 



 

 

               Use a calculator (only available in a numeric field)

 

          Display line items on a commitment

 

       Cancel & remove all distribution lines

 

              Change the invoice type

 

            Delete the selected distribution line

 

               Mark a distribution 1099-exempt

 

            Display a list of coded supporting documents matching coded information

 

            Mark the invoice as “unapproved” in Sage 300 CRE Accounts Payable

 

                Display vendor history (in Timberscan and Sage 300 CRE)

 

                Email the invoice

 

          Delete the invoice – the invoice will be deleted and stored in the Deleted Invoice Inquiry. From there,

the image can be                                                retrieved and re-acquired if desired. The invoice header information (no

distribution data) is saved.



 

 

           Reject invoice; a pop-up screen displays possible levels as well as personnel who should receive the

rejected invoice - only                                    individuals who have processed the invoice will be displayed as choices

               In Invoice Entry, accept the invoice before it can be processed

 

             In Approve, approve the invoice to process it forward in the routing course

 

     In Final Review, queue the invoice to send it to the export queue for export to Accounts Payable

 

               Leave Invoice Entry or Approval and process all accepted/approved invoices

 

     Move to the previous or next invoice

 
 
TIMBERSCAN SHORTCUT KEYS

To enable underscore for shortcut keys, hit the [Alt] key on the workstation keyboard first. An underscore will display beneath

the shortcut letter.

 
Hold – Alt + H

Job History – Alt + B

Print – Alt + R

Route – Alt + T

View Image Date – Alt + I

View Notes – Alt + V

 



 

 

 
Accept – Alt + A

List – Alt + L

Joint Vendor – Alt + J

Calculate – Alt + U

Cancel – Alt + C

Commitment – Alt + M

Delete invoice – Alt + D

Delete row – Alt + W

Email – Alt + E

Exempt – Alt + X

Finished – Alt + F

History – Alt + Y

Next – Alt + N

Previous – Alt + P
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Maintenance Options
 
TimberScan Maintenance is performed by signing in as an administrator.  See your administrator for the login and

password. 

Signing in as an user with administrative permissions gives you menu options otherwise unavailable in

TimberScan. You need administrative permissions to set up new users with their roles and permissions.
 
 

 
 
 
 
 

                        

 
 
    

                                                  .                                                                                        

 
 
            .

   

 
 
          

 
 
 



 

 

 
 
 
 
 
 
 
 



 

 

User Roles
 

 
Click on Maintenance to begin setting up users/operators.

 
Start by setting up roles for different user types. For example, you can establish a role for data entry operators and a

separate role for approvers as well as roles for accounting final reviewers and users who will have administrative functions.

 
 

 
 
On the User Roles window, simply enter a name for the role and select Save:

 
 

 

 



 

 

Roles Permissions
The next step is to give permissions to each role. Once a role has been defined and given permissions, you can assign a

role to multiple users. This way you need only select permissions one time and assign them to multiple users. For example,

after you have assigned permissions to a data entry operator, you can assign that role to multiple TimberScan users. The

permissions automatically migrate with the role.

 

 
 

The roles permissions window displays multiple groups of permissions. Within each group you will find a list of permissions

to select.



 

 

 
 
NOTE: One role can have standard permissions only; or a role can have administrative permissions only; or one role can

contain both regular user as well as administrative permissions. Be selective with whom is given administrative permissions.

 
 

  Once you have completed setting up the permissions for a user role, press [Save] to save the information.

 



 

 

Invoices Permissions Group
There are 10 TimberScan and 1 Capture permission associated with this group:

 

 
Acquire Invoices:     This allows a user to acquire invoices, checks (not used with Auto-Attach Checks) or supporting

documents for entry into TimberScan. Acquiring is done by scanning directly into TimberScan, retrieving previously scanned

images from a file or dragging and dropping either a file or email attachment into the image viewer.

 
Approve Invoices:***  Allows the user to approve invoices. Only users with this ability can be added to an Approval

Group.

 
Change Invoice Amount:  Allows the user to only change the amount in the invoice header and not change any other

header fields.

 
Change Invoice Header:   Allows the user to change invoice header information. Headers contain information on the

invoice, such as invoice date, discount date, payment date, etc.

 
Delete Invoices:    Users with this permission are allowed to delete invoices from the TimberScan system. It is

recommended that data entry operators only be given this permission. If an approver decides that an invoice should not be

paid, he or she can reject it back to the data entry operator for deletion. It should be noted that invoices are only marked as

deleted in the system, and a reason is required when making the deletion. Deleted invoices can be viewed by a Supervisor

or Executive using the Deleted Invoices Inquiry.



 

 

 
Enter Invoices:***     All data entry personnel who will be entering invoices into TimberScan will need to have this checked. 

 
Invoice on Hold:  Gives the user the ability to Hold an invoice in TimberScan. This Hold status only affects TimberScan and

the hold can not be released by anyone but the user who put the invoice on hold.  It might be useful when the user needs

more information about the invoice and wants the invoice to be separated. 

 
Invoice Status Inquires:  Allows the user to see the status of invoices in TimberScan. 

 
Process Capture Invoices: *** This designates a Capture user - a user who has the rights to process invoices in Capture.

This requires a separate license. For more information, please see the chapter on Capture.

 
Recurring Invoices: Allows the user to import recurring invoices created by Sage 300 CRE Accounts Payable into the

TimberScan approval system, if those invoices require approval.

 
Reject Invoices:  This permission allows users to reject invoices to a previous approver or data entry operator and should

be given to all users who will be approving. It may also be given to users who will be performing the final review if  you want

them to have the ability to reject fully approved invoices.

 
 
*** IMPORTANT Exercise caution when changing any of the below permissions once they are assigned to a user.............

 
1.     Approve Invoices (if user is a part of one or more approval group)

2.     Enter Invoices(if user is a part of one or more data entry group)

3.     Final Review (if user is a part of one or more final review group)

4.     Process Captured Invoices

 
.......... these 4 permissions will generate a warning when unchecked on an existing role. The reasoning: if we update

an existing role in Role Permissions and the role is already assigned to a user, that user's permissions (in User

Maintenance) will also get updated according to the Role Permissions. So if a user is already assigned any one or

more of these 4 permissions and we update this user's role without selecting these 4 permissions, user permissions will

be overwritten and the user will no longer be allowed to Approve Invoices, Enter Invoices,etc. These permission should be

changed per user in User Maintenance.
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AIM Permissions Group
For a detailed explanation of AIM permissions, see the chapter on AIM - TimberScan's Advanced Image Management

system.

 



 

 

Import Permissions Group

 

 
Import Invoices:     This permission allows the user to import invoices and match them with the scanned image. It is

frequently used by companies that use and are entering invoices into the Sage Timberline Office Service Management,

Purchase Order/Inventory systems or use the recurring invoice feature in Accounts Payable. This method is also used

when invoices are entered directly into Sage 300 CRE Accounts Payable. It can also be used for 3rd party products such as

Builder MT or to import data from a csv format.

 



 

 



 

 

Other Permissions Group
This group contains a mix of permissions for a regular user as well as an Administrative user:

 

 
Add Images:       Allows the user to add invoice images to an invoice on the fly during the Invoice Entry, Approval or Final

Review processes.

 
 

Add New Codes:   This permission is used in conjunction with the To-Do List. It allows users to add new GL Accounts,

jobs, cost codes, or categories "on the fly". The new codes are added to the To-Do List and can be imported into Sage

300 CRE Job Cost.

 
Allow Hold in A/P:   Normally invoices posted to Sage 300 CRE from TimberScan are automatically “Approved“ so they

are available to be Selected for Payment in Sage 300 CRE Accounts Payable.  Invoices marked Hold  in A/P are not on the

payment list; they require approval in Sage 300 CRE. With this feature, invoices cannot be inadvertently paid. 

 



 

 

Annotations:     Allows the user to write, draw, highlight or add sticky notes and other annotations to the invoice. 

 
Approval Group Maintenance:     This is an Administrative function. Please refer to the chapter on Approval Group

Maintenance on how to set up approval workflows and approval criteria.

 
Approval Page Maintenance:     This, too, is an Administrative function that is no longer necessary. Previously, the

location of the approval stamp page  in the invoice packet could vary. This function moved the approval stamp page always

to page 2 so it could be omitted when creating pdf files. Now the program tracks metadata on each page associated with an

invoice, automatically identifying the invoice image from a supporting document or attached check or approval stamp page.

 
Attach Checks/EFT:   Allows the user to attach scanned checks to paid invoices. This also gives the user permission to

process EFT notifications to invoices.

 
Auto Deskew with Prompt: When checked, the Auto Deskew prompt is activated.

 

 



 

 

Change Distributions:  Allows the user to change distribution data. Distribution data can be the job, cost code,

commitment, tax code, GL account, etc.

 
Change Type:  Allows the user to change the user-defined invoice type when acquiring, entering or approving invoices. 

 
Dashboard View Only: Allows a user to view invoices via the Dashboard but not have the ability to make any changes to

invoices.

 
Email System:  Users with this permission will be able to email invoices from within the TimberScan Data Entry/Approval/

Final Review screens as well as from the invoice inquiry screen. For example, you could email the vendor of an invoice a

question while you are working with the invoice. 

 
Exempt 1099:      Allows the user to mark an invoice as exempt from 1099 tax reporting.

 
Final Review: ***       Allows the user to perform final review for invoices after they have been fully approved and to queue

them                                                 for export to Sage Timberline Office Accounts Payable. Only users with this ability can

be added to a Final Review Approval Group. 

 
Hide Deskew Prompt: This option hides the Auto Deskew checkbox as an option in Acquire. When checked, Auto Deskew

is grayed out.

 
Job Cost Inquires:  Users can view invoices in Sage 300 CRE and in TimberScan, subject to security on jobs assigned to

TimberScan users.

 
Joint Checks:      Allows the user to enter a joint payee for invoices.

 
Logged In: This box is automatically checked when a user is currently logged into TimberScan.

 
Print Reports:     Users with this permission can print and view TimberScan reports that show which invoices are assigned

to each user an/or user groups in TimberScan.

 
Regular Inquiries:  Users can view invoices in Sage 300 CRE and in TimberScan, subject to security on the General Ledger

prefix assigned to TimberScan users. 

 



 

 

Remove Images:     Allows the user to delete invoices or supporting documents for existing invoices.

 
Report Maintenance: This is an Administrative function. Please see the chapter on Report Maintenance.

 
Review Checks: This is used primarily by Check Signers. After entering  the check number, the associated invoices

included for payment appear on screen.  This mimics the manual process of being given a check with all associated invoices

attached. 

 
To Do List:     In Sage 300 CRE,  users have the ability to add jobs, cost codes or categories to a job “on the fly”. They also

have the ability to similarly add new GL  Accounts to a company. Because of Sage 300 CRE security restrictions, no third-

party application (such as TimberScan) has this ability. To get around this restriction, TimberScan adds these new jobs, cost

codes, categories and GL Accounts to a To-Do-List. The To-Do-List items can be exported to Sage 300 CRE adding the

new jobs, cost codes and categories by using the Add New Codes button next to the To Do List. GL accounts, due to Sage

security,  must be set up manually in Sage 300 CRE. Newly added records must exist in Sage 300 CRE before invoices can

be exported from TimberScan.

 

 
Update Images: Allows the user to add or replace invoice images for existing invoices.

 
Vendor Inquires:  User can view all invoices for specific vendors or all vendors by a date range. NOTE: TimberSync must

be active.

 
View All:     Selecting “View All” overrides the specific security built into other inquiries and allows the user to see all

invoices. 

 



 

 

View Vendor History: Allows the user to view all invoices for the vendor whose invoice is being coded, approved or

reviewed.  It is not filtered by job or property so you may not want to give the approver this option.  This includes both

invoices from Sage 300 CRE and TimberScan.

 
*** IMPORTANT Exercise caution when changing any of the below permissions once they are assigned to a user.............

 
1.     Approve Invoices (if user is a part of one or more approval group)

2.     Enter Invoices(if user is a part of one or more data entry group)

3.     Final Review (if user is a part of one or more final review group)

4.     Process Captured Invoices

 
.......... these 4 permissions will generate a warning when unchecked on an existing role. The reasoning: if we update

an existing role in Role Permissions and the role is already assigned to a user, that user's permissions (in User

Maintenance) will also get updated according to the Role Permissions. So if a user is already assigned any one or

more of these 4 permissions and we update this user's role without selecting these 4 permissions, user permissions will

be overwritten and the user will no longer be allowed to Approve Invoices, Enter Invoices,etc. These permission should be

changed per user in User Maintenance.

 
Invoice Permissions Group                                                                           Other Permissions Group

 



 

 

         

 
 



 

 

User Maintenance Permissions Group
 
User Maintenance is an Administrative function with the following permissions:

 

 
Permission Inquiry:     This gives the user access to the Permission Inquiry which acts as an audit trail on changes made to

users, roles and permissions.

 

 
Role Permissions:     A user with this function is allowed to add/modify/delete permissions assigned to user roles.

 
User Group Maintenance:     A user with this permission can add/modify/delete user groups.

 
User Group Members:     This gives a user the ability to add/delete users assigned to user groups.

 
User Maintenance:     A user with this function can add/modify/delete/disable other TimberScan users and change the user

type.

 



 

 

User Roles:     A user with this permission can add/delete user roles.

 
 



 

 

User Permissions Update Group
 
 This Administrative function gives a user the ability to update user permissions if jobs, properties or GL accounts are

reassigned to a different approver.:

 

 
 

 
 
 
The update will typically occur when those items are moved to the new approver.

 
This feature also allows for updating all users to the current permissions.

 
 

                                 



 

 

Approval Group Permissions Group
 
This Administrative function gives a user the ability to add/modify/delete approval criteria as well as approval workflows

used in automatic routing. Please see the chapter on Approval Group Maintenance.

 

 



 

 

Invoice Type Permissions Group
 

This Administrative function gives a user the ability to add/modify/delete approval criteria as well as approval workflows

used in automatic routing. Please see the Invoice Type chapter under admin > Maintenance.

 

 



 

 

Supporting Documents Settings Group
 
These two Administrative functions control (1) the fields that display for coding on supporting documents and (2)

customized options for displaying supporting documents. For detailed information, please see the Supporting Documents

chapter.

 

 
 



 

 

AIM Maintenance Permissions Group
 
These  Administrative functions are used to set up AIM functionality and workflow. For detailed information, please see the

AIM Setup topic within the AIM chapter.

 
 
 



 

 

Import AP Invoices/Import GL Accounts Permissions
 
These two Administrative options can provide a major performance boost. For a detailed explanation of each selection,

refer to the chapter under Maintenance > Import.

 
NOTE: We recommend that you try TimberScan data entry first and only utilize this feature if performance is slow. 

 

 
 
 
 



 

 

Report Maintenance Permissions Group
 
This Administrative function gives a user the ability to add/modify/delete Crystal reports to the reports menu in TimberScan.

See the Report Maintenance section under Set Up > Maintenance Options to learn how to add reports to the Reports Menu

in TimberScan.

 

 



 

 

Invoice Maintenance Permissions Group
 
This Administrative function gives a user the Repair Invoices function. For detailed information on how to use this function,

see the Invoice Maintenance section under Set Up > Maintenance Options.

 

 

 
 



 

 

Approval Page Maintenance Permissions Group
 
This Administrative function lets the user move the approval stamp page to page 2 of the invoice packet.

 

 
 

 
This functionality is no longer needed. Previously, the location of the approval stamp page  in the invoice packet could

vary. This function moved the approval stamp page always to page 2 so it could be omitted when creating pdf files. Now

the program tracks metadata on each page associated with an invoice, automatically identifying the invoice image from a

supporting document or attached check or approval stamp page. Therefore there is no need to move the approval page to a

unique location - metadata identifies which page is the approval stamp page.



 

 

Invoice Routing Permissions Group
 

There are two optional, user-based routing functions are available in Invoice Entry to (1) manually route invoices within data

entry or to (2) manually route to an approver.

 

 

 
Invoice Routing: 

 
• From Invoice Screen:  is used if you have more than one data folder, allowing you to transfer an uncoded invoice

images from one data folder to another.  Invoices to be transferred cannot contain any coding information. 

This also allows you to transfer an invoice from one data entry group to another when using multiple data entry

groups. 

 
•



 

 

After Invoice Accepted:  is used to "manually" route an invoice to an approver. This overrides established

automated routing rules

setup in TimberScan admin. 

 



 

 

Supporting Documents Permissions Group
 
These two optional settings give a user permissions to attach supporting documents.

 

 

 
Supporting Docs:

 
• Attach SD in Approval:  allows approvers to attach supporting documents to invoices 

 
• Attach SD in Final Review: allows final reviewers to attach supporting documents to invoices

 



 

 

Compliance Warnings Permissions Group
 
These two optional settings - per user - control the compliance warnings display in Approve and Final Review. Compliance

warnings automatically display in Invoice Entry according to Sage settings.

 

 

 
Compliance Warnings:

Based on your settings in Sage 300 CRE, TimberScan can warn you during Invoice Entry when an invoice. vendor

or job is out of compliance. (See Timberline Help for more information on specific compliance issues.) If you want

the warnings to automatically display at the Approval and/or Final Review levels, check these permissions. 

 



 

 

 
• Show in Approval - allows this user to see the warnings in Approval.

If this is NOT checked the user will see NO warnings in Approval.

 
• Show in Final Review - allows this user to see the warnings in Final Review.

If this is NOT checked the user will see NO warnings in Final Review.



 

 

Overage Warnings Permissions Group
 
These two optional settings - per user - control when overage warnings display. These warnings can automatically display

(or not) according to your settings in Sage.

 

 

 
Overage Warnings on Invoice Load:Similar to compliance warnings, this option allows for enabling or disabling over

estimate and/or over commitment warnings that are established in Sage 300 CRE Accounts Payable.  If you want those

warnings to occur at the Approval and/or Final Review level as well as Invoice Entry, you set that here. These warnings will

always display during Invoice Entry when they are set to 'Warn' or 'Error' in Sage. When the boxes to ‘Show in Approval’

and/or ‘Show in Final Review’ are checked and the warning message settings in Accounts Payable are set to ‘Warn’ or

‘Error’, the overage warning will automatically pop up when the invoice is initially loaded. With the boxes unchecked and

with the same settings in Sage, an overage warning will only display when the user tabs through the invoice distribution

grid (the assumption is that the user is viewing or changing the data).

 



 

 

The message will display only if the total amount invoiced is more than the revised commitment or estimate plus the

tolerance amount. If you enter zero tolerance, the message will display when the total amount invoiced exceeds the revised

commitment or estimate. With the warnings boxes unchecked, no warnings will display in Invoice Entry, Approve and/or

Final Review when the warning message settings in Accounts Payable are set to ‘No Message.' See Timberline Help for

more information on these warnings.

 
 

 
 

• Show in Approval - allows this user to see the warnings in Approval.

If this is NOT checked and with the same settings in Sage, an overage warning will only display

when the user tabs through the invoice distribution grid (the assumption is that the user is

viewing or changing the data). If checked, the warning displays as soon as the invoice is loaded.

 
• Show in Final Review - allows this user to see the warnings in Final Review.

If this is NOT checked and with the same settings in Sage, an overage warning will only display

when the user tabs through the invoice distribution grid (the assumption is that the user is

viewing or changing the data). If checked, the warning displays as soon as the invoice is loaded.



 

 

 



 

 

Inactive Equipment Warning Permissions Group
 

This is another Sage warning that can be overridden when the user is given this permission.

 

 

 
 

Inactive Equipment - Allow Warning Override: Allows this user to enter an invoice coded to equipment listed as inactive in

Sage 300 CRE Equipment Cost.

 



 

 

 



 

 

 
Recommended Role Permissions:

 

    
 
 
 
 
 
 
         

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Is Mobile User: When checked, the user has been configured to use TimberScan's mobile application to approve invoices.

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 for an explanation of Deskew options, see our chapter on Capture.

 

 
 

 
 

 



 

 

 



 

 

Suggested User Settings – Data Entry Operator

 

 
 



 

 

Suggested User Settings – Approver
 
 
This configuration will allow the user to make changes to invoices during the approval process.

 
 If this feature is not desired then the Change Invoices Header or Change Distributions checkbox should be unchecked.

 
 



 

 

 
 
 (NOTE: Approve Invoices checkbox is grayed out because this user has been assigned to one or more Approval Groups or

User Approval Groups.)

 
 
 



 

 

Suggested User Settings – Accounting Supervisor
 
This configuration will give the user wide latitude to administer the daily operation of TimberScan without being able to

perform override approvals for other users.

 

.

 



 

 

 
 



 

 

Suggested User Settings – Controller or Owner/Partner
 



 

 

User Maintenance
 
To set up a new user, open User Maintenance > User Maintenance.You should have roles set up before setting up new

users. A role is a required field.

 
 

 
Select the ADD button.  All the fields will turn white.

 

 
 

User ID:  Enter a USER ID for the user (8 characters max).  This can be the same as the user's Sage 300 CRE user ID but

this naming convention is not required. 

 
NOTE:  TimberScan users do not have to be set up as users in Sage 300 CRE, however, they must have Sage 300 CRE

installed on their workstations for TimberScan to function. 

First Name:  Enter the user's first name, up to 15 characters.

 
Last Name:  Enter the user's last name, up to 20 characters.

 



 

 

Email:  Enter the user's email address.  This can be used for notifications to TimberScan users when they have invoices that

need approval, etc.

NOTE: With the release of TimberScan's Mobile application, following changes apply to email addresses:

#     If a user is not a mobile user, no email address is required.

#     If a user is a mobile user, you must enter a unique email address.

#     If an existing user’s record needs to be edited in any way AND there is an email address present, that email

address must be unique in order to save the record.

 

 
A new user with an invalid email address will not be saved in User Maintenance.

 
 
Password: Enter a password for the user.  Passwords must be 6-8 characters in length; they do not need to be the same as

a user's Sage 300 CRE password.  NOTE: You may also enter "Password" here and the user will be prompted to change

his or her password when they first log in. 

 
Notification Method:  Select a method for the user to be notified when he or she has new invoices to enter, approve or

review.  There are two options to choose from:  (1) "email" or "No Notifications". 

 



 

 

 
Special Permissions:      

 
• None is the default.  Most users will not need special permissions.  All of their daily tasks can be assigned using the

regular permissions settings (see below). 

 
Supervisor:  Has access to the Utilities menu and Deleted Invoices Inquiry. Users with "Supervisor" permission will

have access to invoices for all jobs and properties if they are also given "View All" (below in permissions).  Supervisor

and Executive permissions gives the user access to the Utilities Menu to process Accruals, Close Accounting Periods,

Change Accounting Periods and Verify Export Batches. 

 

 

 
 

Executive:  Have access to all invoices with View All AND access to the Utilities menu and Deleted Invoices Inquiry as

well as the ability to approve invoices for all approvers.  In addition, they can override the approval routing system by

completing the invoice approval process for an invoice. 

 



 

 

 
For Example:  An approval hierarchy has been set up with three levels of approval. An Executive user is approving

on behalf of the first level approver and has specified that invoices are to be considered fully approved.  Once he or

she approves an invoice, it will bypass the next two approvers and go directly to Final Review or the Export

Queue upon approval.

 
User Type:

 
There are three types of users from which to choose: Disabled, Regular or AIM Search Only. A Regular user has access

to TimberScan and AIM permissions. Disabling a user frees up a license and decreases the number of User Accounts

Enabled . The user can no longer log into TimberScan. Changing a user from disabled to regular increases the number of

User Accounts Enabled. An AIM Search Only user does not affect the number of User Accounts Enabled. Starting with the

3.8.5 release, you can now have an unlimited number of AIM Search Only users. The AIM Search Only user can only log in

and use AIM Search. These users are subject to AIM security in their searches.

 
 

 
Role:

 
A role is required for a user. Select the appropriate role for this user from roles previously set up in Maintenance > User

Roles. The role contains the permissions granted to the user. You can customize a user by modifying the permissions that

migrate from the role by opening the Permission Group and checking or unchecking individual permissions.

 



 

 

 
 
NOTE: Existing users (prior to release 3.8.7.x) automatically migrate to a role labeled Default which contains all of the

existing user permissions.

 
CAUTION: If you give a NEW user the Default role, that user gets ALL permissions checked automatically.

 



 

 

User Groups
 

The purpose of User Groups is to allow flexibility in assigning responsibilities for performing tasks in

TimberScan. 

 

 

 



 

 

 
 
The main benefit of using groups is to provide flexibility. For example, a project or property manager group would

allow you to assign the PM as a primary approver and an assistant as an alternate approver who could approve

invoices if the PM is not available.

 
Additionally it can be used if there are multiple persons who can interchangeably enter, approver or final review

invoices at a given level. For example, setting up users as primary approvers in one group will any any of them to

  approve invoices that have been routed to the group.

 
 
The number of Data Entry and Final Review groups required for your organization depends upon how many

people will be entering/reviewing invoice. If there is only one user, only one Data Entry and one Final Review

group is necessary. If we look at our organizational chart below two Data Entry groups – one for A and one for B

– are required. The president can belong to both groups.

 
 



 

 

 
 
 



 

 

 
User Group Maintenance

 
 

 
If all data entry operators share the responsibility for all invoices equally, you only need one Data Entry Group,

and all the data entry operators can be assigned to it. 

 
If the various operators or groups of operators each have responsibility for certain invoices, such as for particular

properties or jobs, then a Data Entry User group will be required for each such operator or responsible group. 

 
The most common configuration for Final Review is to create one such group for each Data Entry group and

assign the same users to them (more about that in the User Group Members section). Another configuration

that is not uncommon is to have one Final Review Group to review all invoices, typically by an accounting

supervisor. 

 
 
Note:  A user with the Executive Special Permission can approve invoices for an approver when the approver is

not available and an invoice needs to be approved.  This would not require the use of Approval Groups.

 
 
Action Type :

 
1.      Data Entry:  It is required that the Data Entry function be performed by user groups rather than named

users, even though a group can consist of only one user.



 

 

2.      Approve:  Approvals can be performed by either an Approval User Group or by named approvers.

  You can                                                                                                                                  

              have more than one Group but it is not required.

3.       Final Review:  Like Data Entry, the Final Review function must be assigned to a user group rather

than a named user.

The number of Data Entry and Final Review groups that are required for your organization depend upon how

many people are currently entering invoices in A/P.  If there is only one user, you need only one Data Entry

and one Final Review Group.  If we look at our Organization Chart from earlier, we would need two Data Entry

Groups, one for Data Entry A and one for Data Entry B.

 
 

 
Deactivate:      Once a User Group has been used, it cannot be deleted. However, when a User Group is

no longer required, you can mark a user group inactive. The user group must be removed from all approval

workflows and no invoices can be pending in the group.

 
Email:     When Email Monitoring is activated and email settings have been entered, Auto Acquire will need to

be configured for each Data Entry user group where the Auto Acquire service should monitor incoming emails.

See the section entitled Email Monitoring.

 



 

 

User Group Members
 
Once you have defined the User Groups you can add Users to their respective User Groups.

 

The following screen will be displayed:

 
 



 

 

 
 
 
 
 



 

 

 
 

 



 

 

 
User Permissions Update

 

 
This feature allows you to update the User Permissions when jobs, properties or accounts are reassigned..

 
The update will typically occur when those items are moved or added to the approver.

 
This feature also allows for updating all users to the current permissions.

 
 

                                 

 
 
NOTE: When an approver chooses to select invoices for a specific job and not all jobs display in the approver's queue, run

the User Permissions Update.



 

 

Approval Group Maintenance
 
Approval groups are the hierarchies (workflow) of actions (Data Entry, one or more Approvals and Final Review)

that control how invoices will be routed through TimberScan.

 
 



 

 

Approval Workflow
 
From Approval Group Maintenance > Approval Workflow

 
 

 
 

 
 
The following screen will display a DEFAULT approval workflow group which is required.

 

 



 

 

 
 

 
 
 



 

 

Setup the Default Approval Group First
 

When an invoice is routed to a user for approval from the DEFAULT approval group, a message is displayed,

informing the operator that the invoice was routed to the Default approval group.  The recommended method

of dealing with these invoices is for the administrator to take the appropriate corrective action, which usually

means adding the job or property to an approval group using the Approval Group Criteria function, then rejecting

the invoice back to the data entry operator for coding.  Or, another option is to approve the invoice so it can move

forward to the proper approver for coding. 

 
For the Default group the Group ID must be DEFAULT.  It can be given any description, and it is recommended

that only one approver be defined - the TimberScan administrator. 

 
 



 

 

 
 
 



 

 

 
Defining Approval Group ID's

 

 
GROUP ID AND GROUP DESCRIPTION

Enter a Group ID (10 characters max) and Group Description for the group. It should be noted that the Group ID

is used internally by TimberScan; users will see the Group Descriptions when referencing the approval workflow

groups.

 
 
USE GROUP  (CHECKBOX)

Note also that the Use Group checkbox has been checked and disabled for the Data Entry and Final Review

actions. These actions must be performed by user groups rather than named users. (See the section above on

User Groups Maintenance.) This checkbox has been enabled for the Approve actions since approval can be

done by user groups or named users.

 
THRESHOLD*



 

 

If an approver only wants to see invoices over a certain dollar amount, a threshold can be set so that the

approver is skipped for invoices less than the specified amount. The invoice always routes to the first approver.

Afterwards, TimberScan evaluates the invoice at each level. You can set a threshold amount for each approver.

When the invoice amount is less than the threshold, the invoice skips all other approvers and goes to Final

Review. When the invoice amount equals or is greater than the threshold amount, the approver is not skipped.

After that approver approves the invoice, TimberScan looks at the next threshold to determine if it should route to

or skip the next approver. If the invoice equals or is over the threshold, the invoice moves on to the next approver

and so on. If the invoice is less than the threshold, the invoice goes to Final Review.

 
NOTE: The final approval level cannot have a threshold associated with it as this would be unnecessary.

 
* To illustrate further, let’s take some invoice examples and apply to the Approval Workflow shown above.

 
Invoice 1 for $5,000

·     After being coded by data entry, the invoice will route to Doug Moffet according to the coding and approval

criteria. 

·     Once approved by Doug, the invoice routes to the next approver - Harvey Syan.

·     After Harvey approves, the threshold at Harvey's level is evaluated.

·     Because the invoice amount is under the $7000 threshold, it will not forward to any other approvers. It will

route directly to Final Review.

 
Invoice 2 for $7,500

·     After being coded by data entry, the invoice will route to Doug Moffet. 

·     Once approved by Doug, the invoice routes to Harvey Syan.

·     After Harvey approves, the threshold is evaluated. Since the invoice amount exceeds the $7000 threshold at

Harvey's level, it will forward to Michael to approve.

·     Michael Perkins then approves the invoice. Since he has a threshold of $10,000 at his level, only invoice

amounts that are $10,000 or greater will move forward to Sally to approve. Because Sally will not receive any

invoices under $10,000, the invoice routes to Final Review.

 
Invoice 3 for $10,000

·     After being coded by data entry, the invoice will route to Doug Moffet. 

·     Once approved by Doug, the invoice routes to Harvey Syan.



 

 

·     After Harvey approves, the threshold is evaluated. Since the invoice amount exceeds the threshold at

Harvey's level, it will forward to Michael to approve.

·     After Michael approves, the threshold is re-evaluated. Because the invoice amount equals the threshold

amount at Michael's level, the invoice routes to Sally.

·     Once Sally approves the invoice, the threshold is evaluated again. Because the threshold at Sally's level is

$20,000, the invoice will skip  Approve 1 and route directly to Final Review.

 
Invoice 4 for $20,000

·     After being coded by data entry, the invoice will route to Doug Moffet. 

·     Once approved by Doug, the invoice routes to Harvey Syan.

·     After Harvey approves, the threshold is evaluated. Since the invoice amount exceeds the threshold at

Harvey's level, it will forward to Michael to approve.

·     After Michael approves, the threshold is re-evaluated. Because the invoice amount exceeds the $10,000

threshold amount at Michael's level, the invoice routes to Sally.

·     Once Sally approves the invoice, the threshold is evaluated again. Because the threshold at Sally's level is

$20,000, the invoice routes to Approve 1.

·     Once Approve 1 approves the invoice, it routes to Final Review.

 
Let's look at another example:



 

 

·     In the picture above, after being coded by data entry, the invoice will route to Wade Steele according to the

coding and approval criteria. 

·     After Wade approves, the threshold is evaluated.

·     Tony Curtis has a threshold of $50,000, meaning he will not see any invoices under that amount.

·     If the invoice amount is less than $50,000, the invoice skips Tony and routes directly to Final Review.

·     If the invoice amount is $50,000 or greater, the invoice will route to Tony and, after Tony's approval, to Final

Review.

 
When there is a single approver with a threshold, as shown below, the threshold is essentially ignored.  In the

example shown below, Chris will see every invoice whether it is over $10,000 or not. After Chris approves, the

invoice routes to Final Review.

 

 
 
HARD STOP

Checking this box allows an invoice to always go to last approver/group before Final Review by ignoring a threshold. In the

example below, Jim will always receive the invoice to approve even when the invoice amount is below the threshold.

 



 

 

 
USER OR GROUP

Using the dropdowns, select the appropriate groups for each action. If invoices are to be approved by named

users, uncheck the appropriate Use Group checkbox and the dropdown list will populate with users who have

been granted Approve permission.

 
 
INV COMPLETE



 

 

 
After all of the actions have been assigned, press [Save] to save the group.



 

 

Special Handling Invoices
 
Most organizations also have invoices that receive special handling. 

 
A property management firm has several property managers each responsible for a group of properties.  The

normal process is for them to be the first approver for all invoices for their properties with an approval group

created for each of these PMs.  The firm also has an in-house insurance specialist whose responsibility is

to approve all insurance bills for all properties before they are sent to the PMs for approval. To accommodate

this situation, a second approval group is created for each PM, this time with the insurance specialist as the

first approver and the PM as the second approver.  The manner in which the invoices get routed to the various

approval groups will be described in the Approval Group Criteria section.

 

 
 
 
The next scenario is that of a construction company that has multiple project managers each of whom oversees one or

more jobs.  Again, an approval group has been created for each PM.  The company has a policy that all materials invoices

for all jobs be approved by a purchasing agent after being approved by the PM.  In this case, a second materials

approval group is created with the PM as the first level approver and the purchasing agent as the second.



 

 

 
 

              

 
A common approval group that is typically created is an Administrative group.  Many companies have vendors

such as Fed Ex or UPS whose invoices are allocated to the appropriate jobs even though it is not necessary for

the project managers to approve them.  By assigning these vendors as members of the Administrative group, 

invoices for them can be allocated to the jobs but approved by administrative personnel. 

 



 

 

 



 

 

Approval Criteria
 
The Approval Criteria function is accessed from the Admin Menu by selecting Maintenance > Approval Group

Maintenance >Approval Criteria.

 

Once the approval groups have been created, it is necessary to associate/link the jobs, GL prefixes and other

routing criteria with them.  For TimberScan purposes this is referred to as Approval Criteria.

 
TimberScan can route invoices by:

 
• User-defined Invoice Types
• Commitments
• Vendor - Job combinations
• Vendors
• Job - Extra combinations
• Job-Cost Code-Category combinations
• Job-Category combinations
• Job-Cost Code combinations,
• Categories
• Cost Codes
• Equipment
• Job Authorization
• Jobs



 

 

• Full G/L Accounts
• Base G/L Accounts
• and G/L Prefixes

 
The section on Routing Rules describes how these are configured for each company.

 
 

The following screen will be displayed:

 

 
Select the Approval Workflow to use from the Approval Group dropdown list in the upper left corner of the form.

Note that both the Approval Workflow Descriptions as well as the Approval Workflow IDs display.

 
Member Type:  Use the Member Type dropdown list at the top of the form to select the type of member (criteria) 

to be added.

 



 

 

 
 
Selecting Job as the Member Type will display a list of jobs that have not yet been assigned to an approval

group.



 

 

 
You can click on the desired job and press the [Select>] button or just double click on the job to select it.

 
Different Member Types can be assigned to one group. You could have Job and Base Account in the case of

an approver being assigned to a type of expense (tools) for a specific Job.

 



 

 

 
Items are automatically saved to the group upon selection so when you are finished adding members, you can

just exit this function.

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

New Jobs in Sage 300 CRE can be automatically
set up in TimberScan by setting up an Approval

Group with Job Authorization as the Member Type.
 

The member type “Job Authorization” allows for new jobs set up in Sage 300 CRE to be automatically set up in

TimberScan. 

 
Set the Approval ID in Sage 300 CRE’s Job setup to a Project/Property Manager.  As long as that Manager is

already assigned to an Approval Group in TimberScan the new job is set up for approvals. 

 
Sample selecting by Job Authorization:

Note:  The Field, Job Authorization was changed to Approval ID in Timberline for the example below. 

 



 

 

 
 
 
 
 

 
 
 

 



 

 

Example of Setup for Overhead Invoices

 
Note: Multiple Member Types can be used.  In this example overhead invoices were defined by selecting

specific vendors and G/L accounts.

 
 
Below is an Example of an Approval Group by Prefix (In this case Prefix 22 Equipment Company)

 

 



 

 

Invoice Type Maintenance
 

 
User-defined invoice types have multiple functions within TimberScan:

 
1.  The first is as a method to classify invoices for special handling.  An example would be Rush

Payment invoices. Creating a "Rush Invoice" invoice type will allow invoices to bypass all other invoices

that may be in the respective queues.  Invoice types can be assigned at any stage during the Acquire,

Invoice Entry or Approval processes, but in order to be able to do so, the user must have been granted

"Chg Type" permission in User Maintenance. 

 

 
 

2.  The second function of invoice types is as a method to route invoices that takes precedence over

all routing rules.  In order to route by invoice type, Invoice Type must be selected in Routing Settings and

then invoice type must be assigned to an approval group using the Approval Group Members function

after having been defined. 

 



 

 

 
3.  You can also use invoice types is as a method to filter for invoices in Invoice Entry, Approve or Final Review.

               

To set up Invoice Types, enter the following: 
 
Invoice Code:

 
Enter a Code (15 characters max) and a Description then press [Save]. 

 
To change a description, click on the item in the list box, change the description and press the [Save] button. 



 

 

 
To delete an invoice type, click on the item in the list box and press [Delete].

 
Note:  Once an invoice type has been assigned to an invoice or used as an approval group member, it

may not be deleted. 

 
 
 
 



 

 

Supporting Documents
 

Supporting Documents are any documents that you want to attach to an invoice.  They can be documents

received before, during and after processing of invoices for approval.  Examples can be Purchase Orders,

Subcontracts, Packing Slips, Receiving documentation, or any other document you want to attach to an invoice. 

 
In admin, navigate to Maintenance > Supporting Documents Settings

 

 
 
 
 
 
 
 
 



 

 

Supporting Documents Settings
 
 



 

 

Define Supporting Documents
 

In admin, navigate to Maintenance > Supporting Documents Settings > Define Supporting Documents

 

                                                                             

 
 
This is where you can set up the various document types such as Purchase Orders, Receiving Tickets, etc.

 

 



 

 

Here is an example of a Purchase Order

 

 
 
 
A possible Receiving Ticket:

 



 

 

 
Image Quality - We recommend using black and white image quality because images scanned with this setting require

significantly less disk space.  However, grayscale and color images are also supported. 

 
Document Number - allows or requires document numbers to be provided.  This field is not necessary for POs if you are

using Timberline commitments. During data entry, the PO number can be selected from the Timberline commitment list. 

 
Document Date - allows or requires document dates to be provided. 

 
User Name - allows or requires identification of an Approver or Receiver.

 
Second Vendor - allows or requires a secondary vendor.

 
Attach to Invoice - allows the Supporting Document to be attached to an invoice if applicable.

 
Job, Commitment, Equipment and Company - The next four selections define the distribution grid.  Note:  None of these

fields are required. 

 
Invoice Code 1 and Invoice Code 2 -  are user-defined fields.  Below is an example of Timberline's AP being set to use

Invoice Code 1 as a Voucher #. 



 

 

 

 
 
 
Invoice Code 1 is set to Voucher # in Sage 300 CRE for this example.

If you need this information to be entered in your supporting documents, choose Display or Required. 

 

 



 

 

You also have 2 custom fields that you can define in Supporting Documents Settings.

 
Those custom fields can be Displayed and/or Required fields of entry for a Supporting Document.

Below, Units Ordered and Cost Per Unit are Custom Fields defined in Supporting Documents Settings.

 

 
 
 
 
 



 

 

Vendor-Job Setup
To be able to route invoices by Vendor and Job combination, you must have Vendor-Job checked in Routing

Items.

 
This could be used when you have a person responsible for ordering and approving all lumber for one or more

jobs but NOT all jobs. 

 

 
Once you have set the Vendor-Job routing capability you will get a NEW option under Maintenance:

 



 

 

 Vendor-Job Setup

 

                                                                                      
 
The following screen will display:

 

 
Choose the Vendors and Jobs you want to route by and click the Accept button.

 
You are now ready to apply the Vendor-Job (or other routing selections) criteria to an Approval Group in

Maintenance > Approval Group Maintenance > Approval Group Criteria.



 

 

 

 
Chose to select by Job or by Vendor. Then move the needed Vendor-Job combinations to the right to be part of

that Approval Group.

 

 



 

 

Import
 
TimberScan providesa couple import options as follows:

 
1.     Import Invoices from A/P

 
2.     Import G/L Accounts

 
 
These options extract data from the Sage 300 CRE database and put the data into the TimberScan SQL

database. 

 
Performance can be greatly improved when using these options, especially for clients with large databases.

 

 
 



 

 

Import A/P Invoices
 

Import AP Invoices - This option can provide a major performance boost. When you enter an invoice into

TimberScan it searches Sage 300 CRE to see if that invoice already exists.  If you have a very large database

of AP invoices this process could take a few seconds, causing a delay in data entry for each invoice. Import A/

P Invoices pulls the vendor code and invoice number into the TimberScan SQL database.  Once this is done the

duplicate invoice search is instantaneous.   

 
If you are using TimberScan for all your AP invoice processes, TimberScan maintains the invoice file and

the import needs to be done only once.  If you are entering invoices into Timberline directly, the TimberSync

synchronization keeps the databases in sync. 

 
We recommend that you try TimberScan data entry first and only use this feature if performance is slow. 

 
 
 
 
 



 

 

Import G/L Accounts
 

 
 

Import GL Accounts - This option can provide a major performance boost as

some clients have a very large number of GL accounts. 

 

This feature will upload all GL accounts into the TimberScan SQL database and thereby significantly

improve performance.

 
The same comments made about Import A/P invoices hold true with this feature.  We recommend trying

TimberScan first and only using this feature if data entry is slow.

 
 



 

 

Report Maintenance
 

How to Add Reports into TimberScan with Report Maintenance

 
The Report Maintenance program allows users to add Crystal Reports to run within the TimberScan program.

Before you can add reports to the TimberScan menu, you should install the report designs on the TimberScan

server. We recommend creating a Custom Reports folder under the TimberScan directory on the server. Once

the reports are saved to the server, you can add them to TimberScan utilizing the new Report Maintenance

program.

 
To access Report Maintenance, log into TimberScan as the admin user. Select Report Maintenance > Crystal

Report Maintenance:

 

 
The Report Maintenance Menu displays:

 

 
 
When the Report Maintenance menu displays, you are automatically in “Add” mode. To add a new report:

     (1) Enter a description in the Description box



 

 

     (2) Select the yellow folder to the right of Report Path and browse to the folder on the TimberScan server

where the reports have been saved (for example, \TimberScan\Custom Reports).

 

 
Highlight the Crystal report file and select the Open button.

 
 
The report name and path will prefill in the Report Path cell. Select the Add button to add the report to the menu.

The report will be added to the bottom of any existing report list.

 

 
Once the report has been added to the list, you can select the Cancel button to clear the Description and Report

Path boxes to repeat the process to enter a new report.

 
Select Exit when done.

 



 

 

You can edit or delete an existing menu selection. To delete a report design from the menu, highlight the report

and select the Delete button.

 
 
To edit a menu item, highlight the selection and select the Edit button. Both the Description and Report Path

boxes are available to revise.

 

 
 
Be sure to select the Save button when done.

 
Select Exit to leave Report Maintenance. You will be returned to the Maintenance menu in admin setup.

 
When you log into TimberScan as a user, select File > Refresh Menu to have the new reports available for use.

 

 
To run a report that’s been added in Report Maintenance, select Reports from the main TimberScan menu:

 



 

 

 
 
All reports may be printed to a printer or pdf file by selecting either the Print or Export button as shown below:

 

 
 
 



 

 

Repair Invoices
Occasionally an invoice will get 'stuck' and will not move forward in the workflow process. When this occurs, you

can try to repair the invoice.

 

 
Select the number of days that will include the invoice date of the invoice. Next enter the vendor. You can enter

the invoice number if you know it.

 
Next select the Find Invoice for Repair button.

 
When the invoice displays, highlight it and select the Repair button.

 
NOTE: If the Repair Invoices utility does not release the invoice, please contact TimberScan Support.



 

 

Approval Page Maintenance
 

This administrative function is no longer necessary. Previously, the location of the approval stamp page in the invoice packet

could vary. This function moved the approval stamp page always to page 2 so it could be omitted when creating pdf files.

Now the program tracks metadata on each page associated with an invoice, automatically identifying and differentiating the

invoice image from a supporting document or attached check or approval stamp page.

 



 

 

Settings 

 



 

 

System Settings
 

From the Settings Menu > System Settings

 

 
 



 

 

 
Blank Page Tolerance: 4,000 is the default tolerance.  This measurement helps TimberScan recognize images that are blank

pages.  A number smaller than 4,000 is more sensitive, a larger number is less sensitive.  A less sensitive setting will be more

forgiving in terms of stray marks, etc.

 
Operator Clear Minutes: After 60 minutes idle, the operator's Timberscan session will close.

 



 

 

PDF Conversion Resolution (DPI): We recommend that the image resolution be set to 300 dots per inch.

 
Allocate Sales Tax:  If you using Timberline's Allocate Sales Tax feature.  It forces TimberScan to create a .txt and to import

invoices into Sage 300 CRE.  When checking this box, you must also select the Export Format = Timberline. 

 
Using Timberline Named AP Files:  If you are using Timberline's Named Files feature.  It forces TimberScan to create

a .txt and to import invoices into Sage 300 CRE.  When checking this box, you must also select the Export Format =

Timberline

 

 
.

 
Export Format:  Choose Timberline file format if you are importing .txt files into Sage 300 CRE Accounts Payable. 

 

 
 
Vendor-Job Record Limit: This optional setting allows you to limit the number of vendor-job records to be set up in

Maintenance > Vendor-Job Setup.

 



 

 

PO's in Approval Groups:  Only subcontracts will display adding to approval group criteria unless this box is selected

and if you choose the Commitment Routing  rule in Routing Settings.  This Commitment Routing rule allows for specific

commitments or Purchase Orders (if the option is checked) to be added to an approval groups in Approval group criteria -

not whether or not there is a commitment or PO, but routing for specific commitments or PO's.

 
Restrict G/L & Job Access: Will you have approvers who only approve invoices for certain jobs or departments? 

Approvers can be limited to just the jobs or G/L accounts that are assigned to them in Approval Group Criteria.

 
Use TimberSync:  TimberSync is a tool that allows TimberScan to communicate with Timberline by synchronizing the

two databases at regularly scheduled intervals.  For example, when you add a new vendor or job in Timberline, TimberSync

copies the record to TimberScan. Records are searched in TimberScan instead of Timberline, allowing for faster processing

TimberScan. 

 
TimberSync is installed as part of the TimberScan software installation.  It can be turned on or off.  There is a Disable

TimberSync button on each user's File menu that you can use if you need temporary "live synchronization." 

 
 

Allow No Job or GL Entry: This option allows Data Entry to enter invoice information without the distribution coding. The

only coding that must be entered on the distribution grid is the dollar amount; the total distribution amount must equal the

invoice amount. This feature is useful if you want project managers or  other approvers to enter the distribution coding for

invoices. 

 
 
Ignore Threshold on Route: If using thresholds and an approver is using the manual routing feature to select who they want

to send the invoice to next, checking this box will ignore any threshold and transfer the invoice to the selected approver. 

 
Auto Display Approvals:  This box displays a pop up window showing all previous approvers. 

 
Omit Tax from Commitment:  Must be checked in order for TimberScan to follow Timberline's Tax rate setup.  If in Sage

300 CRE Accounts Payable the box is checked to exclude tax from commitment. 

 
 
Use Commitment Item Description: Retrieves the Commitment Item Description into the Invoice Entry Distribution

Description. 



 

 

 
Allow Export Batch Naming:  It allows naming the batch exported to Sage 300 CRE Accounts Payable.  It allows the user

to search by batch name in Sage 300 CRE.

 
Allow Multi-line Commitment: Checking this box allows operators to select multiple line items on a commitment at one

time to retrieve them onto the invoice distribution grid. 

 
Allow Override Commitment Unit Cost: Checking this box allows operators to override any unit cost on a commitment

set up in Sage 300 CRE.

 
Suppress Notifications: You can select to suppress notifications that generate from the Acquire and/or Invoice Entry

functions.

 
Document Mode: Select from either Monochrome or Color to store images in TimberScan and Sage 300 CRE. You can

select to suppress notifications that generate from the Acquire and/or Invoice Entry functions. Black & white images are

stored in TIFF format while color images are saved in PDF format. Color mode utilizes more memory and storage space.

 
Invoice Type Required: For those who always route by Invoice Type, check this box. When this box is checked, an Invoice

Type is required to process any invoice in data entry (Invoice Entry, Approve, Final Review, etc.) and to move it forward in

the workflow.

 
Check Duplicate Document on AIM Data Entry: Check this box to be warned when indexing an AIM document with the

same data for the same document type.

 
Document Assembly Order: Select how to order your images. Do you want to see checks before invoice images or

checks as the last image in the packet. You can choose from Checks/Invoice/Supporting Documents or Invoice Supporting

Documents/Checks.

 
Date Formats: Select the Date Display Format to match the Regional Settings Date Format. You can choose from various

Date Entry Formats. The date formats here should match your system settings in Windows on your PC.

 
 



 

 

                                                                 

 



 

 

Capture Settings:

 



 

 

Processing Method -   Currently the Proofing Grid is not available. The Processing Method defaults to Original.

 
Accounting Date Usage -   The three options are “Invoice Date”, “Current Date” and “Acquire Date”. Regardless of the

method that you choose for calculating this date, it can always be changed at any time before being exported to Sage 300

CRE.

 
The Invoice Recognition Percent - should never be changed unless so advised by a TimberScan support representative.

 
Use Painted Regions on Data Entry - Checking this box displays Capture-colored fields matching the template fields.

 
With the box checked, the colors display; unchecked no colors display for Capture-acquired invoices.



 

 

 
 

.

 
Remove Leading Zeroes - Check this option if you do not want your vendor invoices starting with zeroes.  This option

removes the zeroes and the invoice number starts with the first digit not zero. 

 
Default Invoice Date Format:  MM/DD/YYYY is the most common date format in the United States while DD/MM/YYYY is

commonly used in Canada and Europe and other countries. 

 
Image Resolutions:

 



 

 

Capture - You have the option to specify whether the Capture documents that you are are going to scan/acquire should

have a resolution of 300 dpi or 600 dpi.  We strongly recommend using 300 dpi as the higher 600 dpi resolution provides no

appreciable benefits when recognizing the text in a document and results in significantly larger image files. 

 
Final - The permanent resolution that the images will be stored at after the Capture process.  We recommend 300 dpi as it

is generally considered to be archival quality, however, to save space the images can be downgraded to 200 dpi.  It is not

possible to upgrade the Final Resolution to a higher resolution than the Capture resolution. 

 
Other Settings:

 

 
Mobile API Settings - These settings will be entered when you choose to purchase TimberScan's Mobile application which

allows users to approve invoices via mobile devices such as tablets and smartphones.

 
Auto Acquire Emails - These settings will be entered should you choose to set up TimberScan's auto acquire where email

attachments can automatically be acquired and placed into a data entry queue. This is an optional purchase.

 
 

 
 

 
 

 
 
 



 

 

Accrual Settings
 

TimberScan gives the ability to automatically create an accrual journal entry based on invoices that are still

unapproved in TimberScan.  

 
TimberScan will create the accrual entry in Sage 300 CRE and also create the auto-reversing entry. 

 
You can choose the following types of accruals:

 
1. Job Cost and/or Regular Cost Accruals

 
2. Tax Accruals

 
 
 
 



 

 

Job Cost Accrual Settings
 
TimberScan gives the ability to automatically create an accrual journal entry based on invoices that are still

unapproved in TimberScan. 

 

 
TimberScan will create the accrual entry in Sage 300 CRE and also create the auto-reversing entry. 

 
You can accrue both Job Cost Invoices and Regualr (non-job) Invoices. 

 
 
 



 

 

 
 
 
 
Default Settings:

 
If you chose any of the default methods for accruing Job Cost Invoices you will need to indicate those defaults here.

 

 



 

 

 
 

If using Default Values you will need to set the Debit and/or Credit Accounts.

 
Journal:

 
If your Sage 300 CRE system uses journals, you will be able to assign journal numbers to the accrual and reversing

transaction entries that will show up on the General Ledger. 

 
 

 
 
 



 

 

Job Cost Invoice Accruals
 
Job Cost Invoice Accruals

 

 
You can Accrue Completed Invoices in TimberScan and/or Incomplete Invoices.

 
To Accrue Completed Job Cost Invoice you can choose from the following:

 
• The general ledger Credit Account is required.  It does not use the AP account by default.  You may, however, choose the

AP account. 

 
• Use Invoice Values - The option uses the cost and GL account coding on the completed invoice for accruals

 
• Always Use Default Job/Cost Code/Category - Uses the defaults entered here for the job costs coding during accrual

 
•



 

 

Always Use Default Cost Code/Category - Uses a default entered here for cost code and category (no job). 
a. This method uses the Job already on the Invoice distribution.  The Invoice Job is combined with the Default

Cost Code and Default Category. The Account # associated with that combination is used as the accrual debit

account. 

 
• Use Debit account - Ignores the Invoice Coding and uses a default debit account for accruals and reversal.

 

 
To Accrue Incomplete Job Cost Invoices:

 
 
• Use Default Cost Code/Category if Not entered - This option uses the cost and GL account coding on the invoice for

accruals UNLESS the invoice coding is currently incomplete and then it uses these default settings.  There must be some

Job related information (Job, Cost Code and/or Category) coded to the invoice for the system to know it is Job Cost. 

 
• Always Use Default Job/Cost Code/Category - Uses defaults entered here for the job costs coding during accrual

 
•



 

 

Always Use Default Cost Code/Category - Uses the default entered here for cost code and category (no job).  Uses

the Job already on the invoice distribution to complete the Job Cost Coding and will retrieve the GL coding for that

combination of Invoice Job with Default Cost Code and Default Category. 

 
• Use Debit account - Ignores the Invoice Coding and uses a default debit account for accruals and reversal. The amounts

for Job Cost invoices are accrued for but there is no actual Job Cost coding.  The accrual entries will be General Ledger

only entries. 

 
• Do Not Accrue - Will not accrue Incomplete Job Cost Invoices

 



 

 

Regular Invoice Accruals (Non Job)
To Accrue Regular (Non-Job) Invoices:

 

You can choose to accrue Completed Invoices and use

 
• Invoices Values - GL coding on the invoice
• or Default Values (Use the Debit and Credit Account entered here)

 
 

For Incomplete Invoices

 
• Use Default Values (Use the Debit and Credit Account entered here)
• Do Not Accrue

 
 



 

 



 

 

Tax Accruals
 

 
 
 
 

                          

 
To Accrue Taxes associated with TimberScan Invoices.

 
1. Leave DrAccount and CrAccount with "Default Value". 

This option accrues the tax value of an invoice as it would normally, as part of the Job or Regular (non-job) cost,

For example if an invoice amount of $100.00 also has $5.00 of tax, the amount of $105.00 will be accrued to the Job

Cost Information and/or General Ledger account specified in Job Cost Accrual Settings. 

 
2.  If you change and OVERRIDE the default value for the DrAccount and CrAccount for an individual tax rate, the tax

associated with that rate will be separated out of         the invoice distribution cost accrued separately as a debit to the

DrAccount and a credit to the CrAccount.  BE VERY CAREFUL.  ONCE YOU CHANGE THE DrAccount and CrAccount,

YOU CAN NOT CHANGE IT BACK TO DEFAULT.

 



 

 

 
TAX RATES ARE NOT TAX GROUPS. Timberline allows a user to set up Tax Rates and then to include the

Tax Rates into Tax Groups.  In the example below, the Metro Tax is 4.25% composed of the OR rate of 3%

and the Metro rate of 1.25%. 

 

 
 
 

 
In TimberScan, the tax lines in TAX ACCRUALS are related to Tax Rates.  If you have a Tax accrual set for

"OR" similar to below, it will accrue a separate tax at that "OR" tax rate anytime it finds a matching rate in

Timberline.  FYI:  A Tax Rate can be part of multiple tax groups. 

 
 



 

 

 
Ways to use this:  If you wanted only the OR tax associated with OR Group to be used, simply set up an

additional tax rate called OR1 with the same rate and information and add it to the MET group.  Re-run your

accruals and only one tax accrues.  There are a variety of ways this can be used to accommodate special

needs. 

 
One Special Need:  needing tax amounts excluded from their accruals.   If you separate tax on your

invoices but do not want the tax amounts accrued, you can achieve this by setting the Dr Account and Cr

Account up with the same account number. 

 
You can see below that both entries are to 10-6118.

 

 
In this example, $971.22 will accrue as a non-job invoice to Account 5170 as indicated in Accrual settings. 

The tax portion of 28.78 will be sent to Timberline but to the same account as a debit and credit entry.  Also

from above,  the amount of $97.09 will accrue as a Job Cost entry sans tax. 

 
 
 



 

 

 
 
 



 

 

Important Note on Sage 300 CRE Settings
When accruing invoices in TimberScan, we recommend that you do NOT set the accounting date in Sage 300 CRE

(Timberline) to be the same as the Invoice Date.

 
Using this setting in Timberline will cause invoices to be expensed twice in the same accounting period.

The following example explains the issue:

 
1. TimberScan invoices are accrued as of February  28. Reversal entries are created as of March 1.

 
2. The February accounting period is closed in TimberScan and the accounting date on all invoices prior to March 1 is

changed to March 1.                           Invoice Date         Accting Date    

 
3. Assumption 1: February accounting period is NOT closed in Timberline:



 

 

When TimberScan invoices are exported to Timberline AND the accounting date is set to invoice date, Timberline ignores

the 3/1 accounting date on the TimberScan invoice. Instead, Timberline uses the February invoice date and posts to the

month of February. Since the accrual entry already was expensed to February, the expense is essentially “doubled” for the

February accounting period.

 
   Assumption 2: February accounting period is CLOSED in Timberline:

When TimberScan invoices with invoice dates prior to 3/1 are exported to Timberline AND the accounting date is set to

invoice date, Timberline will reject the invoices back to TimberScan. Timberline is looking at the invoice date (February)

as the accounting date and that accounting period (February) has been closed. [NOTE: This assumes entry to a closed

accounting period is not allowed.]

 



 

 

Email Setting
 

 
NOTE: Your Timberscan installer will set up this information. It is recommended that you not change it.

 
 



 

 

Routing Rules
 
 
From the Settings Menu > Select Routings Settings

 

 
NOTE:  Once you select and save Routing Items, you cannot unselect them.

 
Invoice approval routing is automatically done by the system based on how an invoice is coded. 

 



 

 

 
 
 
Routing rules follow a hierarchy. Category (No. 9 above) is a higher priority than Job (No. 13 ).  This means that

if you have a specific approver that approves all material invoices they will get all Category = Material invoices

regardless of the job, because the Category information is analyzed first for routing prior to the Job information.



 

 

                       

                                   

 
Select the items that you want to route invoice approvals by.

 
Items previously selected are displayed as grayed and cannot be unselected.

 
You will add the appropriate values (criteria) to the approval groups in a later step (Approval Group Members).

 
Select only the Routing Items you wish to use.  Too many options can slow up processing so it is a good idea to

only select the ones you require.

 
 
 
Routing Settings:

 
You can elect to skip the Final Review step. In this case the last approver will send invoices to the Export

Queue for posting into Sage 300 CRE.

 



 

 

 
 
 
             



 

 

 
 
 
 
 

 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Passwords
 

 
Administrator Password: Use this function to change the password for the TimberScan admin login.

 
Timberline Password: The password entered here should match the password set up for the TimberScan user

in Sage Security. Changing the User ID or Password either here or in Sage 300 CRE may prevent you from

accessing TimberScan. 

 

 
Caution: If username/password in TimberScan do not match the username/password for the TimberScan user in

Sage 300 CRE, no users will be allowed to access TimberScan.



 

 

Apply Accounting Update
 

When instructed by Core Associates, select this option to modify changes purchased to Capture, such as

modifying the number of Capture users.

 
 



 

 

Auto Approve
 

 
Many organizations have certain invoices that require no approval. Examples of this are rent or utility

bills.

 
TimberScan provides for this by allowing certain general ledger accounts to be designated as auto-approve

accounts and certain vendors to be designated auto-approve vendors.

 
Upon data entry, invoices that meet auto-approve criteria will automatically bypass any other defined routing rules

and be routed to Final Review or Invoice Export as appropriate.

 
When auto-approving by general ledger account, all distribution lines for an invoice must contain an auto-approve

account.

If even one distribution line has a non auto-approve account, the invoice will be routed according to normal

routing rules.

 
When selecting auto-approve vendors, a threshold can be entered so that if an invoice is entered that exceeds

the threshold

it will automatically be routed according to normal routing rules.

 
 
NOTE: There are settings in the Sauron logon that must be checked to initiate these two auto approvals:

 



 

 

 
 
 



 

 

Auto Approve G/L Accounts
 

 
 
From Approve, select Auto-Approve Accounts.

 
 
The following screen will appear:

 



 

 

 
 

You can also select accounts to auto approve for recurring invoices. 

 



 

 

 
Locate the GL account you want to auto approve and once highlighted, you will be able to click Auto-Approve Recurring.  If

you are not able to click this option, see your administrator for options available in System Settings.

 
 
 



 

 

Auto Approve Vendors
 
If you have vendors whose invoices can skip TimberScan's approval process, you can set the vendor up as an

'auto-approve vendor.' Invoices entered to an auto-approve vendor are automatically routed to Final Review or

Export (depending on your selected Routing Settings) as soon as they leave invoice entry.

 
In admin, select Approve > Auto-Approve Vendors

 

 
The following screen will appear:

 

 
Auto-Approve Regular

 



 

 

Select the desired vendor by clicking on it then checking the Auto-Approve Regular checkbox in the lower left corner of

the form.

 
 
(NOTE: Clicking on the checkbox to the left of the vendor ID has no effect.)

 
When selecting auto-approve vendors, a threshold can be entered so that if an invoice is entered that exceeds the threshold

it will automatically be routed according to normal routing rules. If a threshold is desired for this vendor, it should be entered

in the Threshold box. When done selecting vendors, press [Ok] to record the selections and exit.

 

 
Auto-Approve Recurring

 
The same can set up for vendors that are set up as recurring invoices. 

 
 



 

 



 

 

File Maintenance
 

 
Choose the data folder that contains your Sage 300 CRE data.

 
To search for existing Sage 300 CRE company data folders and to add new data folders.

 
NOTE: Do NOT Uncheck the Default company data folder.

 
 

 
 
 



 

 

 



 

 

Workflow
 



 

 

Acquire Images
    

 
Before you can enter invoices or other documents into TimberScan you must first bring the invoice images into TimberScan.

 
This is accomplished by clicking the Acquire menu item from TimberScan’s main menu and then selecting Acquire Images.

 
Acquire > Acquire Images

 
 

 
 
The Acquire Images screen will then be displayed. There are multiple ways to acquire images. 

 
1.Scanning invoices to a file using a network scanner or multi-function copier/scanner/printer. 

 



 

 

2.Scanning invoices using a scanner attached to a user’s workstation.

 
3.Drag and drop files from the Windows file system or email attachment.

 
4.Acquire files saved to disk.

 
 
 
 
 



 

 

Scanning invoices to a file using a network
scanner or multi-function copier/scanner/printer

 
 
The most common method of acquiring images is to first scan them to a network drive using a network scanner or multi-

function copier/scanner/printer.



 

 

Main Acquire Image Screen
 
 



 

 

Image Type
The Image Type must next be selected. Depending upon your implementation of TimberScan, you will have up to seven

image types to select from.

 
 

 
#Regular Invoices refers to invoices that are to be entered into Accounts Payable through TimberScan.

 
#Existing Invoices are invoices that have already been entered into TimberScan or Sage Timberline Office Accounts

Payable or other software. They can be invoice images that you want to attach to existing records in Sage Timberline Office

Accounts Payable that were not originally processed with TimberScan.. These can also be additional or replacement pages

for invoices that have already been processed into TimberScan or Accounts Payable.

 
#The Checks option allows Accounts Payable checks to be acquired after printing and automatically attached to all invoices

paid by each check.

 



 

 

#The Imported Invoices option is used to import invoice data from a report created by the vendor.  The report must be in

the format that Sage 300 CRE specifies for importing A/P invoices.This report contains details on all the invoices the vendor

is submitting.  The purpose of this report is to eliminate data entry. Typically vendors send these reports when they submit

many invoices.  TimberScan allows for the scanning of the invoices associated with that data file, importing the data file and

matching the invoice images to the current data. 

 
#The Invoices Uploaded from AP option may or may not be available depending on your TimberScan implementation.

  You will use this option to scan invoices already entered into Sage Timberline A/P.  Invoices entered directly into Sage

300 CRE A/P or uploaded from Purchase Order Module, Service Management/PO Module, or Residential Management/PO

Module

 
#Recurring Invoices may or may not be available depending on your TimberScan implementation.  It is used to scan

invoices relating to recurring invoices in Sage 300 CRE.

 
#Supporting Documents is used to acquire any type of image that supports an invoice.  These can be purchase orders,

receiving tickets, packing slips, lien waivers, etc.  The Procedures Manual details how this feature works.

 



 

 

Data Entry Groups
 
The Data Entry Group must next be selected. If only one data entry group has been defined for your organization, the

dropdown will default to that group. If multiple data entry groups have been defined, the correct group must be selected.

 
 
 

 
 
If invoices are inadvertently assigned to an incorrect group, they may be reassigned during data entry.

 



 

 

Invoice Type
 
Depending upon a user’s security permissions, the Invoice Type dropdown may or may not be displayed on this screen.

 
Invoice types are optional identifiers for invoices that are defined by an organization’s system administrator.

 
Examples of this are Rush Checks or Utility Bills.

 
Identifying invoices in this manner allows them to be expedited through the system.

 
Invoice types can also be assigned to invoice Approval Groups.

 



 

 

Scan Type
 
 
 
TimberScan provides three ways of processing individual invoices.

 

 
1.Invoices that I will manually separate - allows you to place a stack of invoices, of one or more pages, into the document

feeder and scan them in bulk. You then scroll through the pages and mark the first page of each invoice.

 
2.One or more invoices having _# pages. Since most invoices are single pages, it saves time by scanning single page

invoices separately, especially if you have a large batch.

 
3.The third method of identifying invoices is to place a blank sheet of paper between each invoice. TimberScan will

recognize the blank page as a separator and automatically start a new invoice at that point. This will allow the operator to

scan invoices of varying page lengths in one batch.

 



 

 

Selecting Images
 
 
 
Regardless of which Scan Type method is chosen, the Windows file explorer will then be displayed. Note: TimberScan will

remember the last folder where invoices were acquired from and automatically bring the operator back to that folder on

subsequent scans. This setting is remembered on an operator-by-operator basis so each operator can be assigned his or her

own network folder for scanned images.

 
Once You click “Open” the screen will look similar to the following:

 



 

 



 

 

Scanning invoices using a scanner attached to a user’s workstation
 
 

All of the settings and procedures pertaining to invoices acquired from an existing file also pertain to invoices scanned

directly into TimberScan so they will not be repeated here,

 
To use a scanner attached to a workstation, the scanner must be turned on and on-line for TimberScan to recognize it. Using

the Image Source dropdown, select the appropriate scanner.

 
It should be noted that some network scanners or multi-function copier/printer/scanners provide software that allows these

machines to be controlled from a user’s workstation just as if it were attached directly to the workstation. TimberScan

supports this configuration as well.

 

 
The View Scanner Interface checkbox will be enabled. It is recommended that this box be checked the first few times

invoices are being scanned. This will ensure that the correct scanning settings are being memorized by the interface (this is

not a TimberScan function). The recommended settings will be displayed before the interface.

 

 
The [File] button caption has been changed to [Scan]. Press it and TimberScan will take control of the scanner and scan the

items in the document feeder. Once the scanning is complete, all of the above steps should be followed.

 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Drag and drop files from the Windows file system or email attachment
 

Images can also be acquired by dragging them directly from an email attachment or from a file in the Windows file system

and dropping them on to the image viewer portion of the Acquire Images screen.

 

 
 
 
While it is recommended that the files or attachments be in tiff format, TimberScan will be able to import most (but not all)

files or attachments that are in Adobe Acrobat pdf format.

 
Once images have been acquired in this manner, they can then be processed as described previously.



 

 

Working with Scanned Images
 



 

 

Explanation of Page Layout & Icons
 

 
 
Thumb Nail images of all the pages display on the far right.  The thumbnails will identify the invoice number and each page

of multiple page invoices. 

 
Taskbar - The description of the icon appears when pointing to it. To navigate you can either highlight the thumbnail or use

the taskbar. 



 

 

Taskbar symbols
 
 
Size the invoice by using the wheel on the mouse or one of these image control icons

 will move you to the first page

 will move to the previous page

 Pan mode

 Zoom mode

 

 Zoom out

 

 Zoom in

 

 Resize image to fit window

 

 View image at original size

 

 Next Page

 

 Last Page

 
 
 
 
.

 



 

 

Page Edits
 
Page Edits – are at the far right of the screen

 



 

 

 
 

Sticky Notes

You can add "sticky notes" to an image by clicking on the  icon that is located on the far right.

 

 
 
Right mouse click on the sticky note to delete.

 
 



 

 

 



 

 

Top Menu
 
 

 
 
Remove Current Page - If you want to delete the current page from the invoice. 

 
Remove All Pages - To remove this batch of documents.

 

Clear Invoice Markers - If the process selected during Acquire was incorrect and you wish to manually mark the

Invoices you can clear them first.

 
Previous - Moves to the previous invoice (Document)

 



 

 

Next - Moves to the next invoice (Document)

 
Mark as New Invoice - Mark the current document or invoice as the beginning of a new invoice or document.

 
 
 
 
 

 
 
 
 



 

 

Process Images
 
 
 
Once all of the options have been selected, the [Process] button should be pressed. This will copy the images to

TimberScan’s processing folder and record image information in TimberScan’s database. The following message

will be displayed:

 
 

 
Selecting [Yes] will result in the original image files being retained while pressing [No] will cause these files to be deleted.

IT IS STONGLY RECOMMENDED THAT [No] be pressed to avoid the chance of processing the image file a second time.

Although TimberScan will detect duplicate invoices during the Enter Invoices process, deleting the invoices avoids the

possibility of unnecessary work.

 
Once the processing is complete, the following message will be displayed;

 

 
After pressing [OK] the empty Acquire Invoices screen will be displayed. Additional images may be processed at this time or the operator

can be returned to the main menu by pressing the button in the upper right corner of the screen.

 
If email notifications have been activated the following message will be displayed:

 

 



 

 

If the operator who just acquired the images is the one who will be entering the invoices in TimberScan, there is probably no need for this

person to send himself or herself an email. If, however, the person who will be doing the data entry is different from the person who did

the acquiring, a notification should probably be sent.

 
 
 



 

 

 
Invoices

 
 



 

 

Invoice Entry
 

 
   

   

 
 
After invoices have been acquired into TimberScan, the next step is to enter the invoice information.

This is done by selecting the Invoice Entry menu > Primary Invoices or Alternate Invoices depending on whether the Data

Entry person is the Primary or Alternate entry person.

 
 

 
 
 
 
PRIMARY OR ALTERNATE INVOICES

 
To select invoices that are the operator’s primary responsibility, select the X Primary Invoices menu item where “X”

represents the number of invoices to be entered.

 



 

 

If the operator is going to be entering invoices that are not his or her primary responsibility either the X Alternate Invoices

menu item.

 
 
When a User is assigned to a data entry group, they are defined as a primary or an alternate.  

 



 

 

Invoice Entry Selection Options

 
 
 
If the invoices were assigned an Invoice Type during the Acquire Images process, the Invoice Selection dropdown can be

used to select the Invoices by Invoice Type option. In that event, the Selection Criteria dropdown will be enabled and will

display the appropriate invoice types.

 

                                                  

 
                            Invoice Types Depend on the set up of your Company.

 
 
 



 

 

 



 

 

 
Invoice Entry – Explanation of Page Layout & Icons

 

 
 
 



 

 

Thumb Nail Images and Controls
 
Thumb Nail images of all the pages display on the far left.  The Thumb Nails will identify the invoice number and each

page of multiple page invoices. 

 
You can turn off Thumb Nail images by pressing "Enable thumbnails". 

 
Thumbnail on

 

 
Thumbnail off

 



 

 

                           

 
Right Click on a Thumb Nail to get more options:  File and View.

 
Clicking on File gives you an option to Duplicate or Delete a page. 

 
 



 

 

 
 
 
 
 
 
 
The Purchase Order is an attachment of the invoice and one of the Thumb Nails.

 

 
 
 



 

 

Taskbar Controls
 
Taskbar - The description of the icon appears when pointing to it.

To navigate you can either highlight the thumb nail or use the taskbar.  The taskbar auto-hides and is visable when you move

the cursor to the bottom of invoice.

Size the invoice by using the wheel on the mouse or one of these image control icons

 will move you to the first page

 will move to the previous page

 Pan mode

 Zoom mode

 

 Zoom out

 

 Zoom in

 

 Resize image to fit window

 

 View image at original size

 

 Next Page

 

 Last Page

 
 



 

 

Page Edits – are at the far right of the screen
 
 

 Add pen notation

 Highlighs in yellow

 Sticky Note – Add a sticky note.

  Rotate the image left 90 degrees

  Rotate image right 90 degrees

  Rotate image 180 degrees

   Despeckle image

  Descrew or straighten image

 Black to white

 Remove holes

  Remove boarder

 
 



 

 

Sticky Notes

You can add Sticky Notes to an image by clicking on the  icon that’s located on the far right

Point to where you want to add the Sticky Note and click.  You can type your note, size it and position using normal

windows controls.  Right click the Sticky Note to remove it.

 
 



 

 

Invoice Entry – Regular Invoices
 

 
 

Columns of Entry will mimic Sage 300 CRE Invoice Entry.

 
The first section is invoice header information and the second section is for the invoice distribution(s).

 
The fields displayed in the invoice entry grid at the bottom of the screen will correspond to the fields displayed on the Sage

300 CRE Accounts Payable invoice entry screen. Once the main invoice data has been entered, the detail (distribution) grid

will appear and as many detail items as necessary can be entered.

 



 

 

 
 
 

 
 

 



 

 

Dual Monitor users

 
 

     Double click on the Invoice bar to separate the data entry section from the invoice. 

 
To reconnect double check the invoice bar.

 
 
 
 
 
 
 



 

 

Example of Split screen
 

Screen #1

 
Screen #2

To reconnect double check the invoice bar.

 
 
 
 
 
 

 



 

 

 
 
 

 
 
 
 

 
 



 

 

Top of Screen Buttons and Controls
 

 
Previous Inv: Allows you to go back to the previous invoice. The icon is grayed out if you are on the first invoice in the

batch

 
Next Inv:  Allows you to skip the current invoice and work on the next invoice in the batch.  Icon is grayed out when you’re

on the last invoice of the batch.

 
Full Screen: This expands the invoice image to cover the invoice entry grids. The caption is then changed to Detail Screen

and will redisplay the grids when pressed.

 
Remove: Deletes the page you are currently viewing.  You can also delete a page from by right clicking on the thumbnail.

 
Hold: This will place the invoice on hold and remove it from the data entry queue. This is useful if further information is

required before the invoice can be entered. When pressed, the following message is displayed:

 

 
Pressing [Yes] will result in the Enter Comment form being displayed.

 

 
A comment is required when placing an invoice on hold.



 

 

 
Held invoices are accessed by selecting the Invoice Entry menu item from the main menu then clicking on Held Invoices.

 

Print: Pressing this button will send a copy of the invoice to the default printer for the workstation.

 
Route: This allows an invoice to be routed to another data entry group for entry. If multiple Sage Timberline Office data

folders have been created, the invoice can be routed to another data folder. When pressed the following form is displayed:

 

 
Attach:  Is used to add additional pages to the invoice file. When invoked it opens windows and allows you to choose the file

to add.  Currently only TIF and PDF files can be attached.

 
Note:  An alternate way of attaching is by simply dragging the desired image on top of the invoice record.

 
Comment: Pressing this will display the Comment form. All comments are automatically displayed for every user who

subsequently views an invoice. This includes comments that are entered using other forms.



 

 

View Notes: This button will display any invoice comments as well as all of the system created log entries. In the Invoice

Entry stage, there will not be much information to show.



 

 

Bottom of Screen Buttons & Controls
 
 

 
 
Joint: This will allow a joint payee to be entered to an invoice as in Sage Sage 300 CRE Office Accounts Payable.

 
List…: The list button performs the same function as the [List…] button in Sage Timberline Office Accounts Payable.

 
Calculate: This performs the same function as the [Calculate] button in Sage Timberline Office Accounts Payable.

 
Commitment: This option will allow you to see Commitment Line Items and their totals during Invoice Entry

 

 
 



 

 

Cancel Distribution: Is used when data has been entered to the distribution grid, the caption of this button becomes Cancel

Distribution and pressing it will clear this grid and change the caption to Cancel Invoice.

 
Chg Type: If this button is displayed, pressing it will allow the operator to assign or change an invoice type for an invoice.

The down arrow displays all the user defined Invoice Types.

 
 

Delete Row: Pressing this button will delete the highlighted distribution row.

 
Exempt:  This works like the Exempt button in Sage 300 CRE.  Pressing it will exempt the distribution of the invoice from the

1099 amount included for processing year end 1099’s.

 
Supp Docs: The Supporting Document button will be highlighted if there are supporting documents matching the vendor/

job/commitment or vendor/property coded to the invoice.  Clicking on this button will display the supporting documents.  The

operator will choose any supporting documents that needs to be associated with the invoice

 



 

 

 
Note: If the operator forgets to select Supporting Documents, TimberScan will automatically display any supporting

documents for that vendor.

 
History:  This button will display the vendor’s history including all invoices in Sage 300 CRE as well as all invoices still in the

approval process.

 

 
Hold in AP:  This feature requires that the Sage 300 CRE Approval System is activated. Selected invoice will need to go

through an additional approval in Sage 300 CRE.  This insures that these invoices cannot be paid inadvertently.

 
Email: The email button causes the TimberScan email form to be displayed. Using this form you can select email addresses

from the TimberScan user list, Sage Timberline Office address book or Outlook contacts. A copy of the current invoice will

be converted to Adobe Acrobat PDF format and automatically attached to the email by default unless they Include Invoice

checkbox is unchecked.



 

 

If a copy of the email is required for the user’s records, checking the Cc My Email Account checkbox will cause a copy to be

sent to the user’s inbox.

 

Delete Invoice: This button will cause the current invoice to be marked as deleted. Invoices are not actually deleted from the

system but remain there for future reference. When pressed, the following message appears:

If [Yes] is pressed, a form appears prompting for a reason for deletion to be entered. It is mandatory that a reason be given.

Prev Inv:  Will allow you to work on the previous invoice in the batch

 
Nxt Inv:    Will allow you to work on the next invoice in the batch

 
Accept:    Records the invoice as accepted.  You will still be able to exit the invoice.

 
Finished:  Completes the batch.  It will display a list of all invoices in the batch and will highlight the ones that have been

accepted.  Select the Commit button to route the invoices to the next level.

 



 

 

                              



 

 

Subcontractor Compliance
 
During Invoice Entry you may encounter compliance warnings from Sage CRE Settings:

 
Timberscan warnings are designed to mimic the warnings received during Invoice Entry in Sage 300 CRE.  One set of

warnings is displayed at the Invoice Header level and another set of warnings is displayed at the Invoice Distribution level. 

 
Once you bypass (ignore) a warning, that warning will not be displayed again.  This again mimics the behavior of Sages 300

CRE.  If you change an invoice, you will not see the original warnings again.

 
Messages can be related to: Lien Waivers, Certified Reports, Insurance or Miscellaneous Compliance items. Check with your

Sage 300 CRE administrator for more information on these settings.

 

 
You can select the Enter key on the keyboard to bypass the message and continue entering the invoice

and/or you can click "Details" to get more information about the warning.

 
Lien Waivers

 
The Message below is warning that the Vendor has not submitted required Lien Waivers for a specific job.

 



 

 

 
Certified Reports

 
If you require warnings for Certified Reports, you will also receive warnings for Commitments that have no Actual Start

Date.  Certified Repots cannot be generated without an Actual Start Date. 

 



 

 

 
 
 
Insurance

 
Sage CRE stores up to 6 types of insurance and policy information and certificate information can be stored at the Vendor

and/or Commitment.

 



 

 

 
Miscellaneous Items

 
Vendor Misc Items might be Permits Expired, Punch Lists, etc. 

 
 



 

 

 
 
 
Warnings can be received resulting from issues at the following levels:
 

•   Vendor
•   Job
•   Jurisdiction of the Job and/or Vendor
•   Subcontract (Commitment)

 
Below is an example of a warning at the Vendor, Job and Commitment level.

 

 
 
 
 
 
 
 
 
 



 

 

 
 
 

 
 



 

 

Importing Invoices Into TimberScan Setup
 

IMPORT INVOICES INTO TIMBERSCAN
This feature allows you to import various types of invoices into Timberscan for image attachment and/or approval. If using

Timberscan’s approval system, the approval system must also be activated in Sage 300 CRE Accounts Payable.

 
Why use this feature?

There are several reasons to import already coded invoices into Timberscan:

 
 

                                                                          

 



 

 

 
 
 
                            

Clients requiring this feature typically use the Sage Timberline Purchase Order Module, SM Purchase Order, or RM

Purchase Order.

 

 
NOTE: This feature is also required if you want to enter A/P invoices directly into Sage 300 CRE or if your

company's recurring invoices require approval. You can also use this feature to import invoices from a csv/txt formatted

file.

 



 

 

 

                                                                            

Import Regular Invoices

1. If you need to have costs in Accounts Payable, General Ledger and/or Job Cost posted as soon as the vendor invoice

is entered, enter the invoice in Sage then import the invoice into Timberscan to match the invoice image to the invoice.

Optionally, you can route the invoice through Timberscan’s approval process. The invoice in Sage remains “unapproved”

while the invoice is routed for approval through Timberscan. After final approval, the approval flag in Sage is automatically

set to “approved" and the invoice image is attached.

 
Import Imported Invoices

2. Invoices from Sage’s Purchase Order and Service Management modules are coded and automatically sent to Sage 300

CRE Accounts Payable. The import invoices feature in TimberScan allows the operator to match images to the invoices and,

optionally, route invoices through Timberscan’s approval system.

 
NOTE: Starting with Sage 300 CRE version 12.1, invoices from the PO module are imported as “regular invoices” in

Timberscan – Option 1 above. Invoices created in the PO module on Sage 300 CRE versions prior to 12.1, are treated as

“imported invoices.” Invoices from Service Management are also treated as “imported invoices” – Option 2.

 
Import Invoices from File

3. Data from a comma-delimited TXT file in the correct Accounts Payable import file format can be imported into

Timberscan as coded invoices which then can be matched to images and routed through the approval process.  Use this

process to set up a vendor's monthly invoice to speed up processing of invoices with numerous distribution lines.

 
Import Recurring Invoices

4. Use this feature to import Sage 300 CRE recurring vendor invoices into Timberscan to match images to invoices and,

optionally, to route invoices for approval.

 



 

 

1.     IMPORT INVOICES ORIGINALLY ENTERED AND POSTED IN SAGE 300 CRE ACCOUNTS
PAYABLE:
 
SETUP:

 
a. If approving invoices in Timberscan, the Approval system must be turned on in Sage.

 
b.  In Timberscan, log in as admin and select System Settings; check the Approve Regular Invoices if you want to

send these invoices through Timberscan’s approval process.

 
NOTE: You must also check either the Approve Imported Invoices or Approve Recurring Invoices to display Import

Invoices on the Timberscan menu:

 
 

 
In Routing Settings, check Final Review Mandatory for Regular Invoices.

 
If routing invoices for approval, check the Set Timberline Approval Flag on Export.

 
NOTE: Do NOT check the Final Review Mandatory For Imported Invoices box.  If checked, the Acquire feature does not

allow the “Invoices Uploaded from AP” selection to display.

 



 

 

 
In User Maintenance, check the Import Invoices permission:

 

 
2.     IMPORT INVOICES IMPORTED INTO SAGE 300 CRE ACCOUNTS PAYABLE:
Use this option to import invoices which were originally imported in Sage 300 CRE Accounts Payable. This includes invoices

created in Sage’s Service Management application or Builder MT. Also, use this option to import invoices from Sage’s

Purchase Order module – only if created on Sage 300 CRE versions prior to release 12.1. (Use Option 1 above to import PO

invoices created in release 12.1 and after.)

 
SETUP:

 
If approving invoices in Timberscan, the Approval system must be turned on in Sage. In Timberscan, log in as admin and

select System Settings;

check the Approve Imported Invoices if you want to send the invoices through Timberscan’s approval process.

 Also, check “Approve Regular Invoices” to include the Import Regular Invoices in the drop-down list (beginning with version

12.1,  Sage considers invoices from the Purchase Order application as “Regular” as opposed to import imported invoices).

 
 



 

 

In Routing Settings, check the Final Review Mandatory For Regular Invoices box. 

If routing, check the Set Timberline Approval flag on Export:In Routing Settings, check the Final Review Mandatory For

Regular Invoices box. 

If routing, check the Set Timberline Approval flag on Export:

 

 
In User Maintenance, check the Import Invoices permission:

 

 
3.     IMPORT INVOICES FROM A FILE:
Use this option to import invoices from a TXT file into Timberscan. If your vendor can send you invoices in a comma-

delimited format that matches Sage 300 CRE’s AP import invoice format, you can use this feature in Timberscan to import

data from a file. After the import, invoices can be matched to images and routed through Timberscan’s approval process.

When importing into the program, Timberscan is expecting a comma-delimited TXT file.

 



 

 

Setup:

 
Import invoices from a file does not need any of the Invoices Uploaded from AP options checked:

 

 
In Routing Settings, check the Final Review Mandatory For Imported Invoices box.

 
 NOTE: If you are also importing invoices from Sage 300 CRE, that option should not be checked.In Routing Settings, check

the Final Review Mandatory For Imported Invoices box. NOTE: If you are also importing invoices from Sage 300 CRE, that

option should not be checked.

 

 
In User Maintenance, check the Import Invoices permission:

 

 
4.     IMPORT RECURRING INVOICES INTO TIMBERSCAN
 



 

 

Use this feature to import recurring invoices from Sage 300 CRE into Timberscan where they can be approved and matched

up to invoice images. There are four conditions that must be met to import a recurring invoice:

 
1.     Assuming that importing is based upon the last import cutoff date and not a specific batch, the date stamp

of the APM_MASTER__INVOICE             record must be greater than or equal to the cutoff date entered when

generating recurring invoices in AP.

2.     The invoice status cannot be ‘Fully paid’

3.     The Batch Source must be “Generate invoices’

4.     The invoice cannot already exist in TimberScan

 
SETUP:

 
If approving recurring invoices in Timberscan, the Approval system must be turned on in Sage.

 
In Timberscan, log in as admin and select System Settings;

check the Approve Recurring Invoices if you want to send the invoices through Timberscan’s approval process.

 

 
In Routing Settings, check the Set Timberline Approval Flag on Export:

 

 
In User Maintenance, check the Recurring Invoices permission:



 

 

 

 
 
 
 
 
 
 
 
 



 

 

Import Invoices Workflow
 
 

 

                                                                            

 
 
1.     IMPORT INVOICES ORIGINALLY ENTERED AND POSTED IN SAGE 300 CRE ACCOUNTS
PAYABLE:
 
Use this feature if you enter invoices in Accounts Payable and then want them approved in TimberScan. This way costs are

in the accounting system as soon as the invoices are posted in AP. With the Approval flag set in AP Settings, the invoices are

automatically flagged 'unapproved' so they cannot be selected for payment until approved. When the invoice is imported

into TimberScan and approved, TimberScan does two things: (1) the invoice is marked approved in Accounts Payable so it

can be selected for payment and (2) the invoice image is attached.

WORKFLOW:

 
1. Acquire the invoice images: Acquire – Invoices Uploaded From AP

 

 



 

 

When prompted, enter a description for the batch of invoice images.

 
2.  Import the invoices from Sage:

Invoice Entry > Import Invoices from AP > Import Invoices

                     a. Type – Import Regular Invoices

     Batch Description – enter the same description used for the Acquire process. This will make it easier to match

the images to the invoices in                Step 3.

                    b. Data Entry Group – select a data entry group

                    c. Start Date – enter the beginning date to search for invoices

                    d. Import Type: select AP for invoices enter in Accounts Payable or PO for invoices originating from the Purchase

Order application or both if                     you have multiple batches containing a mixture.

                    e. Select AP Batch By: (1) All Batches since the Start Date; (2) Specific Batch since the Start Date; or by (3)

Operator ID since the Start Date.

 
Note:  If your screen looks differently than this, check your setup for Importing Invoices Into TimberScan Setup

 
 

          

 
f. Select the Start button.

 
 
3. Match Images to Invoices:

Invoice Entry > Import Invoices from AP > Match Imported Invoices



 

 

 

 
a. Enter the batch name for the invoice images.

b. Enter the batch name for the imported invoices.

c. Select OK.

 
d. For each image, highlight the invoice below and select the Match button.

There is no way to automatically match multiple images to multiple invoices as the import order may be different

for both groups.

 You are able to sort on the column headings:

 

 
 
OPTIONAL: While in the session, you can select to Unmatch images with invoices:

 



 

 

 
The invoices (including auto approve invoices) will be routed according to their coded information.

 
Once final approved, the images are attached to the invoices in Sage and the approval flag is automatically set so the

invoices can be selected for payment.

 
The invoices no longer show as being in Timberscan (they do not display on the Invoice Status Inquiry).

 
CAUTION: If you change the vendor or invoice ID on unapproved invoices in Sage 300 CRE after the invoice is imported into

Timberscan, the invoice cannot attach after approval and it will be deleted by Timberscan. (Workaround: rescan and attach

the image as existing with the corrected ID)

 
2.     IMPORT INVOICES IMPORTED INTO SAGE 300 CRE ACCOUNTS PAYABLE:
Use this option to import invoices which were originally imported in Sage 300 CRE Accounts Payable. This includes invoices

created in Sage’s Service Management application or Builder MT. Also, use this option to import invoices from Sage’s

Purchase Order module – only if created on Sage 300 CRE versions prior to release 12.1. (Use Option 1 above to import PO

invoices created in release 12.1 and after.)

 
 
WORKFLOW:

 
1. Acquire the invoice images: Acquire – Invoices Uploaded From AP

 



 

 

 
When prompted, enter a description for the batch of invoice images.

 
 
2.  Import the invoices from Sage:

               a. Invoice Entry > Import Invoices from AP > Import Invoices

               b. Invoice Type – Import Imported Invoices

               c. Batch Description – enter the same description used for the Acquire process. This will make it easier to match

the images to the invoices in                          Step 3.

               d. Data Entry Group – select a Data Entry Group

               e. Start Date – enter the beginning date to search for invoices

               f. Invoice Type: Optional; if you acquired images using an invoice type, select the same invoice type here.

 
               g. Select AP Batch By: (1) All Batches since the Start Date; (2) Specific Batch since the Start Date; or by (3) Operator

ID since the Start Date.

 

 
h. Select the Start button.



 

 

 
 
3. Match Images to Invoices:

a. Invoice Entry > Import Invoices from AP > Match Imported Invoices

b. Enter the batch name for the invoice images.

c. Enter the batch name for the imported invoices.

d. Select OK.

 
e. For each image, highlight the invoice below and select the Match button. There is no way to automatically match

multiple images to multiple invoices as the import order may be different for both groups. You are able to sort on

the column headings:

 

 
OPTIONAL: While in the session, you can select to Unmatch images with invoices:

 

 



 

 

The invoices (including auto approve invoices) will be routed according to their coded information. Once final approved,

the images are attached to the invoices in Sage and the approval flag is automatically set so the invoices can be selected for

payment. The invoices no longer show as being in Timberscan (they do not display on the Invoice Status Inquiry).

 
 
 
 
3.     IMPORT INVOICES FROM A FILE:
Use this option to import invoices from a TXT file into Timberscan. If your vendor can send you invoices in a comma-

delimited format that matches Sage 300 CRE’s AP import invoice format, you can use this feature in Timberscan to import

data from a file. After the import, invoices can be matched to images and routed through Timberscan’s approval process.

When importing into the program, Timberscan is expecting a comma-delimited TXT file.

 
WORKFLOW:

 
1. Acquire the invoice images: Acquire – Imported Invoices

 

 
When prompted, enter a description for the batch of invoice images.

 
2.  Import the invoices from a comma-delimited TXT file:

a. Invoice Entry > Import Invoices from AP > Import Invoices from File

                 b. Import File – browse to the comma-delimited TXT file

                 c. Rejected Records File – Timberscan automatically creates the name for the reject TXT file

                 d. Batch Description - enter the same description used for the Acquire process. This will make it      easier to match

the images to the invoices in                     Step 3.

                 e. Data Entry Group – select a data entry group

                 f. Invoice Type: Optional; if you acquired images using an invoice type, select the same invoice type here.



 

 

 

               g. Select the Start button.

 
Import File with Images

Beginning with the 3.8.3.x release, the AP Import Invoices from file function now has the capability of importing an

associated image at the same time it imports the text file, thus eliminating the multi-step process of acquiring the image,

importing the invoice file and matching the two. For the file format and additional detail, please see KB article number

41-10708 by logging into our customer portal at www.helpdesk.core-assoc.com.

 
3. Match Images to Invoices:

a.Invoice Entry > Import Invoices from AP > Match Imported Invoices

b. Enter the batch name for the invoice images.

c. Enter the batch name for the imported invoices.

d. Select OK.

 
e. For each image, highlight the invoice below and select the Match button. There is no way to automatically

match multiple images to multiple invoices as the import order may be different for both groups. You are able to

sort on the column headings:

 

http://www.helpdesk.core-assoc.com


 

 

 
 
OPTIONAL: While in the session, you can select to Unmatch images with invoices:

 

 
The invoices will be routed according to their coded information. Afterwards, invoices go to Final Review (when Final

Review Mandatory for Imported Invoices is checked in Routing Settings) to be queued for Export and exported into Sage

300 CRE Accounts Payable.

 
 
4.     IMPORT RECURRING INVOICES INTO TIMBERSCAN
 
Use this feature to import recurring invoices from Sage 300 CRE into Timberscan where they can be approved and matched

up to invoice images. There are four conditions that must be met to import a recurring invoice:

 



 

 

1.     Assuming that importing is based upon the last import cutoff date and not a specific batch, the date stamp

of the APM_MASTER__INVOICE             record must be greater than or equal to the cutoff date entered when

generating recurring invoices in AP.

2.     The invoice status cannot be ‘Fully paid’

3.     The Batch Source must be “Generate invoices’

4.     The invoice cannot already exist in TimberScan

 
 
WORKFLOW:

 
1. This step is optional. If you would like to attach a permanent approval page or invoice image to the recurring invoice

SETUP in Sage 300 CRE, perform the following:

 
     • Acquire the image as a recurring invoice

 

     

 
     • Invoice Entry > Enter recurring invoices

     • Select the appropriate vendor and recurring invoice ID to attach the image to

    

NOTE:     The above step is not required in order to route recurring invoices through Timberscan.

 
    

This image will not be sent through approval – it is stored in Sage recurring invoice setup as a reference.

 



 

 

 
2.  Follow these steps to process recurring invoices through Timberscan for approval:

 
a. Generate recurring invoices in Sage 300 CRE Accounts Payable

b. Import the generated invoices into Timberscan:

c. Invoice entry > Import Invoices from AP > Import Recurring invoices from AP

                    Batch Description – enter a description for the batch; it will not be needed later since there is no matching step.

                    Data Entry Group – select a data entry group; this group will be skipped since these invoices go straight to be

approved.

                    Invoice Type: Optional; if the recurring invoices do not need to be approved, consider using an “auto approve”

type.

                    Start Date – Enter the processing date on the recurring invoices batch. This is the first date that Timberscan will

start looking for batches and                     will continue through to the current date and time.

                    Select AP Batch By: (1) All Batches since the Start Date; (2) Specific Batch since the Start Date; or      by (3)

Operator ID since the Start Date.

 

     

               d. Select the Start button.



 

 

 
     The following occurs automatically:

•     A “substitute” image will be attached to each recurring invoice showing the vendor code, invoice number from Sage

and the amount of the invoice.

•     The invoices will route to the appropriate approvers according to their coded information.

•     Once final approved, the images are attached to the invoices in Sage and the approval flag is automatically set so the

invoices can be selected for              payment. The invoices no longer show as being in Timberscan (they do not display on

the Invoice Status Inquiry).

 
ByPass TimberSync. This was added in 3.8.6 so not sure how things were working in 3.8.5...

From Sanket: Yes we added Bypass Timber Sync – Once checked it will directly query timberline (bypassing timber sync)..

will slow down the process but use will see all batches



 

 

Working with Commitments
Multi-Line Commitments

Allow Multi-line Commitment – is a global permission in admin > System Settings. When this is checked, the operator can

retrieve multiple lines from a commitment onto an invoice. Once the commitment is selected and the Item Number List

window opens, check each commitment line item you want to retrieve onto the invoice. After the appropriate rows have

been selected, press the "Next" button and the screen will be refreshed. Only the rows that were selected will be displayed

and the "Quantity", "Unit Price" and "Amount" columns will be enabled. The checkbox column will be hidden. There will

be a total on the "Amount" column and there will be "Back", "Finish" and "Cancel" buttons. Any change to the Quantity or

Unit Price will change the Amount and any change to the Amount will change the Unit Price. If the user presses the "Back"

button, the original screen with all of the items will be displayed and any changes that have been made to "Quantity", "Unit

Price" or "Amount" will be retained.

 
Once the "Finish" button is pressed, all of the items from the second screen will be pushed to the distribution grid and the

invoice can be processed as normal.

 
Unit Cost Commitments

 Allow Override Commitment Unit Cost is another global permission in System Settings. Checking this box allows operators

to override any unit cost on a commitment set up in Sage 300 CRE.

 
 



 

 

Held Invoices
 

 
                               

Invoices marked “Hold” during data entry are transferred to the Held Invoice file.  All the data entry options and features are

available for invoices that are held. 

 
Once the “Accept” is selected held invoices will be routed to the correct approver exactly the same way as Regular Invoices

are.

 
 



 

 

Update Existing Invoices
 

                                                            

 
 
 
 
When you use TimberScan for all your Accounts Payable invoices the invoice will be automatically attached. 

 
If you have invoices in Sage 300 CRE prior to using TimberScan then you will have invoice records without invoice

images attached. 

 
The “Update Existing Invoices” is used to attach images to existing invoices in Sage 300 CRE.  When the invoices are

acquired, you MUST use the Image Type “Existing Invoices”. 

 

 
 
 
 Note:  This process can also be used to replace an existing invoice with a new image.

 



 

 

Update Existing Invoices Main Data Entry Screen
 

 
.

List Button displays vendor list from Sage 300 CRE

 
Enter Invoice number and TimberScan will verify that the invoice is in Sage 300 CRE by displaying the date and

amount.  If the invoice is not in Sage 300 CRE the system will display the following message.

 



 

 

 
If TimberScan does not register an invoice attached it will only give you an option to “Add New”.  It will simply add the

existing invoice file to the invoice information you supply. 

 
If, however, TimberScan does register an attachment already you can choose to Add to it or Replace it and you can choose

where to add the new invoice document. 

 
 
 

 
Attach Method: 

Add to the End

            Add After Page

            Replace Exisiting Page

            Delete Existing Page

            Replace Existing Invoice

 
Skip

          



 

 

 
If you are not ready to attach this document to an existing document yet you can Skip it now and return to it later

by choosing “Yes”. 

 
If you wish to delete the invoice from existing invoices you can Choose “No” and it will be deleted. 

 



 

 

Supporting Documents
 

Supporting Documents are those documents that can be attached to an invoice to support the invoice

cost.

 
Examples might be receiving tickets, purchase orders, receipts, lien waivers, etc.  Any document you need to be attached to

invoice can be set up as a supporting document. 

 
 

 
 
The Supporting Documents Feature allows you to create various user-defined types of documents.  These include

Purchase Orders, Packing Slips, Receiving Tickets, Contracts, Lien Waivers, etc.

 
Supporting Documents can be attached to invoices during invoice entry.

 
A receiving ticket may come in before the invoice. With this feature you will be able to scan and code the receiving ticket

immediately Then, during invoice data entry you will be able to review all supporting documents relating to the vendor and

job or property and select documents to attach to the invoice.  Once the invoice is entered the approver will be able to

see the invoice with all the supporting documents.

 
Supporting Documents can also come in after the invoice.  This feature allows you to add supporting documents to an

existing invoice. 

 
Even documents not associated with an invoice can be scanned such as Vendor Insurance Certificates.

 



 

 

Supporting Document Coding
 
This section covers categorizing the supporting documents that have already been scanned. 

 

 
Document Type:  The various Document Types are defined during administration set up.  During this initial setup the

distribution grids are also defined.

 
Select the document type from the pull down list.

 



 

 

 
 

 
Once the document type is selected you can code the supporting document.  Supporting documents only require two data

fields to be completed; these are the vendor and either the Job, Commitment, Company or Property.  The List Button makes

it easy to code it correctly.

 
Coding the supporting documents makes it easier to select the right supporting document during invoice entry.  Only

supporting documents matching the invoice coding will be available during invoice entry.

    

The Recurring check box is used to identify supporting documents for recurring invoices. 

 
 
 
 
 
 
 



 

 

Checks/EFT
 

 
 
This menu selection is designed to attach checks/EFT's to their corresponding invoices.

 
• The Attach Check option requires checks to be scanned in TimberScan. 

 
• The Auto Attach Check option works with Piracle (Create-A-Check) or PrintBoss.  These programs MICR encode your

checks and have an option to save the check run digitally. 

 
• Process EFT's

a. Users who have Attach Checks permissions in Timberscan will be able to attach EFT notifications.
b. Actual notifications produced during EFT generation in Sage 300 CRE will not be used by Timberscan

i. Instead, the EFT attachment process will create its own Notifications and attach those

 
 
 
 



 

 

Attach Checks
 
The first step in  Attach Checks:

 
Acquire checks and give them a Batch ID.

 

 
Checks scanned in TimberScan require a Batch ID.  Select the Batch ID you wish to work on.

 
From the Checks menu > Attach Checks

 



 

 

 
 
In order to start the attach check process you need to:

Select the Back Account and Starting Check Number. 

The Bank Account has a pull down selection that displays your bank accounts from the Sage 300 CRE system.

 
 

 



 

 

 
With this information TimberScan reads the Sage 300 CRE database and extracts the vendor ID and all the invoices that

were paid on this check.  It then attaches a copy of the check to each invoice.

 
Checks can be attached one at a time by using the Attach button at the top of the window. After a check is attached, the

next check in the batch displays to be attached. Use the Feelin Lucky feature to automatically cycle through all checks in the

batch, attaching each check to the corresponding invoice. Ensure that the scanned checks are in the same order as checks

in the batch.

 
NOTE: Attach Checks does not handle the Accounts Payable 'overflow' check that is created when a check pays more than

13 invoices. In addition, Attach Checks cannot be used when there are multiple banks in the same batch. Use TimberScan's

Auto Attach feature for these functions.

 
 
 



 

 

Auto Attach Checks
 

Working with Piracle (Create-A-Check).

 
Checks > Auto Attach Checks

 

 
 
 

 



 

 

Create-A-Check (Piracle)  has the ability to save all checks in a batch in TIFF format.  Once you invoke this ability Create-A-

Check will save all the checks to your computer system. 

 
Simply select this file by clicking on

“Browse for Checks” and "Process" TimberScan will automatically attach each check to its corresponding

invoices.

 
 
 
Working with PrintBoss

 

 
PrintBoss has the ability to save all checks in a batch in TIFF format.  Once you invoke this ability PrintBoss will save

all the checks to your computer system.  Simply select this file by clicking on “Browse for Checks” and TimberScan will

automatically attach each check to its corresponding invoices.



 

 

 



 

 

Process EFT
 
 
Process EFTs

 
IMPORTANT: Allow enough time for the initial EFT process to complete. During the first EFT run,

TimberScan will scan all EFT batches in Timberline. This may take several minutes.

 
There are two important items to consider when attaching EFTs:

•      EFT batches do not display in TimberScan until after TimberSync has run. If you wish to process EFT batches

beforehand, disable TimberSync first (File > Disable Timibersync).

•     An image MUST be attached to the invoice before processing EFTs. If there is no image attached to the invoice in

Timberline, the EFT will not attach.

 
Actual notifications produced during EFT generation in Sage 300 CRE will not be used by TimberScan. Instead, the EFT

attachment process creates its own notifications and attaches those.

 

SETUP:

If you have permission to attach checks in TimberScan, you automatically have permission to attach EFT transactions

created in Timberline. Attach Checks/EFT is a user permission in admin.



 

 

 
WORKFLOW:

Follow these procedures to attach EFTs in TimberScan:

 
1. Select the Checks/EFT tab then Process EFT button.

 

 
2. When the Process EPayments window opens, enter a date range and select the Process button to display EFT batches that

fall within the designated date range.

 
3. Select the checkbox to the left of Batch to select all displayed batches or select individual batches.

 
4. Select the Detail button to view the EFT payments in a selected batch.



 

 

 

 
NOTE: If a payment displays with a “Missing invoice image from Timberline” the EFT will NOT be attached. If you wish

to attach an EFT you must first ensure there is an image attached to the invoice in Timberline.

 
Select the Back button at the bottom of the screen to move back to the Process EPayments window.

 
5. After you have checked the batches for EFT attaching, select the Process button to proceed. A message displays warning

that this process is not reversible.

 

Select ‘Yes’ to continue.

The attach process displays onscreen and you are notified when the process is complete.



 

 

 
 

4

 
A message displays onscreen should EFT processing encounter an error.

Select OK to be returned to the Process EPayment window where you can highlight the batch and select the Detail button to

review the results.

 
To correct a ‘missed’ EFT attachment, process the same batch again. EFTs will attach to invoices not processed originally in

the batch.

 
 

 
 

 
 
 



 

 

 
 
 
 
 
 



 

 

Final Review
 

The Final Review process is done before the invoice posts into Sage 300 CRE.

 

Once the invoices are posted they are in the A/P new file.

 

 
Only an operator with Final Review rights will see this menu selection.

 



 

 

Selecting Invoices for Final Review
 

 
 
There are numerous options for selecting invoices for approval depending upon both how TimberScan and Sage Timberline

Office are configured. For example, the following illustration has an item Invoices by Discount Date. If discounts are not used

in Sage Timberline Office, this item will not be displayed.

 

 
If an item other than <All Invoices> is selected, the Selection Criteria dropdown will be populated with the appropriate values

to select by. Only selection criteria that apply to invoices in a user’s approval queue will be listed. For example, if Invoices for



 

 

a Specific Vendor is selected, only vendors in the user’s approval queue will be listed, not all the vendors in Sage Timberline

Office Accounts Payable.

 
 
 
 
 
 
 
When you select a specific vendor it will list all the invoices in the final review process for that vendor allowing you to get the

invoice you need quickly and easily.

 
 

 
 

You can also sort invoices in various order; Vendor Order, Company Order or Job Order.

 



 

 

 
 
 



 

 

Final Review Main Screen
 

 
The Final Reviewer sees each invoice.  If it’s OK you can just click on Queue for Export.

 

 
The invoices selected for Export are accumulated in TimberScan.  Once this process is complete click the Finished Option.

 

 
The final step to export is selecting the Export option

 
Once again you have the ability to post all invoices or filter them.

 



 

 



 

 

If there was a problem with the post
 

TimberScan will notify you if any of the invoices did post

 

 
You can reselect Final Review Primary Invoices and go directly to the rejected invoice

 

 
TimberScan will automatically record the reason the invoice did not post and highlight it as a Critical Priority

 
 
 



 

 

Approval Process
 

Selecting Invoices for Approval

 
Approving the Invoice(s)

 
 
 



 

 

Selecting Invoices for Approval
 
 

 
1. If you are listed as Primary in an Approval Group you will see that groups Invoices under Primary Invoice. 

 
Below, you see that Andrew Ramka and Brent Hultman are Primary approvers for the Group = IApprove. 

 
2. You will only see Held Primary Invoices if you have permission to Hold Invoices. 

 

 
 
This option allows you to hold invoices and keep them separate from the rest of the invoices for approval. 

 



 

 

 
3. If you have Executive level permissions you will be able to Approve another user’s invoices. 

 
 

 
 



 

 

Approving invoices is a very simple procedure in TimberScan. To start, select the Approve menu item from the main menu

and then select the Invoice option (Primary, Held or another user's invoices) you want to approve.

 
The following form is displayed:

 

 
There are numerous options for selecting invoices for approval depending upon both how TimberScan and Sage Timberline

Office are configured. For example, the following illustration has an item; Invoices by Discount Date. If discounts are not

used in Sage 300 CRE, this item will not be displayed.

 

 
If an item other than <All Invoices> is selected, the Selection Criteria dropdown will be populated with the appropriate values

to select by. Only selection criteria that apply to invoices in a user’s approval queue will be listed. For example, if

Invoices for a Specific Vendor is selected, only vendors in the user’s approval queue will be listed, not all the vendors in

Sage Timberline Office Accounts Payable.



 

 

 
You can select all invoices for a specific vendor 

 

 
 

Or a specific invoice for the selected vendor

 
 

 
 

You can also sort invoices by the criteria above. 

This is handy when an approver is responsible for multiple jobs or properties

allowing them to work on one job or property before going to the next one.

 



 

 

 
Once the [Accept] button has been pressed, the invoices will be in the approval queue displayed in the order specified.

 
 
NOTE: When an approver chooses to select invoices for a specific job and not all jobs display in the approver's

queue, run the User Permissions Update in admin.

 
 
 

 



 

 

Approving Invoices
 

Based on your user permissions, you can do the following to an invoice in the Approval Workflow

 
Approve the invoice unchanged
Modify the invoice header (vendor, invoice ID, date, etc.)
Modify the invoice distribution (job, commitment, cost code, GL coding, amounts, etc.)
Reject the invoice (send it back to Invoice Entry or to another user)
Add/remove images
Annotate images (highlight, add sticky note, etc.)
View vendor history
Hold the invoice (only you will be able to release the invoice)
Route the invoice to another person
Add comments/notes to the invoice
View other approver's notes
Email the invoice
Change the invoice type
Add a joint payee
 



 

 

 
 

After you have selected invoices to approve, the invoices for approval will display in a screen like the data entry screen.

 



 

 

 
Approve the Invoice Unchanged:

 
If the invoice looks okay you can click the [Approve] button, then [Finished] button and the invoice will be routed to the

next person (group) in the Approval Workflow. 

 
Modify the Invoice:

 
Depending upon each particular user’s permissions, he or she may or may not be able to modify the invoice information.

Assuming the user has permission to change invoices, just click the mouse into the cell to be changed and either type in the

information or press the [List…] button if it is active for that particular cell.

 
The system allows for partial coding by the data entry staff.  The approver can complete the coding if data entry doesn’t

know the data elements.

 
If you are not allowed to modify an invoice, you may need rights to:

     Change Invoice Header

     Change Invoice Amount



 

 

     Change Distributions

 

 
Reject the Invoice:

 
If you receive an invoice that should not have gone to you because it was coded incorrectly – select the [Reject] button and

send it back. 

 
 

 
 
 



 

 

 
 
 
 
 

     Reviewing Invoices – Hover Feature

 
Positioning the cursor on select fields provides additional information about the field.

 

 
 
An explanation of the functions of the various buttons follows.

.

     Top of Screen Buttons and Controls

 

 
 
A. Prv Inv: Allows you to go back to the previous invoice.  The icon is grayed out if you are on the first invoice in the batch.

 



 

 

B. Next Inv:  Allows you to skip the current invoice and work on the next invoice in the batch.  Icon is grayed out when

you’re on the last invoice of the batch.

 
C. Full Screen: This expands the invoice image to cover the invoice entry grids. The caption is then changed to Detail Screen

and will redisplay the grids when pressed.

 
D. Remove: Deletes the page you are currently viewing.  You can also delete a page from by right clicking on the thumbnail.

 
E. Job: Runs the Job Inquiry Report.  This report contains all A/P data for the job being entered from both the Timberline

and TimberScan database.  The report has filtering capability and the ability to view the invoice image and supporting

documents. Examples of this and other reports are in the Reports and Inquiry Section

 
F:  Hold: This will place the invoice on hold and remove it from the normal approval queue. This is useful if further

information is required before the invoice can be entered. When pressed, the following message is displayed:

 

 
Pressing [Yes] will result in the Enter Comment form being displayed.

 

 
A comment is required when placing an invoice on hold.

 
Held invoices are accessed again selecting the Held Invoices Selection from the the Approval Menu.

 



 

 

 
G: Print: Pressing this button will send a copy of the invoice to the default printer for the workstation.

 
H: Route: This allows an invoice to be routed to another data entry group for entry. If multiple Sage Timberline Office data

folders have been created, the invoice can be routed to another data folder. When pressed the following form is displayed:

 

 
I. Attach:  Is used to add additional pages to the invoice file. When invoked it opens windows and allows you to choose the

file to add.  Currently only TIF and PDF files can be attached.

 

 
J.Comment: Pressing this will display the Comment form. All comments are automatically displayed for every user who

subsequently views an invoice. This includes comments that are entered using other forms.

 



 

 

 
K. View Notes: This button will display any invoice comments as well as all of the system created log entries. In the Invoice

Entry stage, there will not be much information to show.

 

 
L.  View Image Data:  Displays information about the Image.

 

 
M.  Retain Image Size:  If you increase or decrease the size of the image, you can use this option to maintain the Image Size

for all your invoices to approve. 

 
N.  Enable Thumbnails: If you do not wish to see the thumbnail images to the left of your screen you can turn it off. 

 
Thumbnails off

 



 

 

 
Thumbnails on

 

 
 

     Bottom of Screen Buttons and Controls

 

 
Joint: This will allow a joint payee to be entered to an invoice as in Sage Timberline Office Accounts Payable.

 
List…: The list button performs the same function as the [List…] button in Sage Timberline Office Accounts Payable.

 
Calculate: This performs the same function as the [Calculate] button in Sage Timberline Office Accounts Payable.

 



 

 

Commitment: If you’re working on a commitment this button will be highlighted. Pressing this will display a commitment

report.

 
Cancel Distribution: Is used when data has been entered to the distribution grid, the caption of this button becomes Cancel

Distribution and pressing it will clear this grid and change the caption to Cancel Invoice.

 
Chg Type: If this button is displayed, pressing it will allow the operator to assign or change an invoice type for an invoice.

The down arrow displays all the user defined Invoice Types.

 

 
Delete Row: Pressing this button will delete the highlighted distribution row.

 
Support Doc: The Supporting Document button will be highlighted if there are supporting documents matching the vendor/

job/commitment or vendor/property coded to the invoice.  Clicking on this button will display the supporting documents.  The

operator will choose any supporting documents that needs to be associated with the invoice

 



 

 

 
Note: If the operator forgets to select Supporting Documents, TimberScan will automatically display any supporting

documents for that vendor.

 
 
History:  This button will display the vendor’s history including all invoices in Timberline as well as all invoices still in the

approval process.

 
Email: The email button causes the TimberScan email form to be displayed. Using this form you can select email addresses

from the TimberScan user list, Sage Timberline Office address book or Outlook contacts. A copy of the current invoice will

be converted to Adobe Acrobat PDF format and automatically attached to the email by default unless they Include Invoice

checkbox is unchecked.

 



 

 

 
If a copy of the email is required for the user’s records, checking the Cc My Email Account checkbox will cause a copy to be

sent to the user’s inbox.

 
Prev Inv:  Will allow you to work on the previous invoice in the batch

 
Nxt Inv:    Will allow you to work on the next invoice in the batch

 
Approve:    Records the invoice as approved.  You will still be able to go back to modify the invoice even if needed.

 
Finished:  Completes the batch.  It will display a list of all invoices in the batch and will highlight the ones that have been

accepted.  Select the Commit button to route the invoices to the next level.

 



 

 

 
 
 
 
 
 
 
 



 

 

Review Paid Invoices
 

Paid invoices can be viewed by Account and Check as well as EFT.

 

 
 
• If the Payment Type is EFT, the starting and ending values will be Dates

 



 

 

 
Reports and Inquiries

 
 
There are two distinct Menu Items:

 

• Inquiries and
• Reports

 
However, you can use Inquiries to create TimberScan reports. 

 
Often the term "Reports" in TimberScan is used to indicate an Inquiry generated report.



 

 

Reports and Inquiries Admin Setup
 
ADMIN SETUP for Users

 
In admin setup the “User Maintenance” option controls which users can see reports.  The following check boxes control the

ability to view inquires:

 
 
1.     “Print Reports” option allows the user access all the reports.

 
2.     “Invoice Status Inquiry” allows the user to view only the invoices that are assigned to that user AND are still in the

approval process. 

 
3.     “Regular Inquiry” will allow the user to see only the companies and properties that are assigned to that approver.

 
4.     “Job Cost Inquiry” will allow the user to see only the jobs that are assigned to that approver.

 
5.     “View All” option allows the user to see all data when running inquiries, effectively overriding the limitation to these

inquiries.  However, you still need to select “Regular Inquiry” or “Job Cost Inquiry” as well as “View All” to have access to all

inquiries.  

 



 

 

 
 
 
 
 
 



 

 

Reports
 

 

 
There are 17 custom reports that can be added to your TimberScan menu:

1.          Commitment Report  6-29-17

2.           AP Processing Trends by Group Current Folder 9-11-15

3.           AP Processing Trends by User Current Folder 8-7-17

4.           AP Processing Trends by Workflow Group Current Folder 9-11-15

5.           Export Analysis 5-13-14

6.           Invoice Notes Report 5-13-14

7.          Invoice Notes Report for PM 10-12-16

8.           Invoice Turnaround Analysis 5-13-14

9.           User List 4-6-16

10.     Unaccruable Distributions

 
In addition, there are 6 Invoice Status reports as follows:

11.     Invoice Status Report (Drill Down) Current Company 8-14-17

12.     Invoice Status Report All Companies 9-11-15

13.      Invoice Status Report with Vendor Name

14.     Invoice Status Report by Job All Companies with Extra



 

 

15.     Invoice Status Report by Job Current Company Only 9-14-16

16.     Invoice Status Report by Job Current Company Only with Vendor Name

 
And 1 AIM ONLY design:

17.     Pending AIM Workflow 12-15-15

 
1. Commitment Report - This report drives off the Sage 300 CRE (Timberline) Commitment record and shows everything

posted against a commitment in Timberline as well as in TimberScan (unposted in Timberline). The report prompts for a

range of commitments and prints in commitment ID order. For each commitment, the report displays the job coding (job,

extra, cost code and category) with amounts for original commitment, approved change orders, revised commitment,

amount invoiced, retainage held, amount paid and unbilled balance on the commitment. Invoices are grouped by Accounts

Payable Invoices (posted in Timberline) and TimberScan Invoices (not posted in Timberline) with subtotals and totals. NOTE:

If there have been no invoices posted against a commitment item, the item will not display. 

 
Processing Trends Reports:

These three trend reports are designed to provide insight into how long invoices are held in the various stages from data

entry to final review.  All reports print only for the currently logged in company data folder. The reports display invoices

assigned to groups.

 
Each report provides the following information: vendor, invoice type, invoice number, amount, description, invoice date,

accounting date, invoice action, date assigned, date complete and the duration at that stage. 

 
The following totals are provided:

            •    Number of invoices and dollar amount by action type, date completed and operator/group

            •    Grand total number of invoices and dollar amount

 
 
2. AP Processing Trends by Group – This report sorts by user group (data entry, approve and/or final review) without having

to select a user. It displays a section for each user group for invoices showing complete as well as invoices waiting to be

completed by date range. The operator can choose to print completed invoices only, incomplete invoices only or both

completed and incomplete invoices. This report prints for the current company data folder and requires a user group ID to

be entered. To print all user groups, enter 0 for the lower value and ZZZZZ for the higher value.

 



 

 

3. AP Processing Trends by User – This report sorts by user without having to select a group. It displays a section for each

user for invoices showing complete as well as invoices waiting to be completed by date range. The operator can choose to

print completed invoices only, incomplete invoices only or both completed and incomplete invoices. This report prints for

the current company data folder and requires a user ID to be entered. To print all users, enter 0 for the lower value and

ZZZZZ for the higher value.

 
 
4. AP Processing Trends by  Workflow Group  – This report sorts by approval workflow group. It displays a section for each

approval workflow group for invoices showing complete as well as invoices waiting to be completed by date range. The

operator can choose to print completed invoices only, incomplete invoices only or both completed and incomplete invoices.

This report prints for the current company data folder and requires the Group Description of the approval workflow group

to be entered. To print all approval workflow groups, enter 0 for the lower value and ZZZZZ for the higher value. 

 
 
5. Export Analysis – This report displays the number and dollar value of invoices exported to Sage 300 CRE by a date range.

The report provides a day by day view of the invoices exported with a subtotal by date as well as a grand total. It can be

printed with or without detail; no detail shows a total only. The report prints for the current company data folder.

 
6. Invoice Notes Report – This revised report prints for jobs only. It prints for the current company data folder. You will need

to enter all values. When entering job information, be sure to include all formatting such as a hyphen, dash, etc. To leave

out all job information, uncheck Include this value and check the No lower value for Start of Range; and enter the word

“none” in the End of Range field (uncheck Include this value). To print all jobs, enter 0 for the lower value and ZZZZZ for the

higher value.

 



 

 

 
7. Invoice Notes Report for PM: Same as the Invoice Notes Report with one exception - there is no prompt for a range of

jobs.

 
8.  Invoice Turnaround Analysis – This report displays the time elapsed between scan and export for a range of scan dates. It

provides a view into how long it takes from the time an invoice is scanned until it is exported. The report prints for the

current company data folder. It may be viewed with or without invoice detail; no detail shows a total only.

 
9. User List – This report prints for all users and sorts by active or inactive status. It displays the user name as well as the

logged-in machine name.

 

10. Unaccruable Distributions – This report is for users who accrue entries in TimberScan. The report should be run before

running the Accrual process. The report sorts through all distributions on unexported invoices, and reports on which

are missing base accounts and/or prefixes. The report also lists all invoices that will not accrue by virtue of their being

recurring, uploaded or existing invoices already residing in Sage 300 CRE (Timberline).  

 

To run the report, you will be prompted to enter the number of prefixes that exist on your General Ledger account format.

Select 1 for Prefix A, 2 if using Prefix A-B and 3 for Prefix A-B-C format; select 0 if you do not use GL prefixes. In addition,

you will be prompted for the accrual accounting cut-off date. 

 



 

 

The report displays information for the current company data folder. At the end, the report displays a total number of

distributions as well as the total dollar amount in TimberScan that will not accrue.

 
Invoice Status Reports:

There are six invoice status reports to round out the collection:

11. Invoice Status Report (Drill Down) Current Company

12. Invoice Status Report All Companies

13. Invoice Status Report with Vendor Name

14. Invoice Status Report by Job All Companies with Extra

15. Invoice Status Report by Job Current Company Only

16. Invoice Status Report by Job Current Company Only with Vendor Name

 

The Invoice Status Report (Drill Down) Current Company lists the total number and dollar amount of invoices in TimberScan

by user. The report displays information for the current company data folder only. The operator can select a user and

double-click to drill down to individual invoices, displaying the date assigned, assigned by (system or manual override),

invoice type, vendor ID, invoice ID, invoice date, invoice description and amount. Clicking on the image link opens the

invoice image.

 

The Invoice Status Report All Companies shows invoices in TimberScan for all linked Timberline companies. The report

groups invoices by action within a company: Acquire, Approve, Data Entry, Export, Final Review and Match. Subtotals and

totals display by operator per action. Columns include date assigned, invoice type, vendor ID, invoice ID, invoice date,

accounting date, invoice description and invoice amount. Like the other ‘drill down’ report, a link opens to display the

invoice image.

 
The Invoice Status Report with Vendor Name substitutes the vendor ID with the vendor name.



 

 

 
The three Invoice Status by Job reports show the invoice distribution (not invoice) amount per job (not cost code or

category). The reports sort by job then user and action (Approve, Data Entry, etc.) with subtotals and job totals. Columns

display the date assigned, assigned by (system or manual override), invoice type, vendor ID, invoice ID, invoice date, invoice

description and amount. The ‘All Companies’ report also contains a column for Extras. Links open to invoice images. The

Invoice Status Report by Job All Companies prints for all linked company data folders. The Invoice Status Report by Job

Current Company Only prints for the currently logged in company data folder.  The Invoice Status Report by Job Current

Company Only with Vendor Name displays the vendor name in lieu of vendor ID.

 
AIM ONLY:

17. Pending AIM Workflow – This custom report is designed for use only with the AIM (Advanced Imaging Management)

application. The report displays AIM documents within the various approval workflows. Like the AP Processing Trends

reports, this report is designed to provide insight into how long documents are held in the various workflow stages of

approval in AIM.  The report prints for the currently logged in company data folder and displays documents assigned to

users, providing the document category and type, date assigned, workflow assigned as well as the number of days in a

queue. A link opens the document in its native format.

 



 

 

Import Invoices to Print
 

 
There  is a feature under TimberScan Reports that allows the user to print images based on a Sage 300 CRE

report design.  For example, a user could modify Sage 300 CRE's check register report to bring the data into

TimberScan to create a check register with attached invoice images. 

 
This feature is found in TimberScan by selecting Reports > Import Invoices to Print.  Its purpose is to be able to

print images based on a reort that is run in Sage 300 CRE.

 
Instructions:

 

There is a two - step process to create a report with images:

 
First, a report is created or modified in Sage to output the data in a comma-delimited format.

 
Second, the data is imported into TimberScan and printed with the images attached.

 
1.  Create or Modify a Sage Report Design

 
Select the Sage CRE 300 report you'd like to modify or create a new report.

 For example, you may want to attach invoice images to the current WIP report for customer billing.  Or, as noted

above, you could modify a check register to attach invoice images.

 
Use Sage's Report Designer module to modify (or create) a report design using the following rules:

• Remove the Header Section of the report
• Remove column headings
• Remove totals
• Remove additional rows if the report contains more than 1 row of fields



 

 

 
Modify or create the report design with these required fields:

 
1. (FIRST field) Vendor ID
2. (SECOND field)Invoice Number
3. (THIRD field)the field you want to Group the report data by (for example, for a check register you might select Bank ID;

for a job cost report you might select the job ID).
4. (FOURTH field)Amount

 
Commas need to be entered after each of the first 4 fields as we are re-designing the report to print in a comma-delimted text

field format.

 
Add additional fields after the 4th field to include the data you want to print on the invoice image.  With the check register

example, you may select to add the check number and check data; for a job report you may want to add the cost code and/or

category.  NOTE: There should be no commas between these additional fields.

 
In Report Designer > Print Controls, ensure that each field as well as the comma separators print on each line.  Change tHe

option on the amount field to NOT use commas.

 
Save the report re-design and add it to Reports menu in Sage where the report will be run.

 
The report design should resemble something similar to the report design below:

 
 



 

 

 
Your report printout should resemble the printout below showing vendor, invoice, bank, amount, check number, etc.

 

 
2. Process the data in Timberscan:

 
In Sage 300 CRE, run the report and save it as a text file.

 
In TimberScan, under the Reports menu, select Import Invoices Report > Import Invoices to Print:

 



 

 

 
Select the text file that was just created from running the report design in Sage.

 
•      Enter 1 or 2 report headings (optional)

 
•      Select the Import Data button

 

 
The Report Options screen displays. Make your selections and print the report.

 



 

 

 
If you would like to reprint any report, select Reports > Print Imported Report.

 

 
A screen displays listing previously imported report designs:

 

 
 



 

 

Print Imported Report
If you would like to reprint any previously run "Imported Invoices to Print" report, select Reports > Print Imported Report.

 

 
A screen displays listing previously imported report designs:

 



 

 

Invoice Status Reports with Drill Down
 
 

 
TimberScan has three drill-down Invoice Status reports.

 
1. Invoice Status Report (Drill Down) Current Company

 
This report lists the total number and dollar amount of invoices in TimberScan by user. The report displays information for

the current company data folder only. The operator can select a user and double-click to drill down to individual invoices,

displaying the date assigned, assigned by (system or manual override), invoice type, vendor ID, invoice ID, invoice date,

invoice description and amount. Clicking on the image link opens the invoice image.

 
2. Invoice Status Report All Companies

 
The Invoice Status Report All Companies shows invoices in TimberScan for all linked Timberline companies. The report

groups invoices by action within a company: Acquire, Approve, Data Entry, Export, Final Review and Match. Subtotals and

totals display by operator per action. Columns include date assigned, invoice type, vendor ID, invoice ID, invoice date,

accounting date, invoice description and invoice amount. Like the other ‘drill down’ report, a link opens to display the invoice

image.

 
3. Invoice Status Report with Vendor Name



 

 

The Invoice Status Report with Vendor Name substitutes the vendor ID with the vendor name. The report displays data from

the current company only.

 

 
This page shows all invoices in TimberScan by user.  Once an invoice gets posted to Sage 300 CRE it is no longer shown on

this report.  Selecting a user will drill down to the invoices assigned to that user.

 

 
The invoices are in date order based on when they were assigned to the user. The red circle indicated invoices that are on

hold by the approver.



 

 

 
Click on Image to see the invoice and supporting documents.  The binoculars allow you to search the document.  This is

handy to easily find a specific invoice.



 

 

Invoice Status Reports by Job
 
The three Invoice Status by Job reports show the invoice distribution (not invoice) amount per job (not cost code or

category). The reports sort by job then user and action (Approve, Data Entry, etc.) with subtotals and job totals. Columns

display the date assigned, assigned by (system or manual override), invoice type, vendor ID, invoice ID, invoice date, invoice

description and amount. Links open to invoice images.

 
1. Invoice Status Report by Job All Companies with Extra

 
The ‘All Companies’ report contains a column for Extras.  This report prints for all linked company data folders.

 
2. The Invoice Status Report by Job Current Company Only prints for the currently logged in company data folder. 

 
3. The Invoice Status Report by Job Current Company Only with Vendor Name displays the vendor name in lieu of vendor

ID.

 

 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 



 

 

AP Processing Trends Reports
 

The three trend reports are designed to provide insight into how long invoices are held in the various stages from data

entry to final review.  All reports print only for the currently logged in company data folder. The reports display invoices

assigned to user groups, users or approval workflow groups.

 
Each report provides the following information: vendor, invoice type, invoice number, amount, description, invoice date,

accounting date, invoice action, date assigned, date complete and the duration at that stage.  

 

The following totals are provided:

•     Number of invoices and dollar amount by action type, date completed and operator/group

•     Grand total number of invoices and dollar amount

 

NOTE: The date assigned is when the particular distribution shows up in a user’s or group’s queue. For data entry, this is the

date that the invoice is acquired and assigned to a data entry group.  For final review, this is the date the invoice routed to

the final review group/user. Regarding approvers, there are different scenarios that control the date assigned. If there were

three distributions that went to three different people, each would see his/her “portion” of the invoice with the date each

was first able to see it (the date assigned from data entry). If the three approvers were at three different levels then after

the first approval, the date assigned for user number two would be the date that the first approver approved the invoice

and it routed to the second approver, and so on. The date completed could be (1) after coding from data entry, (2) the date

approved/rejected or re-routed; i.e. the date the invoice left the user’s queue, or (3) when the invoice was queued for

export.

 
1. AP Processing Trends by Group Current Folder

 
This report sorts by user group (data entry, approve and/or final review) without having to select a user. It displays a section

for each user group for invoices showing complete as well as invoices waiting to be completed by date range. The operator

can choose to print completed invoices only, incomplete invoices only or both completed and incomplete invoices. This

report prints for the current company data folder and requires a user group ID to be entered. To print all user groups, enter

0 for the lower value and ZZZZZ for the higher value.

 
2. AP Processing Trends by User Current Folder

 



 

 

This report sorts by user without having to select a group. It displays a section for each user for invoices showing complete

as well as invoices waiting to be completed by date range. The operator can choose to print completed invoices only,

incomplete invoices only or both completed and incomplete invoices. This report prints for the current company data folder

and requires a user ID to be entered. To print all users, enter 0 for the lower value and ZZZZZ for the higher value.

 
3. AP Processing Trends by Workflow Group Current Folder

 
This report sorts by approval workflow group. It displays a section for each approval workflow group for invoices showing

complete as well as invoices waiting to be completed by date range. The operator can choose to print completed invoices

only, incomplete invoices only or both completed and incomplete invoices. This report prints for the current company data

folder and requires the Group Description of the approval workflow group to be entered. To print all approval workflow

groups, enter 0 for the lower value and ZZZZZ for the higher value. 

 

 
 
 

 
 
 

 
 
 



 

 

Commitment Report
 
This report drives off the Sage 300 CRE (Timberline) Commitment record and shows everything posted against

a commitment in Timberline as well as in TimberScan (unposted in Timberline). The report prompts for a range of

commitments and prints in commitment ID order. For each commitment, the report displays the job coding (job, extra, cost

code and category) with amounts for original commitment, approved change orders, revised commitment, amount invoiced,

retainage held, amount paid and unbilled balance on the commitment. Invoices are grouped by Accounts Payable Invoices

(posted in Timberline) and TimberScan Invoices (not posted in Timberline) with subtotals and totals. NOTE: If there have

been no invoices posted against a commitment item, the item will not display. 

 



 

 

Export Analysis Report
This report displays a total invoice count and dollar value of invoices exported to Sage 300 CRE by a date range. The report

provides a day by day view of the invoices exported with a subtotal by batch and by date as well as a grand total. The report

prints for the current company data folder.

 

 



 

 

Invoice Notes Reports
 
 

There are two invoice notes reports that print out the audit log and/or notes for all invoices posted to Sage 300 CRE by

posting date.

 
1. Invoice Notes Report

 
This report prints for jobs only and sorts in job order. It prints for the current company data folder and can be filtered by

accounting date or invoice date. The operator can choose to print the logs only, notes only or both. You will need to enter

all values. When entering job information, be sure to include all formatting such as a hyphen, dash, etc. To leave out all job

information, uncheck Include this value and check the No lower value for Start of Range; and enter the word “none” in the

End of Range field (uncheck Include this value). To print all jobs, enter 0 for the lower value and ZZZZZ for the higher value.

 
2.  7. Invoice Notes Report for PM

 
This report contains the same information as the report above with one exception - there is no prompt for a range of jobs.

 
 
 
 

 



 

 

This report prints out the Log or Audit Trail for select invoices.  To select the log you will need to know the export date of the

transaction.  You can get the export date from any Inquiry Report by checking the Log or Detail file.

 
Tech Tip:  It’s much easier to get this report by running an inquiry – selecting the invoice you want and clicking on the log. 

There is an option to print the log which will create the same report.

 



 

 

Invoice Turnaround Analysis
This report displays the time elapsed between scan and export for a range of scan dates. It provides a view into how long it

takes from the time an invoice is scanned until it is exported. The report prints for the current company data folder. It may be

viewed with or without invoice detail; no detail shows a total only.

 



 

 

Unaccruable Distributions Report
 
This report is for users who accrue entries in TimberScan. The report should be run before running the Accrual process.

The report sorts through all distributions on unexported invoices, and reports on which are missing base accounts and/or

prefixes. The report also lists all invoices that will not accrue by virtue of their being recurring, uploaded or existing invoices

already residing in Sage 300 CRE (Timberline).

 
To run the report, you will be prompted to enter the number of prefixes that exist on your General Ledger account format.

Select 1 for Prefix A, 2 if using Prefix A-B and 3 for Prefix A-B-C format; select 0 if you do not use GL prefixes. In addition,

you will be prompted for the accrual accounting cut-off date. 

 

The report displays information for the current company data folder. At the end, the report displays a total number of

distributions as well as the total dollar amount in TimberScan that will not accrue.

 
 



 

 

  



 

 

User List
This report prints for all users and sorts by active or inactive status. It displays the user name as well as the logged-in

machine name.

 
 
 



 

 

Pending AIM Workflow
 
 
This custom report is designed for use only with the AIM (Advanced Imaging Management) application within TimberScan.

The report displays AIM documents within the various approval workflows. Like the AP Processing Trends reports, this

report is designed to provide insight into how long documents are held in the various workflow stages of approval in AIM. 

The report prints for the currently logged in company data folder and displays documents assigned to users, providing the

document category and type, date assigned, workflow assigned as well as the number of days in a queue. A link opens the

document in its native format.

 

 
 



 

 

Inquiries
 

 



 

 

Invoice Status Inquiry:
 

Reports on all invoices that are still in TimberScan.  

 
You can easily see what Level (workflow level) each invoice is currently at within TimberScan.  The approver or approval

group at each level depends on the Approval Workflow the invoice applies to. 

 

 
 
 



 

 

 

 
Select log to see who currently is processing this invoice. This will give the name of the approver who currently has control

of the invoice. 

 

 
All notes and comments are on the log.  If the approver records the reason that this invoice is still unapproved other users can

easily see the notes by running this inquiry.



 

 

 
Users of this report can also record new comments by clicking on the comments box.  This can be very useful if one is

speaking to a vendor about an open invoice.  The user can record who they spoke to and the details of that conversation

directly from this report.

 
You can print the Log and it will create the same Crystal report you get with Invoice Notes Report

 
 
 
 
 
 
 
 
 
 



 

 

Job Cost Inquiry
 

This report allows you to select specific jobs or all jobs and also bridge both the Sage 300 CRE & TimberScan databases. 

 

 
Invoice Status:  From Sage 300 CRE you can select “All Invoices”, “Paid” or “Open”. 

 
Invoice Locations:  Make sure you “X” Current if you want Sage 300 CRE invoices.  “X” TimberScan if you want invoices

in the approval process.  If you Check "Historical" you will get invoices in the Sage 300 CRE Accounts Payable History

File. 

 
Date Range:  You can filter by range of dates or all dates.  You can also filter by invoice date or accounting date.

 
 
Jobs:  Select the Job or Jobs you wish to view or report on.



 

 

 
 

 
The Job Cost Invoice information will display in a columnar format that you can modify.

• Sort by any column by simply clicking on the column header.
• Modify the Columns that display by right clicking on any column heading.

•



 

 

The filter buttons on top of each column header allow you to filter by any data element.  If you want to view

only "Fully Paid" invoices you can filter on that condition in the the Status column. Filter for Vendors, Dates,

Amounts, etc. 

 

 
 

• If you highlight a date or amount column header, the range button allows you to filter by a range of values.

 



 

 

 
 
 
Print Grid will print the entire report and fit it on the page as best as it can.

 
Export to Excel  will open the report in Excel. 

 

 Clears all filters and returns the inquiry to the original data

 
 



 

 

Group by Area

 
Clicking on the white area just above the column heading opens up a Group by Area section

 

 
Dragging a column name into this area will display the data by that type.  For example dragging vendor name into the

grouping are will change the report to display one line for each vendor.

 
Note: Group by Area feature is available on all inquiry reports

 

Clicking on the “+” box will display the details

 



 

 

You can have multiple groupings.  For example you can group by vendor name and commitment and it will filter

commitments by vendor.



 

 

Report Filtering
 
Clicking on a column heading will sort it in order.  If you click on Name the report will be in vendor name order.

 
Beneath the column headings are filtering options.  Clicking these will allow you to filter to a specific item.  For example

clicking on Cost Code will display all the cost codes & you can select the ones you need.

 

 
The Custom option gives you powerful filtering capabilities

 



 

 

Report Options
 
If you click the Report Option from any Inquiry, you will get a screen like this:

 

 
 
 
Send Report To: 

• Printer - Send the report directly to your Printer.
• Viewer - The report will pop up in the Viewer you have available, for example, TimberViewer if you have it

installed. 
• Adobe Acrobat File - A .pdf report will be created at a location you specify.
• CD Burner - A report will created directly on a CD.

 



 

 

Image Page Options:

Select which types of images to include in your PDF packet. You can select from four options:

• Include Invoice Images
• Include Supporting Documents
• Include Check Images
• Include Approval Page

 
 

Options:

• Report with Separate File for each Image - The report will be created along with a separate pdf file for each

image.
• Reports and Images Combined in One File - The report will be first with each Invoice following in the order of the

report. 
• Report Only - Only the report will display, NO invoice images. 
• Images Only - Only the Invoices Images will display.
• Suppress Duplicate Images
• The “Group Report By” selection option will sort the report by the various categories.   The most popular ones

are by vendor, G/L account and Cost Code. The Options in this selection will depend on which Inquiry you are

working with.  For example, the Cost Code option, will not be available in Regular Invoices Inquiry. 
• Print Images with Annotations - Prints Invoice Images with any highlights, sticky notes, etc. added during the

approval workflow in TimberScan. 
• Print Color Images

 

Report Amount:

Choose which amount to display on the report:

• Reflect Full Invoice Amount (including partial payments)
• Reflect Invoice Balance (unpaid amount)

 
 
All reports are in Crystal format.

 



 

 

 

This report is grouped by cost code.  After the report all the invoice images follow in the same order as the report.

 
 
 
 
 
 
 
 
 



 

 

Regular Invoice Inquiry
 

This report works just like the job cost report but can be used for property managers and Job Cost overhead invoices

 

 
Invoice Status:  From Sage 300 CRE you can select “All Invoices”, “Paid” or “Open”. 

 
Invoice Locations:  Make sure you “X” Current if you want Sage 300 CRE invoices.  “X” TimberScan if you want invoices

in the approval process.  If you Check "Historical" you will get invoices in the Sage 300 CRE Accounts Payable History

File. 

 
Date Range:  You can filter by range of dates or all dates.  You can also filter by invoice date or accounting date.

 
GL Prefix: User defined , can be Company, Property, Department, etc. : You can pick All, one or several.   

 
The Regular Invoice Inquiry works exactly like the Job Cost Inquiry.  It is used to access Companies and Properties.   The

report options are also the same as the Job Cost Inquiry Report.

 



 

 

 
The Regular Invoice information will display in a columnar format that you can modify.

• Sort by any column by simply clicking on the column header.
• Modify the Columns that display by right clicking on any column heading.

 

 
•



 

 

The filter buttons on top of each column header allow you to filter by any data element.  If you want to view

only "Fully Paid" invoices you can filter on that condition in the the Status column. Filter for Vendors, Dates,

Amounts, etc. 

 

 
• If you highlight a date or amount column header, the range button allows you to filter by a range of values.

 
 



 

 

 
Print Grid will print the entire report and fit it on the page as best as it can.

 
Export to Excel  will open the report in Excel. 

 

 Clears all filters and returns the inquiry to the original data

 



 

 

Vendor Invoices Inquiry
 

The Vendor Invoice Inquiry allows you to select vendors and see the invoices for those vendors by “All Dates” or by date

range by “Invoice Date” or “Accounting Date”

 

 
This report show invoices in Sage 300 CRE and TimberScan.  The status column shows where the invoice is and its status.

  Open and Full Paid invoices are from Sage 300 CRE.  Approve and Final Review are in TimberScan.  All the filtering

options are available to help with the analysis. 

 
 



 

 

 
 
 
The Detail Button will show how the invoice was distributed.  The View button will show the invoice and all supporting

documents.

 
Export to Excel will open the report up in Excel. 

 
 
 
 
 
 
 
 



 

 

Supporting Documents Inquiry
 
Inquiry > Supporting Documents Inquiry

 

 
You can select Supporting Documents by the following:

 
• Document Type (User Defined and may include Purchase Order, Receiving Tickets, etc)
• Vendors
• Dates
• Additional Criteria (Job, Commitment#, etc.)

 
 

 



 

 

 
Document Type “Unprocessed” displays the supporting documents that have not been assigned to invoices.  They are still

open.

 
Documents Type “Unposted”  displays supporting documents attached to invoices but are still in the approval process.

 
Supporting Document Inquiry provides many filtering (Additional Criteria) options.



 

 

 
 
When you have finished selecting the options and criteria, press [OK]

 

 



 

 

 
View a document or edit the distribution. 

 
Filtering capabilities and sorting capabilities are available to help select the right documents.

 

 
 
The View Mode allows one to Print or Email the document.

 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 



 

 

Deleted Invoice Inquiry
 
TimberScan keeps a report of all invoices even deleted invoices.  If it’s scanned into TimberScan it’s accounted for.  Of

course no deleted invoices will ever go into Sage 300 CRE.  TimberScan keeps the image and the audit log so that you can

see who deleted the invoice, when and why.

 

 
 
 



 

 

Accrue Invoice Reports
 

Utilities > Accrue Invoices

 

 
TimberScan has an accrual feature that lists all unapproved invoices and allows you to select the invoices that you wish

to accrue.  The system will create a month-end accrual journal entry and an auto revering journal for the first of the

new month.  For Job Cost transaction it will create the journal entry in Job Cost.  For overhead or property management

transaction it will create a journal entry in the General Ledger.

 

 
To start a new period select the reset button. Then enter all the appropriate dates.  Once that is complete select the compile

button. 

 



 

 

To view the invoices click on Review.

 
Clicking on the column heading will sort by that column.  On the report below the amount column was used as the sort field.

 

 
The report button will provide a detail report.  The OK button will post.

 
 



 

 

 
 
 
 
 
 
 



 

 

 
Supporting Documents

 



 

 

Supporting Documents
 

Purchase Orders, Packing Slips, Receiving Tickets, Contracts, Lien Waivers, and more are examples of Supporting

Documents.  The Supporting Documents Feature allows you to create various user-defined types of documents.

 
Supporting Documents can be broken down into three time frames.  Documents that are received PRIOR to receiving an

invoice, documents received AFTER an invoice is received and documents that are received ALONG WITH the Invoices. 

The purpose of Supporting Documents is to give the user the ability to scan and attach Supporting  Documents at any time. 

 
An example of documents that come in before the invoice is received is a receiving ticket.  Using Supporting Documents

you will be able to scan and code the receiving ticket immediately.  Then, during invoice data entry, you will be able to review

all supporting documents relating to the vendor, job or property and select documents to attach to the invoice.  Once the

invoice is entered, the approver will be able to see the invoice with all the supporting documents attached.

 
When Supporting Documents come in after the invoice, this feature allows you to add to an existing invoice.  Usually, a

Lien Waiver comes in after the invoice is entered.  The Supporting Document feature allows you to attach documents such

as Lien Waivers to existing invoices. 

 
Documents not associated with an invoice ,Vendor Insurance Certificates,  for example can be scanned and attached.

 
If a Supporting Document comes at the same time as the invoice, the best procedure is to scan the two together.  There

is no need to use the Supporting Document feature in that case unless you want to run Inquiries for only the Supporting

Documents from the Supporting Document Inquiry.

 
 



 

 



 

 

Admin Setup for Supporting Documents
 
When signed in as an Admin > Go to Maintenance > Supporting Document Settings >Supporting Documents Settings

 

                                                                         

 
This feature can be renamed “Future Items”, “Additional Document Types”, etc. 

Two generic custom fields are provided which can be coded to any type of document.

 
 

 
 
 
 
 



 

 

After completing Supporting Document Settings, select Define Supporting Documents from Supporting Documents

Settings.  Various document types such as Purchase Orders, Receiving Tickets, etc. can be set up here.

 

 
Document Number – allows or requires document numbers to be provided.

 
Document Date – allows or requires document dates to be provided.

 



 

 

 
Units Ordered: Can be displayed but NOT required, displayed  and required or not used at all.

 
Cost per Unit: Can be displayed but NOT required, displayed  and required or not used at all.

 
 
 
 
 
 



 

 

Scanning
 

 
• From Image Type select Supporting Documents.

 



 

 

Categorize/Document Types
 
From Invoice Entry > Supporting Documents

 

                                                                                              

 



 

 

 
 
 
 
In the example below the Supporting Document is being coded to Vendor 2306 and Job 03-001.  When you receive the

Invoice and enter it into Data Entry, you will be able to view and attach the Document when you use the same Vendor and

Job.

 

 
 
 



 

 

Attaching to a document already in the
TimberScan or the approval process

 



 

 

 
 
The previous example shows a Lien Waiver.  By choosing Attach Existing, a list of all matching invoices will appear.  This

includes both invoices posted to Sage 300 CRE and invoices that are still in the approval process in TimberScan. 

Select the invoice that is associated with the Supporting Document.

 
 
 
 
 
 



 

 

Invoice Data Entry - Supporting Documents
 
From Invoice Entry - Once the invoice is coded, selecting Supporting Docs will list all supporting documents "Supp Docs

Button"  that match the coding of your invoice.

 
  This invoice is coded to a specific vendor.  Selecting Supporting Documents will list only documents for that vendor.

 



 

 

 

 
All supporting documents that could relate to the invoice will display.

 
Select the documents that actually relate to the invoice. 

 

 
• The Keep Open option will attach the document to the invoice and make it available for other invoices.  



 

 

 
• An example of Keep Open would be a PO that is greater than the invoice because of a partial shipment. 

 
• It is important to check the Keep Open check box to make the supporting document available to attach to another invoice.

  Once that box is unchecked, the Supporting Document is in effect, closed out, and not available for attaching to another

invoice.

 
• If the operator accepts the invoice and forgets to select Supporting Documents, the system will automatically

display them.

 
 
 
 
 
 
 
 
 



 

 

Approval Process
 

 
• When the approver selects supporting documents the invoice and supporting document can be moved.  This can make line

item matching easier. 

 
• The approver can also use the navigation buttons at the top of the window or the thumbnails to move forward through the

pages. 

 
• The Approver can NOT add a supporting document. 

 
 

 
 
 
 



 

 

 
 
 
 
 
 



 

 

Reporting
 
From Inquiries, you can choose Supporting Document Inquiry to do an inquiry or create a report.

 
 

 
Once you select the Supporting Documents Inquiry you can use the filters as seen below. 

 

 
Supporting Document Inquiry provides many filtering options.  The filters are as follows:



 

 

 
#     1. Document Type

#     2. Vendors

#     3. Date Range

#     4. Additional Criteria

 
Document Selection:

 

 
 
• Document Type “Undefined” displays the supporting documents that have not yet been classified as to what document

type it is.

 
• Documents Type “Attached” displays those Supporting documents that have been attached to an Invoice.

 
• Documents Type “Unattached” displays supporting documents that have not yet been attached to an Invoice.

 
 
Vendors

 
Select all Vendors, one vendor or multiple vendors. 

 
The selection will be limited as to the vendors already coded to supporting documents



 

 

 

 
 
 
Date Range

 
You can focus on a range of dates or click “All Dates”. 

 

 
 
 
Other Criteria

 

 
Additional Criteria can be added such as: 

o     Job

o     Commitment

o     Company

o     Equipment

 



 

 

An example of the Commitment used for Additional Criteria. 

 

 
Again, the information will be limited to the supporting documents coded to commitments already.

 
The Supporting Documents Grid:

 

 
One can view a document or edit the distribution.  Filtering capabilities and sorting capabilities are available to help select

the right documents.

 



 

 

#     Sort by any column by clicking on the Title.

#     Right Click on a Title to remove or add columns to the grid.

#     Add Counts, etc by clicking on the Summation key.

#     Set Filters

#     Clear Filters

#     Print Grid – Sends you to the printer settings to print

#     Export to Excel – Sends you to a file naming screen where you want your Excel report.

 
SORT by any column

 
Click on any column Title to change the grid sort.

 
ADD or REMOVE columns

 
Right click on any column title to add or remove columns from the grid.

 
Summations

 
Click on any columns Summation symbol to add Counts, etc

 



 

 

 

 
Set Filters

 
Filters can be set on most Columns by clicking on the down arrow and choosing a parameter

 

 
 
Clear Filters

 



 

 

If you wish to start over with filters you can click on Clear Filters to go back to the original grid. 

 
 
 
 
 



 

 

VIEW MODE
 

 
 
The View Mode allows you to Print or Email the document.



 

 

Edit Mode
 

 
The edit mode allows you to add information and also redistribute to a different vendor or job.

 
 



 

 

Other Procedures
 



 

 

Exporting New Cost Codes & Categories
 
During TimberScan data entry, you can add cost codes and categories on the fly just like in Timberline Invoice Entry.  The

steps are as follows:

 
1.     Add a new code and/or category during invoice entry.

 
2.     Review the new codes and categories in the To Do List.

 
3.     Add new Job Cost Codes and Categories. Utilities > Add Job Codes.  Creates a file of new extras, cost codes, and

categories to be used in Sage 300 Job           Cost as an Import file.  

 
4.     Import the Cost codes and Categories into Sage 300 CRE Job Cost. Job Cost > Tools > Import > Estimates. 

Imports the new codes created from                     Timberscan into Sage 300 CRE Job Cost.

 
 



 

 

Adding Extras/Cost Code/Categories
to Timberscan Invoice in Data Entry

 
From Invoice Entry, when you need to code an invoice to a new extra/cost code and/or category that does not currently exist

in Timberline, you will get a message asking to add the new data from the standard list. 

 

 
Select “Yes” to add the new Cost Code.

 
TimberScan automatically adds the new codes/categories to the To Do List.

 
 



 

 

To Do List
 
From the Utilities Menu > To Do List

 
 

 
All the new cost codes categories are recorded in the “To Do List”.

 

 
Review the “To Do List” before exporting to Sage 300 CRE.

 
Delete codes that should not be posted to Sage 300 CRE.

 
Next Step:  Add Job Codes in Timberscan. Utilities > Add Job Codes

 
 
 
 



 

 

 
 
 
 
 
 
 



 

 

The Add Job Codes function
 

 
The “Add Job & Codes” function will create a file that can be imported into Sage 300 CRE.  It will add Cost Codes to Job

Cost.

 
Select “Yes”.

 
Name the import file.  TimberScan will open to the Sage 300 CRE directory that you’re currently using.

 



 

 

 
NOTE:  The file type is automatically set as an “Estimate Import File” (.jce)

 
Sage 300 CRE allows you to import zero value estimates.  ODBC does not allow adding cost codes. 

 
However, the importing feature works very well.

 
Click on open and TimberScan will create the file.

 

 
 
 
 



 

 

Importing new Job Codes into  Sage 300 CRE
 
In Sage 300 CRE Job Cost >  Tool select Import > Estimates.

 

 

 
Select the import file that was created and click Open.

 
Name the Rejected record file.



 

 

 

 
Note: Ignore the statement that “Estimates will be applied to” a specific job.  The import will add the cost codes, extras and

categories to all the jobs selected.

 

 
You are now ready to Export Invoices from Timberscan to Sage 300 CRE Accounts Payable with new Job Cost Codes . 

 
 
 
 
 
 
 



 

 

Sage 300 CRE Purchase Orders Workflows
TimberScan supports a number of workflows for clients that have the Sage 300 CRE Purchase Order System.  These are as

follows:

 
1.     Invoices from the PO system do not require approval in TimberScan.  You just want to attach the scanned

invoice.

 

 
 
2.     Invoices require approval and you want to process them in TimberScan

 

 
Note:  These two options do not require special instructions.  They should be obvious.

3.     Invoices require approval and you want to process them in Sage 300 CRE

 



 

 

 
 
4.     Invoices require approval and you want to enter the invoices in the PO system but not post them to AP

 

 
 



 

 

POs & Invoices Processed Entirely in Sage 300 CRE
Purchase Orders and other types of Accounts Payable invoices are entered into Sage 300 CRE directly.  This may include

POs from Service Management and Residential Management as well.

 
You may be able to do the following:

 
1.     Enter some or all A/P Invoices directly into Sage 300 CRE rather than TimberScan.

2.     Post invoices from the PO module, Service Management PO Module and RM PO Module into AP.

 
TimberScan has a method of knowing which invoices need to be imported from Sage 300 CRE. 

 
The workflow is to scan the invoices into TimberScan and upload the new Sage 300 CRE invoices into the TimberScan

system.  Since that order of invoice images and invoice data may not be the same, TimberScan provides a simple matching

routine.  Once the invoices are matched they will flow to the right approvers.  There is no need to do data entry.

 
To differentiate between approved and unapproved invoices TimberScan utilizes Sage 300 CRE’s approval feature. 

Invoices entered or posted from the various PO systems will be flagged as unapproved in Sage 300 CRE.  TimberScan will

automatically mark invoices approved in Sage 300 CRE after the final approval process when TimberScan posts to Sage

300 CRE.  This will insure that only approved invoices get paid.  TimberScan will also attach the image and all supporting

documents during the posting process.  This documentation will show you how to use this feature.  

 
This feature also provides a new method of extracting data from the various Sage 300 CRE PO modules. This method

supports AP invoices posted directly to Sage 300 CRE.  The original method of processing POs still works.  With the

original method one had to be very careful not to post the PO invoices to AP because an error could lead to duplicate



 

 

invoices.   The new method eliminates this problem.  Invoices from the PO systems rarely require coding changes.   If

frequent changes to the coding are anticipated then the original PO method should be considered.  The main disadvantage

with this method is that invoice data cannot be changed in TimberScan.  All changes need to be changed at its source, Sage

300 CRE.

The new method is the only option available for clients using the RM PO module.

 



 

 

Step 1 – In Sage 300 CRE – Use Approval System
 
In Sage 300 CRE Accounts Payable

File > AP Settings

 
 

 

 
Make sure that the “Use approval system” is checked. 



 

 

This will allow TimberScan to control the approval flag so that only invoices approved and posted from TimberScan

will be marked as approved in Sage 300 CRE.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Step 2 In TimberScan Admin –          Routing Settings
 
Settings > Routing Settings

 

 
Set Timberline (Sage 300 CRE) Approval Flag on Export

 
 

 



 

 

Step 2- Scanning
 

File > Acquire

 

 
 
Image Type = Invoice Uploaded from AP

 

 
Scan the invoices you just processed in Sage 300 CRE from the PO Modules.



 

 

 
 
 
 



 

 

Step 3 – Import Invoices from AP
 
Invoice Entry > Import Invoices from AP

 

 
Name the batch in Batch Description.  TimberScan knows which invoices are new invoices.  It will automatically keep track

of previously imported invoices and include that date on the screen.  Selecting batches by operator is also an option.

 



 

 

Step 4 – Matching
 
Invoice Entry > Match Imported Invoices

 

 
Using the same batch ID for the scanning and importing makes matching easier

 



 

 

Highlight the data that matches the Image and click Match.  The number of imported images and the number of invoices

from Sage 300 CRE or the PO system should be equal.  If you missed scanning any invoices, you can scan additional images

to the same batch number.  The import batch from Sage 300 CRE will only close when all of the records have either been

matched or deleted.

 



 

 

POs Entered into PO System but Not Posted to A/P



 

 

Settings in Sage 300 CRE PO module
 

Before starting make sure that the automatic post macro for Purchase Orders is turned off:

 
From PO Module >File>Data Folder Setting>File Location Tab

                   

Make sure there is no AP Invoice Macro

 

 
1.     Enter POs normally

 



 

 

 
Commit PO

 
2.     Send Order to Job Cost & Post

 
 

 
 
3.     Enter Receipts – Receive All & Post

 



 

 

 
Post

 
 

 
 
 
 
4.     Send Invoices to AP ***BE VERY CAREFUL HERE****

 



 

 

 
5.     CLICK ON POST

 
This creatse the APInv.TXT file

 

 
6.     YOU MUST CANCEL
 
If you click start you will not be able to use import files into TimberScan.  The AP invoices will be in AP in the NEW file.

 
This is all normal PO processing. 

 
Now for the TimberScan process.

 



 

 

Procedure in TimberScan
 
1.     Acquire Images

Image Type = "Imported Invoices"

 

 
2.     Process

 

Enter NEW Batch Descritpion – with unique number usually today’s date

 
 



 

 

Then click on OK

 
 
3.     From Invoice Entry  > Import Invoices > Import Invoices From File

 

 
 



 

 

 
Click on the ... to the right of "Import File"

 

 
Select the APInv.TXT file.  This file is in your Sage 300 CRE data folder and contains the batch just created during invoice

entry in PO.

 



 

 

 

 
Click on New

 

 
Give the PO data a batch number – use today’s date so that it’s easy to match with the Image batch.

 
Select the Data Entry Group and then press start

 
 
 
 
4.     Invoice Entry > Match Imported Invoices

 



 

 

 
 



 

 

 
 
Match the image to the list of invoices below. Once you highlight the invoice click on Match and the next image will pop up.

  Once you’re done click on the Finish key. Since the invoice is now coded TimberScan will automatically route the invoice

to the right approver.

 
Note: You can use the Auto Approve feature if the invoices that do not require approval. This may be because it

matches the PO. 



 

 

Recurring Invoices
 

Recurring Invoices are used by Sage 300 CRE to set up and edit invoices generated on a regular basis at a predetermined

time adding invoices automatically to the open invoice database.

 
Examples of Recurring Invoices:

 
Rent - a monthly payment that recurs periodically at a predetermined amount and may or may not have an

invoice. 

 
Loan Payments - Principal and Interest calculated with an amortization table. 

 
 

See Sage 300 CRE for more assistance setting up Recurring Invoices in Accounts Payable. 

 
Using TimberScan you can import Recurring Invoices from Sage 300 CRE's Accounts Payable

 
• attaching a master invoice to the record in Accounts Payable and sending the invoice through your companies

approval workflow (or bypass approvals and automatically approve).

 
 
 
 



 

 

Step 1: Scan Invoice
Step 1 – Acquire/Scan the the invoice using "Recurring Invoices" as the image type.

 



 

 

Step 2: Associate Scanned Image with Recurring Invoice
 

Step 2 – Associate the Acquired/Scanned image with the recurring invoice in Sage 300 CRE's Accounts Payable.

 

Only vendors with recurring invoices will list.

 
You will need to enter or select the Vendor ID and enter the invoice #.

 
Once the image is associated with the invoice TimberScan will attach the image to the Recurring Invoice record in Sage 300

CRE.

 



 

 

 
 This image is now associated with the Recurring Invoice in Sage 300 CRE. 

 
 



 

 

Verify Attachment from Sage 300 CRE
 

From Accounts Payable

• Click on Setup > Recurring Invoices 

 
 

 
 
Using the VCR buttons or the down arrows, locate the Recurring Invoice

 
 



 

 

 
• Click on the Attachments Button

 
• Then on the Open Button to see the invoice image.

 

 
• The Image you see should be the Invoice document you just associated with the Accounts Payable Recurring Invoice

record from TimberScan.



 

 

 



 

 

Step 3: Importing Recurring Invoices for Approval
 
On a periodic basis you will generate recurring invoices from Sage 300 CRE's Accounts Payable.

 
For Example, you might generate invoices for March's recurring rent, etc. on March 1.  This process puts the

invoices in the queue to be paid. 

 
From the generation of recurring invoices, they can be imported to TimberScan for

 
• attachment of an invoice

 
• and approval processing like any other invoice.

 
To Import the recently generated Recurring Invoices

Go to the TimberScan Menu Option for Invoice Entry > 

Import Invoices from AP >

Import Recurring Invoices from AP - There is no matching process as the pro-forma Image has already been

attached.

 
 



 

 

 
 
TimberScan will import all invoices after the start date you input or you can bring in a single or range of batches.

 
 



 

 

 
If you import to TimberScan without an Invoice Type, the Approval Workflow will follow the invoices normal workflow

determined by your company. 

 
You can override the normal approval workflow by choosing an Invoice Type (for example, auto approve) determined by

your company setup. 

 
 



 

 

Invoice Type Special Routing and Auto-Approve Invoices
 
User-defined invoice types have two functions within TimberScan:

 
1. The first is as a method to classify invoices for special handling.

 
An example of this are invoices submitted for rush payment. Creating a Rush Invoice “invoice type” will allow

invoices so designated to be selected during data entry, approval or final review, thereby bypassing all other invoices

that may be in the respective queues. Invoice types can be assigned at any stage during the Acquire, Data Entry or

Approval processes, but in order to be able to do so, the user must have been granted Chg Type permission in User

Maintenance. 

 
2.The second function of invoice types is as method to route invoices that takes precedence over all routing rules.

 
 

In order to route by invoice type

 
•  Invoice Type must be selected in Routing Settings and

 
•  Invoice type must be assigned to an approval group using the Approval Group Members function after having

been defined. 

 
• Two categories of this feature will be covered; Auto Approve Invoices and Manual Routed Invoices.

 



 

 

Auto Approve Invoices
 

The Invoice Type feature can be used to create a special class of invoice that does not require additional approval. 

Using this feature will instruct the system to bypass the assigned approver designated in the business rules.

 A common reason for identifying invoices of this type is that they match the purchase order or commitment and do

not need further approval.

 
This procedure should not be confused with the Auto Approve feature.  That process is used to identify vendors or G/L

accounts that are always auto approved. 

 
 
 
 
 



 

 

Auto Approve – Invoice Type - Admin Setup
 
 
Step 1 Give Users the ability to change an Invoice Type.

 
•  While signed in as Admin, Go to User Maintenance - Make sure that the data entry user has rights to “Change Type”. 

This creates the button on the data entry screen that allows one to select “Auto Appv”

 

 
 
 
Step 2 Create an Approval Group for Invoices to be Auto Approved



 

 

 
You must be signed in as an Administrator.  Select Approval Group Maintenance. This option is found in the TimberScan

Administration / Maintenance >Approval Group Maintenance>Approval Workflow.

 
Create an Approval Group for Auto Approve invoices.  All approval levels are set as none.

 

  

 
 
Step 3. Create an Invoice Type for Auto Approve. 

 
This option is found in the TimberScan Administration / Maintenance / Invoice Type Maintenance

 



 

 

 
Step 4. Create an Approval Group Criteria = Auto Approve. 

 
This option is found in the TimberScan Administration / Maintenance / Approval Group Maintenance/Approval Group

Criteria.

 
This step associates the new Invoice Type = Auto Approve with the Approval Workflow that bypasses approvals.

 

 



 

 

 
Make sure that you select the Member Type as Invoice Type.

 
Auto APPV will initially be listed under Unselected Group Members.  Just highlight it & click select.

 
 
 
 
 
 
 
 
 
 



 

 

Auto Approving Invoices
 
You can set invoices to Auto Approve two ways:

 
1.  By Acquiring as an Invoice Type = Auto Approve or

2.  Manually changing the Invoice Type in Invoice Entry

 
The first method is to acquire an invoice as an Invoice Type:

 
This is what the screen in Acquire Images should look like when you acquire an Invoice as Auto Approved.

 

 
The Second method is changing the invoice type during invoice entry . 

 
When you are in Invoice Entry, (if you have been given the rights in User Maintenance to "Change Type") you will see the

button "chg type".



 

 

 

 
Select “Chg Type”.   An Invoice Type option will pop up.

 
 

 
Select Auto Approve

 
 
Once you select the invoice type the following message pops up



 

 

 
 

 
Once this invoice is accepted it will be ready for Final Approval.

 
 
 
 
 
 
 
 
 
 
 
 



 

 

Auto Approve for Invoices Imported from Sage 300 CRE
 
Invoices relating to Purchase Order are often posted to Sage 300 CRE A/P first then imported into TimberScan.

 
 

 
During the Match Imported Invoices process you can identify invoices that do not require approval by clicking on Change

Type and highlighting AUTO APPV.

 
 
 
 
 
 
 



 

 

Using Invoice Type to Create Manual Routing
 

You can also use the Invoice Type field to create manual routing thereby bypassing the predefined routing rules.

 

 
For example if an invoice is coded to a job that invoice would normally route to the project manager assigned to that job.     

           

However, you may want that invoice to go to a supervisor first. 

Using the invoice type feature will allow that to happen. 

 
 



 

 

Admin Setup
 
1.     When signed in as an Admin, Go to Maintenance/Invoice Type Maintenance to setup the bypass or manual Invoice

Type

 
 

 
2. While still in Admin, Select Approval Group Maintenance> Approval Group Workflow.

 



 

 

 
 
3.     Create  Approval Group Criteria.  This option is found in the TimberScan Administration > Maintenance > Approval

Group Maintenance> Approval Group Criteria.

 
So now whenever you change an invoice type to Mr. Hall, it will bypass it's normal routing and follow the workflow you

have defined for Mr. Hall.

 



 

 

 
 
Make sure that you select the Member Type as Invoice Type.

 
“Mr Hall” will initially be listed under Unselected Group Members.  Just highlight it as click select.

 
 
 
 
 
 
 
 
 
 



 

 

Data Entry
 

Override Approval Groups using Manual Routing with Invoice Types

 
 

Select “Chg Type”

 

 



 

 

Select the approver you want.  Once this invoice is entered it will be routed to the selected approver rather than the one

defined in your business rules.



 

 

Manual Routing Feature
 

This feature allows users to route invoices to any approver. 

 
It is very useful when the data entry person does not know how to code an invoice or when they want to route it to a specific

approver rather than to the assigned one. 

 
There is very little setup required to use this feature.  It may be preferable to the manual route option discussed above. 

 
With only a couple of simple steps you will be able to manually route an invoices when there is NO job or detail information

coded.

 
The first step is to set your Administration settings to allow NO job or GL information. You must be signed in as

Administrator to get this option.

 



 

 

 

The second step comes during Invoice entry.  If the distribution detail is blank , it will automatically ask you

who you want to send the invoice to. 

 



 

 

 
 

 
Simply select the approver you want to send the invoice to and press OK.



 

 

Accrual Feature
 

TimberScan gives the ability to automatically create an accrual journal entry based on invoices that are still unapproved in

TimberScan. 

 
• You can select individual invoices you want to accrue or accrue them all. 

 
• TimberScan will create the accrual entry in Sage 300 CRE and also create the auto-reserving entry. 

 
• You can specify the rules you wish to use for accrual processing. 

 
• TimberScan can accrue Job Cost invoices as well as regular invoices. 

 
 
 
NOTES:

 
The systemwill not accrue invoices uploaded from AP or recurring invoices as these invoices already exist in Accoutns

Payable. Invoices uploaded from file do accrue.

 
The month utilized in the cut-off date for the accrual period must not be closed. If it has been closed, see the Closing

Accounting Periods topic on how to re-open a closed month in TimberScan.

 



 

 

 
Accrual Settings

 
While signed in as Administrator, 

Select Settings > Accrual Settings

 

 
You can define the rules for accruing invoices.

 

 
Job Cost Accruals:

 
 Select this if you need accruals to post to Sage 300 CRE's Job Cost Module. 

 
Completed Invoices:  The default is “Use Invoice Values” for Completed Invoices.



 

 

 
The other options are:

 

 
Incomplete Invoices: The default for Incomplete Invoices is “Do Not Accrue”. 

 
The other options are:

 

 
If you Decide NOT to use the invoice values you can use Default Values for the Job Cost fields and/or General Ledger

accounts.

 
Default Settings for Job Cost Accruals

 



 

 

 

You must enter an Credit Account (Probably an Accrual Account)

 
 
Regular Invoice Accruals

 
These are invoices without Job Cost information. You can elect to accrue or not to accrue. 

 



 

 

 
The Regular Account Accruals allow you to use the Invoice Values for posting to G/L or default values.

 
You will have to choose a credit account regardless how you choose to accrue the invoice amounts or debits.

 
Accrual Entries/Reversing Entries:  If you are using Named Files you can choose which file names to use.

 
If you select to use Reference 1 and Reference 2, make sure you have Use Ref 1 and Ref 2 checked in Sage 300 CRE Job

Cost > Job Cost Settings > Direct Cost. 

 

 
Also, in Job Cost Settings > GL Entry, the Don’t Allow Override option must be unchecked.

 



 

 

 
Tax Accrual settings allow you to override the accounts that the tax accruals post to

 

 
Tax Accrual settings allow you to override the accounts (Default Values) that the tax accruals post to.

 
 
 
 
 



 

 

Accrual Process
 
• TimberScan has an accrual feature that lists all unapproved invoices and allows you to select the invoices that you wish to

accrue. 

 
• The system will create a month-end accrual journal entry and an auto reversing journal for the first of the new month. 

 
• For Job Cost transactions it will create the journal entry in Job Cost.

 
• For overhead or property management transaction it will create a journal entry in the General Ledger.

 
NOTE:  It is highly recommended to print the Unaccruable Distributions report before running the accrual process. This

report displays distributions which will not accrue, such as recurring invoices or invoices uploaded from AP.

 
Please follow these steps to properly accrue the necessary invoices, as well as close and set the new Accounting Periods

within TimberScan.

 
 
1)     Login to the TimberScan system as a user who can create the Accruals, Special Permissions set to (supervisor or

executive).

 

 



 

 

 
2)     Select Utilities > Accrue Invoices.

 

 
 
3)     Once the ‘Accrue Invoices’ is selected, the user will see the following screen. Within this screen, the user will need

to identify a number of dates. Please see the screen shot below along with the reference points directly below for complete

description of each date that is necessary for Accruing Invoices.

 

 
 
• Cut-Off Date: The Cut-Off date will usually be the last day of the month you are accruing.

 
• Transaction Date: The Transaction Date will be the date assigned to the accrual transaction that is being built with this

process.



 

 

 
• Reversal Date: The Reversal Date is the date the accrual reversal will be dated within Sage 300 CRE. This should always

be set to the first day of the next month, unless otherwise defined.

 
• Change Accounting Date - New Accounting Date: The New Accounting Date is the date that will be applied to all non-

approved invoices that are being accrued. Thus, moving their accounting date will allow them to be processed (approved

for payment) in the next accounting period or if needed, accrued again. NOTE: There is a separate step for this process if

you would rather do it separately.

 
• Close Accounting Period - Period End Date: This should always be the last physical day of the month that is being

closed.  Setting this date to the last day of the month will prevent anyone from accidently keying into an Accounting

Date that is no longer available for use. This will force the user inputting invoices to use the new Accounting Period, thus

allowing for new invoices to process forward smoothly.

 
4)     When the dates have been defined, the Accrual user should now select the ‘Compile’ button. This will compile the list

of invoices that are available for the accrual process. When this is complete, the system will allow the ‘Review’ button to be

selected.

 

 



 

 

5)     After the ‘Compile’ function has completed, select the ‘Review’ button to see all possible invoices that can be

potentially accrued. The screenshot below is for illustration purposes only.

 
Please note that when the ‘Review’ option was selected the list of invoices available for accrual is automatically displayed,

with all having the check box to the far left selected.

 
If the Accrual user sees an invoice(s) that does not need to be accrued, the user deselects that invoice(s) by clicking the

check box thus removing the check mark.  You can also unselect them all and select invoices one by one. 

 

 
Note:  It is a good idea to print this report or export it to Excel to be able to confirm the amounts and accounts in

Timberline. 

 



 

 

 
6)     If all the necessary invoices have been identified and have the appropriate check mark, the user can select ‘OK’ to

continue with the accrual process.

 
7)     The user will be returned to the Accrue Invoices screen (see screenshot below)

 



 

 

 
8)     If the user is satisfied that the dates and invoices to accrue are accurate, the Accrual user can now select the ‘Accrue’

button to finalize the Accrual process within TimberScan.

 
     When selecting the ‘Accrue’ button, the user will be prompted to save the accrual file.

 



 

 

 
     The Accrual file should be named automatically by the system. Please do not change the file name being used when

saving, unless absolutely necessary. Please be sure to save this file to the appropriate location on the Sage 300 CRE

server as you will need to access this file and import it into the Sage 300 CRE Job Cost module to complete the Accrual

process.

 
9)     Once the file has been saved, open the Sage 300 CRE Job Cost module and then go to the Tools > Import Direct

Costs.

 

 



 

 

 
When prompted, access the file saved during step 8 above and import.

 
 

       

 
PLEASE NOTE: If there are any GL Accruals, they will import as part of the Job Cost import. However, you will have

to post those entries in GL.

 
 
 
 
 



 

 

 
 



 

 

Accruals and Sage Accounting Date
 
 
When accruing invoices in TimberScan, we recommend that you do NOT set the accounting date in Sage 300 CRE

(Timberline) to be the same as the Invoice Date.

 

 
Using this setting in Timberline will cause invoices to be expensed twice in the same accounting period.

 
The following example explains the issue:

 
1. TimberScan invoices are accrued as of February  28. Reversal entries are created as of March 1.

 

 
 

 



 

 

2. The February accounting period is closed in TimberScan and the accounting date on all invoices prior to March 1 is

changed to March 1.                                                                                                                                              Invoice Date   

      Accting Date    

 
3. Assumption 1: February accounting period is NOT closed in Timberline:

When TimberScan invoices are exported to Timberline AND the accounting date is set to invoice date, Timberline ignores

the 3/1 accounting date on the TimberScan invoice. Instead, Timberline uses the February invoice date and posts to the

month of February. Since the accrual entry already was expensed to February, the expense is essentially “doubled” for the

February accounting period.

 
   Assumption 2: February accounting period is CLOSED in Timberline:

When TimberScan invoices with invoice dates prior to 3/1 are exported to Timberline AND the accounting date is set to

invoice date, Timberline will reject the invoices back to TimberScan. Timberline is looking at the invoice date (February)

as the accounting date and that accounting period (February) has been closed. [NOTE: This assumes entry to a closed

accounting period is not allowed.]

 
 
 



 

 

Closing Accounting Periods
 
You can close the month in TimberScan at the same time as you accrue, however, if you prefer to do this

in a separate step you can. 

 
From Utilities >  Close Accounting Period

 

 
Enter the date you wish to use for the ending date of your TimberScan accounting period. 

 
No transactions will be allowed with accounting dates less than or equal to this date.

 

 
 
These options are part of the Accrual process.  If you do not process Accruals, this option makes sure that you do not post

invoices with accounting dates less than or equal to the indicated date.

 
 
 
 



 

 

 
 
 



 

 

Changing Accounting Dates
 

You can Change the Accounting Dates in TimberScan as part of the accrual process, however, if you

prefer to do that in a separate step or if you do not accrue invoices, you will do this step from Utilities.

 
From Utilities >Change Accounting Date

 

 
This step will change the accounting date for all unexported invoices in TimberScan (not just on those accrued invoices).

You will want to do this so the invoices are not rejected in Timberline when you close your month there.  

 

 
 
In the example above, all invoices with dates less than 2/29/12 will get a NEW accounting date of 3/1/12. 

 



 

 

Automatic Job Setup
 

Once a job is set up in Sage 300 CRE the  job can automatically be assigned to the correct Approval Group in TimberScan

based on it's Job Authorization. 

 
This feature eliminates the need to define new jobs in the TimberScan Admin Setup.

 



 

 

Setup in Sage 300 CRE – AP
 
Approval ID's for Job Authorizations can be set up in Accounts Payable or Set up on the Fly.

 
If setting up in Accounts Payable prior to setting up the Job, use Approval ID's under Setup.

 
 

 
Enter an abbreviation such as initials for the ID and then give a more detailed description of the ID. 

 

 
 
 



 

 

Setup in Job Cost
 
From Job Setup choose the AP and GL tab.

 
 

 
Tab to the Approval ID field and click on List to get the list setup in AP or enter a new Approval ID and Description. 

 



 

 

 
If the Approval ID was assigned to an Approval Workflow in TimberScan previously, then the Job has automatically been

assigned to that Approval ID workflow. 

 
If you have added a new Approval ID for this job, you will need to add this approval ID to a workflow in TimberScan.  Any

jobs added later with this same Approval ID will automatically be assigned to the approval group that you add.

 
 
 



 

 

Admin Setup in TimberScan
 

Setup in TimberScan Admin

 

 
In Admin > Routing Settings.

 
Select the Routing Rules that you require.  Routing Rule #12 is the one to use for Automatic Routing.

 



 

 

 
 

 
 
 
Select Approval Group Members.

 

 
• Select the Approval Group for automatic Job Routing, i.e. “John Jones Jobs”. 
• Select  Member Type “Job Authorization” from the pull down menu. 
• Highlight “Job Authorization JJ John Jones” and click on the Select button between the two boxes. 

 
Once selected the Job Authorization will display below the listed jobs. 



 

 

 

  Now all new jobs assigned to John Jones in Sage 300 CRE will automatically be assigned in TimberScan.

 

 
Adding the approver’s Job Authorization code to the Approval Group Members is all that needs to be done. 

 
When a new job is created in Sage 300 CRE and the approver is selected in Approval ID, then the invoices for that Job will

authomatically be routed to the selected approver.

 
Note: The jobs listed with this example were set up previously. 

 



 

 

Hold Accounts Payable Invoices
 
There are two ways to Hold AP Invoices. 

 
1.      You can use the Sage300 CRE Accounts Payable Approval System that allows you to Hold an invoice in Timberscan

and send it over to Timberline as held.  NOTE: Sage 300 CRE Accounts Payable MUST BE set up to use the Approval

System before some menu options will be available. 

 
2.     There is also a Timberscan Hold system that allows an Approver to hold an invoice they have questions or concerns

for until they can get answers they need.  The Timberscan Hold is only for an Approver and can only be released by that

Approver.  The invoice held by an approver will not be sent through Timberscan for other approvals and will not be exported

to Timberline. 

 
 



 

 

 
Hold Invoices in Sage 300 CRE Accounts Payable

 
Normally Invoices posted to Timberline from TimberScan are available to be selected for payment. Invoices marked Hold

in A/P have to be approved using Timberline’s Approval System first. 

 
Clients have asked us for this feature to free up invoices for export that may, otherwise, get stuck in Timberscan at the

approver level. 

 
Hold in A/P can be used for invoices in cases where management may be waiting for additional documents such as

an insurance certificate or Lien Waiver AND they want the costs of those invoices to be included and available within

Timberline.

 
Using this process, invoices are sent to Sage 300 CRE Accounts Payable two ways,

1. Approved for payment (Still needs to be processed/selected for payment) and

2. Held in Accounts Payable (Requires another approval within Sage 300 CRE Accounts Payable before available

for payment).

 
 
 

This requires additional setup in Sage and Timberscan. 

 
1. Sage 300 CRE Accounts Payable to be setup to use "Approval System"

2.  Approval of all existing AP Invoices before they are ready to process for payment.

3. Timberscan Settings "set an approval flag".

3. User Maintenance set to "Allow Hold"

 
 
 



 

 

 
 

Set up Sage 300 CRE Accounts Payable – To Use Approval System
 

Two parts:       1. Set AP to "Use the Approval System"

 2.  Approve all existing invoices so those invoices can be processed for payment

(otherwise they will not be available to select for payment). 

 
The First step is to set the AP Settings to “Use the Approval System”.  AP > Company Settings > AP Settings > Use

Approval System.

 
 

 



 

 

 
Make sure that “Use approval system” is checked.  This will allow Timberscan to control the approval flag so that

invoices marked as Hold in A/P will require an additional approval in Sage 300 CRE Accounts Payable before they

can get paid. 

 
Then, in Timberline, go to the Task Menu > Approve invoices and

 

 
 
 



 

 

 
Automatically approve all invoices currently in Sage 300 CRE Accounts Payable. 

 
This is important so that existing invoices can be selected for payment. 

 
And, now you are ready to setup Timberscan to use the Held in AP process. 

 
 



 

 

Setup in TimberScan - To Use Sage 300 CRE Approval System
 

Step one: Set  TimberScan to Set an Approval Flag upon exporting to Timberline. 

 
Step Two: The Second step is to  Allow Hold in A/P for each user who needs it.



 

 

 
Set Timberline Approval Flag

 
1. Sign in as Admind

2. Routing Settings

3. Set Timberline Approval Flag on Export.

 
 
 

 



 

 

 
Set Timberline Approval Flag on Export, so that invoices NOT marked as Hold in AP are marked as Approved.

 
Note: this should be checked in order to use the Hold In AP feature.



 

 

User Setting: Allow Hold in AP
 
While signed in as Admin > User Maintenance

 

 
 
 
Check “Allow Hold in A/P” for every user that should have this ability.

 
Note:  If the option is grayed out, 1. make sure you set the Sage 300 CRE Accounts Payable to "Use Approval System"

AND 2. Make sure you are in the same data folder.  (For example, if you have multiple companies, one might have approval

turned on and one may not.  If construction company 1 has approval turned on, then you will need to be the Timberscan

datafolder for the same company, construction company 1.  Some Admin settings are global while others, such as "Allow

hold in AP" are data folder specific. 

 



 

 



 

 

Workflow Procedure for Approvers and Data Entry using AP Hold
 
 

 
Selecting Hold in AP TimberScan will require a comment.

 

 
Once an invoice is selected for “Hold in AP” the icon will now read “Held in AP” so everyone will know its status.



 

 

 

 
 
 
 
 



 

 

Releasing Held Invoices in Sage 300 CRE A/P
From Accounts Payable >Tasks>Approve Invoices

 

 
Just like Selecting Invoices for Payment you can review all invoices to approve or review invoices based on the criteria

listed.

 
 

 
Click on Start to see the invoices.

 



 

 

 
Select the “Display”.Button

 

Select “Unapproved Only”.

 



 

 

 
Approve the Invoices you want to be able to be selected to be paid by double clicking on the invoice.  

 

Note:  The paper clip attachment will show you the invoice and all supporting documents plus the notes.

 
 
 
 

 
 

 



 

 

Hold ONLY in TimberScan
 

There is a simple HOLD available in TimberScan.  It does not carry over to Sage 300 CRE Accounts

Payable.

 
In order to use TimberScan's Hold you have to have permissions set in User Settings.

 

 
Once you have permissions set to Hold TimberScan invoices you will see the Hold button in Invoice Entry.

 
 



 

 

 
From Invoice Entry you put the invoice on HOLD.  Once an invoice is on hold, it MUST be released by the person who put

it on hold. 

 
A Comment is required to put an invoice on Hold.

 

 
Once you put the invoice on Hold it will be moved out of Invoice Entry to a Held Invoice location.

 



 

 

 



 

 

File Import Feature
 

Files that you are currently able to import into Sage 300 CRE can be imported directly into TimberScan.  That’s right! 

You can import fixed or variable format files directly into TimberScan, match the data to the image and send them off for

approval.  You may be able to get files from your vendors or use Excel® as a template for invoices to import.  These are

ways to reduce data entry time.

 
First things first:

 
#      Sage 300 CRE license must have import activated (no extra charge)

 
·     User must have permission for import

 

 
 
·     If you want to Final Review imported invoices

 
     Admin > Settings > Routing settings



 

 

Check the box for “Final Review Mandatory for Imported Invoices”

 

 
 

·     Import files must have extension name of “.txt”, but be the traditional comma separated value (CSV) format

 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 



 

 

File Import Setup
Fixed format files need no additional setup.

 
Variable format files must be setup in Admin before importing.

 
1.     Admin > Settings  > Define Import Formats

 
a.     Check the boxes for the appropriate fields your Sage 300 CRE AP system uses from the report you printed

from Sage 300 CRE AP > Save

 
b.     Repeat this setup for each of your data folders

 
c.     Change data folders and go to Define Import Formats again to set the correct AP fields for the current folder

 



 

 

 
 



 

 

Processing Import Files
 



 

 

Acquire Imported Invoice
 
 
Be absolutely certain to acquire the images with Image Type of “Imported Invoices”

 

 

 
After [Process], when prompted for a batch name, use a unique name like today’s date and your initials

 

 
 
 



 

 

Import Data
 
 
Import Data > Invoice Entry > Import Invoices from AP > Import Invoices from File

 
o     Browse to your import file,

 
o     The reject file name will prefill

 
o     Click [New] to enter a new batch name for the data

 
o     (we recommend that it is the same ID as the acquire batch)

 
o     Choose your data entry group > [Start]    

 
 

 



 

 

Match Images to Data
 
Invoice Entry > Import Invoices from AP > Match Imported Invoices

 
     Choose your two batches (hopefully with the same name) > [OK]

 

 
     With the image on top of the screen, click on the correct line for this invoice number to highlight the data in yellow

and [Match]

 
     Warning:  The images and the data may NOT be in the same order – so watch your invoice numbers!

 
     [Finish] to send invoices to approvers



 

 

Import Invoices into TimberScan
 
 
IMPORT INVOICES INTO TIMBERSCAN

This feature allows you to import various types of invoices into TimberScan for image attachment and/or approval. If using

TimberScan’s approval system, the approval system must also be activated in Sage 300 CRE Accounts Payable.

 
Why use this feature?

There are several reasons to import already coded invoices into TimberScan:

Import Regular Invoices

1. If you need to have costs in Accounts Payable, General Ledger and/or Job Cost as soon as the vendor invoice is entered,

enter the invoice in Sage then import the invoice into TimberScan to match the invoice image to the invoice. Optionally, you

can route the invoice through TimberScan’s approval process. The invoice in Sage remains “unapproved” while the invoice

is routed for approval through TimberScan. After final approval, the approval flag in Sage is automatically set to “approved.”

 
Import Imported Invoices

2. Invoices from Sage’s Purchase Order and Service Management modules are coded and automatically sent to Sage 300

CRE Accounts Payable. The import invoices feature in TimberScan allows the operator to match images to the invoices and,

optionally, route invoices through TimberScan’s approval system.

 
NOTE: Starting with Sage 300 CRE version 12.1, invoices from the PO module are imported as “regular invoices” in

TimberScan – Option 1 above. Invoices created in the PO module on Sage 300 CRE versions prior to 12.1, are treated as

“imported invoices.” Invoices from Service Management are also treated as “imported invoices” – Option 2.

 
Import Invoices from File

3. Data from a comma-delimited TXT file in the correct Accounts Payable import file format can be imported into

TimberScan as coded invoices which then can be matched to images and routed through the approval process. 

 
Import Recurring Invoices

4. Use this feature to import Sage 300 CRE recurring vendor invoices into TimberScan to match images to invoices and,

optionally, to route invoices for approval.

 



 

 

IMPORT INVOICES ORIGINALLY ENTERED AND
POSTED IN SAGE 300 CRE ACCOUNTS PAYABLE:

 
1.     IMPORT INVOICES ORIGINALLY ENTERED AND POSTED IN SAGE 300 CRE ACCOUNTS PAYABLE:

 
SETUP:

 
If approving invoices in TimberScan, the Approval system must be turned on in Sage. In TimberScan, log in as admin

and select System Settings; check the Approve Regular Invoices if you want to send these invoices through TimberScan’s

approval process.

 
NOTE: You must also check either the Approve Imported Invoices or Approve Recurring Invoices to display Import

Invoices on the TimberScan menu:

 
 

In Routing Settings, check Final Review Mandatory for Regular Invoices. If routing invoices for approval, check the Set

Timberline Approval Flag on Export. NOTE: Do NOT check the Final Review Mandatory For Imported Invoices box. If

checked, the Acquire feature does not allow the “Invoices Uploaded from AP” selection to display.

 



 

 

 
In User Maintenance, check the Import Invoices permission:

 

 
WORKFLOW:

 
1. Acquire the invoice images:

Acquire – Invoices Uploaded From AP

 

 
When prompted, enter a description for the batch of invoice images.

 
2.  Import the invoices from Sage:

Invoice Entry > Import Invoices from AP > Import Invoices

     Invoice Type – Import Regular Invoices



 

 

     Batch Description – enter the same description used for the Acquire process. This will make it easier to match the images

to the invoices in Step 3.

     Data Entry Group – select a data entry group

     Start Date – enter the beginning date to search for invoices

     Import Type: select AP for invoices enter in Accounts Payable or PO for invoices originating from the Purchase Order

application or both if you have multiple batches containing a mixture.

     Select AP Batch By: (1) All Batches since the Start Date; (2) Specific Batch since the Start Date; or by (3) Operator ID

since the Start Date.

 

 
Select the Start button.

 
 
3. Match Images to Invoices:

Invoice Entry > Import Invoices from AP > Match Imported Invoices

Enter the batch name for the invoice images.

Enter the batch name for the imported invoices.

Select OK.

 
For each image, highlight the invoice below and select the Match button. There is no way to automatically match multiple

images to multiple invoices as the import order may be different for both groups. You are able to sort on the column

headings:

 



 

 

 
OPTIONAL: While in the session, you can select to Unmatch images with invoices:

 

 
The invoices (including auto approve invoices) will be routed according to their coded information. Once final approved,

the images are attached to the invoices in Sage and the approval flag is automatically set so the invoices can be selected for

payment. The invoices no longer show as being in TimberScan (they do not display on the Invoice Status Inquiry).

 
 
 
 



 

 

IMPORT INVOICES IMPORTED INTO
SAGE 300 CRE ACCOUNTS PAYABLE:

 
Use this option to import invoices which were originally imported in Sage 300 CRE Accounts Payable. This includes

invoices created in Sage’s Service Management application or Builder MT. Also, use this option to import invoices from

Sage’s Purchase Order module – only if created on Sage 300 CRE versions prior to release 12.1. (Use Option 1 above to

import PO invoices created in release 12.1 and after.)

 
SETUP:

 
If approving invoices in TimberScan, the Approval system must be turned on in Sage. In TimberScan, log in as admin

and select System Settings; check the Approve Imported Invoices if you want to send the invoices through TimberScan’s

approval process. Also, check “Approve Regular Invoices” to include the Import Regular Invoices in the drop-down list

(beginning with version 12.1,  Sage considers invoices from the Purchase Order application as “Regular” as opposed to

import imported invoices).

 

 
In Routing Settings, check the Final Review Mandatory For Regular Invoices box.  If routing, check the Set Timberline

Approval flag on Export:



 

 

 
In User Maintenance, check the Import Invoices permission:

WORKFLOW:

1. Acquire the invoice images:

Acquire – Invoices Uploaded From AP

 

 
When prompted, enter a description for the batch of invoice images.

 
2.  Import the invoices from Sage:

     Invoice Entry > Import Invoices from AP > Import Invoices

     Invoice Type – Import Imported Invoices

     Batch Description – enter the same description used for the Acquire process. This will make it easier to match the images

to the invoices in Step 3.

     Data Entry Group – select a Data Entry Group

     Start Date – enter the beginning date to search for invoices



 

 

     Invoice Type: Optional; if you acquired images using an invoice type, select the same invoice type here.

     Select AP Batch By: (1) All Batches since the Start Date; (2) Specific Batch since the Start Date; or by (3) Operator ID

since the Start Date.

 

Select the Start button.

 
 
3. Match Images to Invoices:

Invoice Entry > Import Invoices from AP > Match Imported Invoices

Enter the batch name for the invoice images.

Enter the batch name for the imported invoices.

Select OK.

 
For each image, highlight the invoice below and select the Match button. There is no way to automatically match multiple

images to multiple invoices as the import order may be different for both groups. You are able to sort on the column

headings:

 



 

 

 
OPTIONAL: While in the session, you can select to Unmatch images with invoices:

 

 
The invoices (including auto approve invoices) will be routed according to their coded information. Once final approved,

the images are attached to the invoices in Sage and the approval flag is automatically set so the invoices can be selected for

payment. The invoices no longer show as being in TimberScan (they do not display on the Invoice Status Inquiry).

 
 
 



 

 

IMPORT INVOICES FROM A FILE:
 
 
Use this option to import invoices from a TXT file into TimberScan. If your vendor can send you invoices in a comma-

delimited format that matches Sage 300 CRE’s AP import invoice format, you can use this feature in TimberScan to import

data from a file. After the import, invoices can be matched to images and routed through TimberScan’s approval process.

When importing into the program, TimberScan is expecting a comma-delimited TXT file.

 
Setup: Import invoices from a file does not need any of the Invoices Uploaded from AP options checked:

 

 
In Routing Settings, check the Final Review Mandatory For Imported Invoices box. NOTE: If you are also importing

invoices from Sage 300 CRE, that option should not be checked.

 

 
In User Maintenance, check the Import Invoices permission:

 



 

 

WORKFLOW:

1. Acquire the invoice images:

Acquire – Imported Invoices

 

 
When prompted, enter a description for the batch of invoice images.

 
2.  Import the invoices from a comma-delimited TXT file:

Invoice Entry > Import Invoices from AP > Import Invoices from File

     Import File – browse to the comma-delimited TXT file

     Rejected Records File – TimberScan automatically creates the name for the reject TXT file

     Batch Description - enter the same description used for the Acquire process. This will make it easier to match the images

to the invoices in Step 3.

     Data Entry Group – select a data entry group

     Invoice Type: Optional; if you acquired images using an invoice type, select the same invoice type here.

 

 
Select the Start button.

 



 

 

3. Match Images to Invoices:

Invoice Entry > Import Invoices from AP > Match Imported Invoices

Enter the batch name for the invoice images.

Enter the batch name for the imported invoices.

Select OK.

 

The invoices will be routed according to their coded information. Afterwards, invoices go to Final Review to be queued for

Export and exported into Sage 300 CRE Accounts Payable.

 
 
 



 

 

IMPORT RECURRING INVOICES INTO TIMBERSCAN:
 
 
Use this feature to import recurring invoices from Sage 300 CRE into TimberScan where they can be approved and matched

up to invoice images. There are four conditions that must be met to import a recurring invoice:

 
1.     Assuming that importing is based upon the last import cutoff date and not a specific batch, the date stamp of the            

  APM_MASTER__INVOICE record must be greater than or equal to the cutoff date entered when generating recurring       

  invoices in AP.

2.     The invoice status cannot be ‘Fully paid’

3.     The Batch Source must be “Generate invoices’

4.     The invoice cannot already exist in TimberScan

 
SETUP:

If approving recurring invoices in TimberScan, the Approval system must be turned on in Sage. In TimberScan, log in

as admin and select System Settings; check the Approve Recurring Invoices if you want to send the invoices through

TimberScan’s approval process.

 
In Routing Settings, check the Set Timberline Approval Flag on Export:

 

 
In User Maintenance, check the Recurring Invoices permission:



 

 

 

WORKFLOW:

1. This step is optional. If you would like to attach a permanent approval page or invoice image to the recurring invoice

SETUP in Sage 300 CRE, perform the following:

     • Acquire the image as a recurring invoice

 

     

     • Invoice Entry > Enter recurring invoices

     • Select the appropriate vendor and recurring invoice ID to attach the image to

    

NOTE:     The above step is not required in order to route recurring invoices through TimberScan.

     This image will not sent through approval – it is stored in Sage recurring invoice setup as a reference.

 

 
 

 



 

 

2.  Follow these steps to process recurring invoices through TimberScan for approval:

Generate recurring invoices in Sage 300 CRE Accounts Payable

Import the generated invoices into TimberScan:

 
Invoice entry > Import Invoices from AP > Import Recurring invoices from AP

     Batch Description – enter a description for the batch; it will not be needed later since there is no matching step.

     Data Entry Group – select a data entry group; this group will be skipped since these invoices go straight to be approved.

     Invoice Type: Optional; if the recurring invoices do not need to be approved, consider using an “auto approve” type.

     Start Date – Enter the processing date on the recurring invoices batch. This is the first date that TimberScan will start

looking for batches and will continue through to the current date and time.

     Select AP Batch By: (1) All Batches since the Start Date; (2) Specific Batch since the Start Date; or by (3) Operator ID

since the Start Date.

 

     

     Select the Start button.

     The following occurs automatically:

•     A “substitute” image will be attached to each recurring invoice showing the vendor code, invoice number from Sage and

the amount of the invoice.

•     The invoices will route to the appropriate approvers according to their coded information.

•     Once final approved, the images are attached to the invoices in Sage and the approval flag is automatically set so the

invoices can be selected for payment. The invoices no longer show as being in TimberScan (they do not display on the

Invoice Status Inquiry).

 
 



 

 

Verify Export Batches
 
On very rare occasions an exported invoice does not make it to Sage 300 CRE and it is no longer available in TimberScan.

 
This Verify Export Batch utility compares invoices that TimberScan recorded as exported to Sage 300 CRE to the ones that

actually made it into Sage 300 CRE A/P.

 
 If there are any invoices that the utility does not  find in A/P it will re-establish them into the TimberScan export queue.

 

 

 
 
 
 



 

 

 
 
 
 
 
 
 



 

 

Clear Export Lock
 
If you experience an abnormal termination during the export process TimberScan may get stuck in export mode even after

you reboot.  When you try to export again you well get this message.

 

 
If you get the message above and your sure no one else is actually exporting to Sage 300 CRE select “Clear Export Lock”

from the Utilities Menu.

 

 
 

 
Clicking “Yes” will clear the problem.  You can now export to Sage 300 CRE.

 



 

 

Dashboard
 



 

 

Introduction to Dashboard
 

To view a Video of Dashboard click on the following link:

 
Dashboard Video

 
What is TimberScan’s Dashboard?

 
 It’s a graphical look at invoices that are awaiting approval or final review in TimberScan.

 

 
 It is also a pictorial way to view invoice images in one or multiple data entry queues.

 
There are two new icons on File Menu in TimberScan – Show Dashboard and Show Data Entry.

 

NOTE: A user may be given the 'Dashboard View Only' permission in admin > User Maintenance. This allows the user to

view invoicees but not have the ability to edit and/or approve/final review invoices.

 
 

http://www.screencast.com/t/YihVdFMuB5Qb


 

 

 



 

 

Dashboard Menu Items
 

You may select one or both views at the same time. Toggle the views on or off by selecting and re-selecting the new icons.

 
 

Dashboard toolbar

 

Data Entry toolbar

 
 



 

 

 
 
 

Show Dashboard button

 
 
If you elect to "Show Dashboard", the widgets that you have chosen to display will appear.

 
In this illustration, Invoices by Vendor, Invoices by Job and Invoices by System Aging for approval and final review.

 



 

 



 

 

Data Entry toolbar
 

 
This view is only for members of data entry groups and displays a graphical view of invoice images. Use the buttons in the

lower right-hand corner to move to the next, previous, first and last invoices in the batch.

 
Check the Select Invoice button at the bottom of the screen to review or edit an individual invoice. Or choose  the Edit This

Batch button to have access to all invoices in the data entry group. Either selection opens the familiar TimberScan Data

Entry screens to enter or revise invoices in Data Entry. Use the familiar Accept and Finish buttons to route invoices on to

approvers.

 

Show Data Entry button

 



 

 

 
 



 

 

Show Data Entry
 

This view is only for members of data entry groups and displays a graphical view of invoice images. Use the buttons in the

lower right-hand corner to move to the next, previous, first and last invoices in the batch.

 
Check the Select Invoice button at the bottom of the screen to review or edit an individual invoice. Or choose  the Edit This

Batch button to have access to all invoices in the data entry group. Either selection opens the familiar TimberScan Data

Entry screens to enter or revise invoices in Data Entry. Use the familiar Accept and Finish buttons to route invoices on to

approvers. The Dashboard will refresh (when you hit refresh)

 

Select Invoice button

  Check the Select Invoice button at the bottom of the screen to review or edit an individual

invoice. Or choose  the Edit This Batch button to have access to all invoices in the data entry group.

Either selection opens the familiar TimberScan Data Entry screens to enter or revise invoices in Data



 

 

Entry. Use the familiar Accept and Finish buttons to route invoices on to approvers. The Dashboard will

refresh (when you hit refresh)

 



 

 

Dashboard Widgets
 
Dashboard widgets are grouped by (1) Approve and (2) Final Review.

 
There are 14 widgets to choose from – 7 approval and 7 final review as follows:

 
     Invoices by Vendor              

     Invoices by Job                  

     Invoices by Company*

     Invoices by Payment Date

     Invoices by Days to Discount

     Invoices by Approval Aging

     Invoices by System Aging

*Available only to companies who use GL prefixes.
 
Both Approval and Final Review widgets are dependent on a user’s security.

 
 A user with permission for Approve and Final Review will have access to both groups of widgets.

 
Invoices that display in the widgets are dependent on two criteria:

 
     1) Routing Workflow (the approval stage for the invoice)

 
     2) User Permissions (an Executive user can see all invoices for a particular stage)

 
Each section lists up to ten records. The records can be viewed by the number of invoices or dollar amount.

 For example, if you choose the Invoices by Vendor widget and there are more than 10 vendors with invoices in

TimberScan, the Dashboard displays the largest # of invoices or largest $ amount, depending on your View By

selection.

The largest 9 vendors are listed and the remaining vendor invoices are grouped into a category called Others.

The piechart colors correspond to the invoice list.

 
THIS VIEW IS # OF INVOICES



 

 

 

 
THIS VIEW OF $ AMOUNT

 

 
 Hover over a vendor in the list or on the piechart to see a total # of invoices and dollar value.

 



 

 

 
 
 

 
 
 
 
 



 

 

Customizing Widgets

Dashboard tab

 

Refresh button

 

Vertical Green Bar

Use the vertical green bar on the right side of the screen to display the widgets (graphs).

 
The > (Greater than) icon opens the widget selection screen; the <(less than)  icon closes the screen.

 
Select which widgets to display by checking/unchecking the Show/Hide graphs boxes.



 

 

 

 

Sort Order:# of Invoices option/$ Amount

 

Clear settings button

 

Save settings button



 

 

 
Use the Save Settings button to keep your selection the same next time you select Show Dashboard

 



 

 

Card or Grid View
 
Invoice detail can be displayed in one of two ways on screen – Card or Grid view. Each user can set his/her default view. In

the Card view, each card contains a thumbnail image of the invoice along with invoice detail.The Grid view displays user

invoices in a format similar to TimberScan inquiries - invoices can be sorted by clicking on a column heading. Each view

contains a Details button which shows the invoice distribution coding. In both views – Card and Grid – a comments button is

available only when there are comments on the invoices.

 
What invoices will I see?

Both Approval and Final Review widgets are dependent on a user’s security. A user with permission for Approve and Final

Review will have access to both groups of widgets.

 
Invoices that display in the widgets are dependent on two criteria:

     1) Routing Workflow (the approval stage for the invoice)

     2) User Permissions (approve invoices)

 
Invoices you see in a widget depend on your routing assignments. If you are assigned in a routing stage either individually

or as a member of a group – either as primary or alternate – you will see invoices for that stage. Dashboard invoices are not

segregated into primary or alternate groups. Invoices on hold are also mixed in with other invoices.

 
The “View All” permission impacts what invoices can be viewed in reports and inquiries; therefore it has no impact on what

is shown in Dashboard. Being granted “supervisor” or “executive” privileges also have no effect on invoices displayed in

Dashboard. Currently, invoices meeting the criteria where executives can “approve another’s invoices”, are not included in

Dashboard invoice counts.

 
If you are in a stage, either as an individual or a group, primary, alternate and held invoices are available. In the screenshot

below, the user will see 96 invoices in his/her approval widget:

 

 
 



 

 

 
 
 



 

 

 
Grid View

Select the Grid View button to display the information in a grid format.

 
The same options are available – Edit All, Edit Selected, Approve All and Approve Selected. In Grid View, you can re-sort

data by clicking on a column heading. In both views – Card and Grid – a comments button is available only when there are

comments on the invoices. 

 
Select the Refresh or Minimize button to close the Detail screen. When opening/closing windows, TimberScan may prompt

you at times to refresh the data. Select Refresh at any time to see newly added or revised invoice data.

 

Grid view option

 
Select the Grid View button to display the same information in a grid format.

 

Options available in both views: 

Edit All/Edit Selected/

Approval All/Approve Selected

 
 



 

 

Column Headings

In Grid View, you can re-sort data by clicking on a column heading.

 

 
 



 

 

Card View
 

To see invoice detail, click on a particular item (such as a vendor or job) in the list or on the piechart. A window on the right

side of the screen opens in a Card View. Simply click on a thumbnail of the invoice to enlarge the image. You can select to

Approve an individual invoice by checking the box above Approve and then choosing the Approve Selected button. If you

do not use “Route after Invoice Accepted”, you may select the Approve All button to approve all invoices displayed for the

selected criteria. If the "Rout after Invoice Accepted" permission is checked for a user, that user will not see the Edit All or

Approve All options.

 
Selecting the Edit button opens the familiar TimberScan approval screen to make revisions either to an individual invoice.

Choose the Edit All button to have all invoices display in the approval screen. 

 
Once an invoice is approved, TimberScan will prompt you to refresh the data. Invoice actions are automatically reflected

onscreen – an invoice may move to a different approval group or to final review, for example. If an invoice is marked as

“reviewed,” it will queue for export and will automatically be removed from the dashboard.

 

Grid/Card view option

 



 

 

Options

Edit All/Selected
Approve All/Selected

 
Selecting the Edit button opens the familiar TimberScan approval screen to make revisions either to an individual invoice.

Choose the Edit All button to have all invoices display in the approval screen.

 

list

 

Thumbnail view of Invoice



 

 

 

Refresh/Minimize button

     Select the Refresh or Minimize button to close the Detail screen.

 
When opening/closing windows, TimberScan may prompt you at times to refresh the data. Select Refresh at any

time to see newly added or revised               invoice data

 
 

 



 

 

Show Data Entry View
This view is only for members of data entry groups and displays a graphical view of invoice images. Use the buttons in the

lower right-hand corner to move to the next, previous, first and last invoices in the batch.

 
 
Check the Select Invoice button at the bottom of the screen to review or edit an individual invoice. Or choose the Edit This

Batch button to have access to all invoices in the data entry group. Either selection opens the familiar Timberscan Data

Entry screens to enter or revise invoices in Data Entry. Use the familiar Accept and Finish buttons to route invoices on to

approvers.

 
 



 

 

Email Monitoring
Email monitoring is designed to eliminate the step of having to singly save and acquire email attachments for

vendor invoices.  Email monitoring runs as a service on the TimberScan server where it periodically scans

incoming emails to mailbox addresses, designated by Data Entry type User Groups, and places the attachments

in designated folders. Later, the saved attachments can be easily acquired.

 
Email Monitoring is a service included with TimberScan at no additional cost, providing you are current on

a support agreement.  This service will poll invoices sent by your vendors to a specific email address and

automatically save them to a folder of your choice. You can have multiple email addresses that vendors send

invoices to, which can be linked to different Data Entry User Groups.  Once the invoices that are attached to the

email are saved to a folder, the email is then deleted; however, there are options to forward all emails or just

those that either don’t have attachments or have attachments other than pdfs or tiffs, to another email address.

 
After you complete a required checklist, Core Associates' technical support team will schedule a time to install

and configure the service in conjunction with your IT staff. This is a separate installation from TimberScan and

may be billable. Pease refer to our KnowledgeBase article 41-10870.

 
 
Setup:

 
While the installation and configuration for Email Monitoring is handled by our technical support team, there is

additional setup in TimberScan admin that is required.

 
System Settings

 
1. Open Settings > System Settings. Check the box to Enable Auto Acquire via Email and enter your Pop3 server

name and port.

 



 

 

 
2. In Maintenance > User Maintenance > User Group Maintenance, enter the email settings for each Data Entry

User Group where the email      monitoring service will monitor incoming emails. This allows you to have multiple

inboxes, if desired, one for each User Group.

 
 



 

 

 
 
·     Email address:  Enter the email address associated with shared Incoming mail server to monitor for new

emails.

 
·     User Name:  Enter the user name for that email address.

 
·     Password:  Enter the user password.

 
·     Path to Acquire File: Enter the path to the folder where Email Monitoring should save the invoices that are

attached to the email.

 
·     Forwarding Address: Enter the email address you want the emails to forward to.  What emails will forward

to this email address are based on the following option you select. You can forward emails that do not comply to

another user for manual processing. You can select to forward all or no emails:

 
 ·     “Non-Conforming Emails”:  Ones that either have no attachment or an attachment that is not a PDF or TIFF

file. You can check the box to Mark Non-Cnforming eMails High Priority.

 
 ·     “All Emails” that come into the designated inbox

 
 ·     “No Emails”



 

 

 
NOTE: Data entry User Group setup is not necessary if you purchased Acquire Automation instead of

Emal Monitoring. See the section on Acquire Automation. 

 
A new menu option will now appear on the Acquire ribbon:

 

 
 
 
 
Workflow:

 
Selecting the Emailed Invoices button opens a list of acquired images:

.

 



 

 

You can choose to:

 
Reprocess:  TimberScan stores a copy of the invoice images in the database. If an invoice attachment is deleted

from the folder, the image can be regenerated for acquisition. Clicking Reprocess will create a fresh copy of the

attachment in the designated folder.

 
Delete: Clicking Delete removes the invoice image record from the database. It does not remove the invoice

image from the designated folder.

 
Note:  Only users with Supervisory or Executive privileges can see all emails.  For users without those privileges,

visibility is based on membership in the Data Entry user group for the specific email folder.

 
To acquire images, navigate to the specified folders. Drag and drop the files into the Acquire window as normal.

 



 

 

Acquire Automation
 
Similar to Email Monitoring, Acquire Automation (or Auto Acquire) is an add-on product (that can be purchased)

that works with Email Monitoring. Acquire Automation takes Email Monitoring a step further by cutting out

the acquire step - invoices stripped from emails are automatically sent to the designated data entry group(s).

Basically, you set up vendor definitions that identify the vendor's email address (from) and the address

where they are sending their invoices and attachments (to). By defining this for each vendor, invoices can be

automatically acquired into the appropriate data folder or specific data entry group.

 
If you have multiple company data folders or different offices that enter their own invoices, it is suggested that

you establish a different email address for each company data folder or office entry group. See Examples and

Recommendations below. Each vendor definition must have a unique combination of sender & receiver email

addresses, where typically the receiver address is linked to a specific data folder or data entry group. Acquire

Automation knows what company data folder to save the invoice to, based on the sender’s and/or receiver's

email address.

 
If you are already using Email Monitoring, you will need a new license key to activate Acquire Automation.

In addition, vendor definitions need to be established. If you have not implemented Email Monitoring, after

you complete a required checklist, Core Associates' technical support team will schedule a time to install and

configure the service in conjunction with your IT staff. This is a separate installation from TimberScan and may be

billable.

 
After Acquire Automation has been installed and configured, a new menu option - Emailed Invoices - will now

appear on the Acquire ribbon. If you are upgrading from Email Monitoring, you already have this option.

 

 
 
Setup:

 



 

 

The Acquired Email Definitions button is for Acquire Automation only. While the installation and configuration for

Acquire Automation is handled by our technical support team, there is additional setup in TimberScan admin that

is required. You must set up Email Definitions for each vendor emailing invoices.

 
1. Open Acquired Email Definitions.

 

 
2. Complete the following fields:

 
• Common save to folder: Select a default folder for saving emailed invoices. This is reserved for

invoices that have an issue auto acquiring or for invoices that will be acquired by Capture.

 
• Forward To Address: Enter an email address for forwarding emails based on options outlined below.

 

 
 
 



 

 

3. Select the Create button to open the Aquired Email Definitions window. A definition is required for each vendor,

or when there are multiple email addresses for a single vendor, or for each address the vendor uses for sending

invoices.

 
 

 
Email Properties Tab

 
Complete the following information:

 
•  Sender email: Enter the email address the vendor is emailing the invoices from.

 
•  Receiver email – Enter the email address the vendor is emailing the invoices to.  If you have multiple

data folders, enter a unique receiver email address per company data folder that the vendor is using to

email invoices. See Examples and Recommendations below.



 

 

 
•  Email Password – Enter the password of the email account where the vendor is emailing invoices

(receiver email account).

 
•  Attached File Password – Enter the password, if applicable, in your email system to allow Acquire

Automation to access and open the emailed invoices.

 
•  Save to file system only – Check this box if the vendor is set up in Capture. While Acquire

Automation cannot currently auto acquire Capture invoices, it can still separate a multi-invoice pdf into

separate invoices. This can be used to separate and save invoices attached to emails that you do not

want to be auto acquired.

 
•  Folder to save to – When "Save to file system only" is checked, enter the path where the invoice files

will be saved in the event that Acquire Automation cannot acquire the invoice. This could be due to an

error or if the invoice is to be acquired via Capture. It is also used when you do not want invoices from

this vendor's address to be acquired automatically.

 
• Data entry group – Select the data entry group where the invoices should be placed after auto

acquired.

 
•  Vendor – Select the vendor.

 
•  Invoice code/type – Select the appropriate invoice type, if applicable, for this vendor.

 
•  Description – Enter a description that will populate the description field on the invoice, if applicable.

 
• Comment – Enter an optional comment regarding this vendor’s definition setup, if applicable. This

does not create an annotation or comment on the vendors’ invoices.

 



 

 

• Invoice format section – Select the appropriate option based on whether the vendor sends a pdf per

invoice or if there are multiple invoices in one pdf.  If you select 'Multiple invoices separated by specific

text," you will be prompted to select the text location and to enter the text to denote multi-page invoices.

 
Forwarding Tab - Select this tab to enter an email address to forward the emails after the attached

invoices are acquired.  You can then select what type of emails to forward to this address:

 
#     No emails

 
#     All emails

 
#     Only not matched/processed – to forward emails that encounter an issue in auto acquiring,

such as emails with no attachment, or when the email attachment is a file type other than pdf or

tiff.

 

 



 

 

Be sure to SAVE your entries. As you save each vendor’s definition, the window will remain open and common

items will remain pre-filled, therefore you only need to enter the next vendor’s Sender’s Email Address & the

vendor Name/ID.  If any other fields need to be changed, they can be edited.

 
NOTE: We are not currently defining supporting documents for Acquire Automation. If supporting documentss

are emailed with the invoice, Acquire Automation will not be able to separate them from invoices into two different

document types.

 
 
EXAMPLES AND RECOMMENDATIONS:

 
#     Multiple Data folders – Set up different email accounts with vendors so they can invoice the appropriate

company data folder. We suggest a separate email address to send invoices to per company data folder.

 
#     Multiple offices doing their own entry – Establish different email accounts with the vendor so they can invoice

the appropriate office. We suggest a separate email address to send invoices to per office.

 
#     Different data entry groups based on certain vendors – You can assign the appropriate vendors to the data

entry group who enters those vendor’s invoices.

 
 
 

 
 
 



 

 

TimberViewer
 

This short video walks you through installing and using the TimberViewer application.

 
TimberViewer Video

http://www.screencast.com/t/Ki8dFtqi


 

 

What is TimberViewer
What is TimberViewer? 

 
TimberViewer is a new software add-on to TimberScan which allows users to view sticky notes and other annotations on tif

images stored in Sage 300 CRE.

 
Like Windows Photo Gallery or Picture Manager, TimberViewer can be set as your default viewer so it opens automatically

when you click on an attachment to a Sage 300 CRE vendor invoice.  

 
TimberViewer should be installed on the server and all workstations that utilize Sage 300 CRE.

 
It can be installed as the default viewer so tif images stored in Sage 300 CRE automatically display annotations.

 
As you will see, stored images can be printed and/or emailed – with or without the sticky notes -using Timber Viewer. 

 

 



 

 

Installing TimberViewer
 

The viewer is an easy install.

 
Simply click on the link in the email you receive from Core Associates and follow the instructions.

 
The software will install in a folder called Program Files\Core Associates\TimberViewer.

 
Remember to install it on the server and all workstations accessing tiff image files. 

 
You can select to make TimberViewer your default default viewer so attachments in Sage 300 CRE will automatically

display annotations.

 
You can also select to make TimberViewer a default viewer for png or bmp files.

 
Required features, such as Visual C++ runtime, will automatically install when you select Full Installation.



 

 

Using TimberViewer
 
TimberViewer is an easy tool to access and use.

 
Simply select an attachment in Sage 300 CRE and the image automatically opens when TimberViewer is set as the default

viewer. If not, simply select to open the file in TimberViewer. 

 
Once opened, annotations on tif images automatically display. There are many other useful features that can be utilized.

 

 
For multiple images, use the mouse or keyboard to scroll up and down through multiple pages. 

 
You can add additional annotations by selecting the highlighter, drawing pen or sticky note icons.

 
You can choose the color of your annotations and even choose to highlight or draw in small, medium or large font. Both the

drawing pen and highlighter are continuous.

 



 

 

Use these features to add information to any page in the file (like a job # or other coding on an approval page). 

 
The Clear All selection does just that – clears all annotations you made.

 
You can remove an individual annotation by clicking on it with the right mouse button and selecting Delete Annotation.

 
The Burn All button should be used to SAVE any annotations made in TimberViewer.

 
Once “burned”, annotations cannot be removed.

 
Annotations made in TimberScan are automatically “burned” to the image and cannot be changed.

 
To save your changes, select the File button.

 
If you forget to do this, TimberViewer will prompt you to save your changes when you select Exit.

 
In the Editing section of the menu, there are buttons for Auto as well as Manual Deskew and buttons to Rotate Left or Rotate

Right.

 
You can also right mouse click on an image to display a Page Edits feature which lets you rotate left, right or 180 degrees. 

 
When selecting to Print, the default is to print without annotations but you can choose to print with them. The same goes for

Emailing the image. 

 
You can even use TimberViewer to open png or bmp or pdf files and make changes.

 
Select File Open and browse to the file.

 
 Or, in Windows Explorer, right mouse on the file to open in TimberViewer.

 
Now you have all of the features previously available. You can even duplicate or remove a page by clicking on the right

mouse button and selecting Duplicate or Delete Page. When you save your changes the file is saved with a tiff extension. 



 

 

TimberSync
What is TimberSync?
 
TimberSync is a tool used to push Sage CRE data out to Timberscan's SQL database.  This significantly speeds up data entry

in Timberscan as well as processing in inquiries and reports.  TimberSync creates one database for each Sage 300 CRE data

folder.

 
During the day, this add-on program updates the Timberscan SQL database with all changes occurring in Sage CRE. 

The intervals at which TimberSync daily update runs are set in the Task Scheduler; it could take 15 minutes to an hour to

complete an update process, depending on your environment.  Nightly, the program synchronizes the whole Sage 300 CRE

Pervasive database with Timberscan's SQL database. 

 
 
 
 



 

 

Disable TimberSync
 

If you need to see changes made to Sage 300 CRE prior to TimberSync updating as scheduled, you can

"Disable TimberSync" and you will have a live connection between Sage 300 CRE and Timberscan. 

 
When a user selects "Disable TimberSync", this applies only to the session of that user.  Once that user logs back into

Timberscan, TimberSync will no longer be disabled. 

 
 

 
Beware that this could significantly slow down your system.  You will be prompted with the message that

TimberSync will be disabled until you start a new session of Timberscan. 

 
 



 

 

Use TimberSync
 

There is a System Setting that can be turned on or off for using TimberSync. 

See your Administrator if you are not sure if you have this set up or not. 

 
Unlike the "Disable TimberSync" option in Timberscan, disabling TimberSync in System Settings permanently

disables TimberSync for all users until this setting is changed. 

 



 

 

AIM
AIM - Advanced Imaging Management is a document management application built into TimberScan.

 
 
 

 
AIM allows you to acquire documents, code them and attach them to multiple Sage 300 CRE records, such as employees,

customers, commitments, etc. Invoices processed through TimberScan are automatically available in AIM. AIM's indexing

and search features make it easy and quick to retrieve any type document that has been processed in AIM. Document types

reside in their native format (such as .docx, .xlsx, etc.).

Routing workflows are also available if you choose to route certain types of documentation.

 
 



 

 

AIM Discovery
 

Aim Discovery is a company's opportunity to establish "policies and procedures" for their documents.

 
Questions that each organization should ask before touching the keyboard include:

 
1.     What types of documents do we want to store in AIM?

2.     Do we want to ‘categorize’ those documents in order to segregate them by department or discipline (for

example)?

3.     For each type of document, what are the “key index fields” that are required in order to store the document in

AIM and to search and retrieve the document?

4.     What levels of security do we need to establish for each document? Do we want to establish security at the

category level, the document type level, approval workflow & criteria, field level?  

 
You will need to gather certain information to prepare for your AIM implementation.  Please use this document as a guide

to collect information on how you would like to establish (1) security in AIM as well as (2) document categories and types

for storing and retrieving your AIM documents.

 
AIM training begins with a “discovery” session which introduces you to the overall structure of document management in

AIM. Afterward, we ask you to think through the four primary questions above in order to structure your records in AIM

to best suit your company's needs. During the second training session we critique your AIM “roadmap” and show you how

to apply it in the software. We take you through the setup process and show you how to secure, store and search for your

documents. After you have had the opportunity to use the software, we schedule a final session to review your setup and

answer any questions.

 
AIM training process:

 
•     Discovery session with your AIM consultant

•     Map out a structure for your companies document management

•     Review your AIM roadmap with your consultant

•     Learn how to set up your document categories & types, and how to secure, store and search in AIM

•     Follow up session to review your processes and answer any questions

 



 

 

Please use this document to help you prepare for the discovery meeting with your consultant. Before attending, we ask that

you review this video to obtain an overview of the document management process in AIM:

 
http://www.screencast.com/t/zf8iYeR1Quc

 
 
 

http://www.screencast.com/t/zf8iYeR1Quc


 

 

AIM Structure
 
 

 
Think of AIM as your electronic filing cabinet. You will set up document categories (drawers) to separate or segregate

documents. Within the categories, document types serve as file folders in the drawer to store all of the content for that

specific type.

 

 
You can establish an unlimited number of document categories and types which are global and can be shared among multiple

company data folders. However, bear in mind that currently, search and document retrieval is restricted to an individual

company folder.

 
To help map out how AIM can best benefit your company, consider the following items that pertain to your business.

•     What – what documents do you want to scan and store?

•     Who – who do you want to see which documents?

•     Who not – who should NOT see which documents?

•     What records in Sage 300 CRE do you want to attach to?

•     What index fields will you use to code and retrieve documents?

 
What documents will you store and retrieve in AIM?

Determine which documents you will scan into AIM to be stored and retrieved. Classify the documents into “file cabinet

drawer” groups. Within each drawer, define types of documents to serve as the “file folders” in the drawer.

 
For example, you might set up a drawer called Job Cost. Within this drawer you might scan in various lien waivers,

commitments, change orders, original contracts, etc. In AIM, this would appear as…



 

 

   1.     Document Category = Job Cost

   2.     Document Types = lien waivers, commitments, change orders, original contracts, etc.

   3.     Attach to = Determine if/where you want to see these document types as attachments in Sage 300 CRE.           For

example, do you attach to the Job Record, PJ Change Order Record, AP Vendor Record, etc?

   4.     Index Fields = Determine index fields for each document type.  “Attach-to” fields are required if           attaching to

Sage 300 CRE records. For example, do you want to attach to the Job Record, PJ Change Order, AP Vendor Record, etc.

   5.      Decide on other optional or "custom" fields to code/search by.

 
Keep in mind: Security can be assigned by category, by type, based on workflows & criteria or field level:

 
Who should see/not see which document types. And within those types what documents should they see/not see?

 
 
In Payroll, you might consider establishing two separate file cabinet drawers – (1) one for internal use to hold W-4, I-9 or

other private documents and (2) a public category searchable by other personnel in your company to hold such things as

licenses or certifications.

 
 

A PR Internal category would contain document types with sensitive information which should only be viewed by a finite

number of personnel.

 
A “public” PR category can contain less sensitive documents which can be coded, viewed and retrieved by a larger set of

personnel.

 



 

 

 
NOTE: Currently, each category and type must be unique. In other words, you cannot have a lien waiver type in both an

AP category and in a JC category:

 
 

 
Why must document types be unique?

 
AIM creates and stores documents in individual document type folders in the company folder on the server. If you had the

same name for a folder (type) in each file cabinet drawer (category) and you remove the folders out of the drawers, you

would not be able to distinguish folders. If each drawer (category) had a “lien waiver” folder, how would you know which

folder should be filed in which drawer?

 
The screenshot below shows the AIM filing structure on your server. Document type folders are created under the

\TimberScan\Images\YourCompanyName folder. AIM folders below include 1099, Change Order, Commitment and Job

Certificate:

 



 

 

Starting with AIM v4, supporting document definitions created in TimberScan automatically become document types in

AIM. For this reason, do not set up an AIM document type with the same name as an existing supporting document in

TimberScan.

 
What records will you attach to in Sage 300 CRE?

 
AIM has the unique ability to store and search for documents within AIM, as well as view those same documents in SAGE

300 CRE as “attachments”. After assigning users to categories and types, you will be prompted to select which records to

attach a document type to in Sage 300 CRE. For example, you might attach a 1099 to a vendor record only while you might

attach a commitment to a vendor AND a job. Records selected here are required during the coding process.

 
What index fields will you use to code and retrieve documents? Which fields will be required?

Determine what fields you will use to code and search for each document. For example, you might code a W4 form to a

single employee record. This also allows you to search for a W4 by employee.  On the other hand, you might code a change

order to a job and a commitment so that you will be able to search for the change order by job or commitment or both.

 
Custom Fields: Custom fields can be established in AIM for coding and searching. Custom fields allow you to create

searchable document types for Sage 300 CRE records that do not support attachments, such as purchase orders and service

management work orders.

 
 
 



 

 

AIM Document Categories
 
A few words on how AIM Documents are organized. 

 
At the very highest level, are Document Categories.  These are completely user-defined and are designed for you to be able

to group similar documents together to facilitate security and searching.  As an example, you may have two types of Payroll

documents – those containing sensitive information such as Forms W9, and more public information needed by Project

Managers, such as copies of certifications or licenses.  

 
In AIM, you can set up two Payroll document categories –

• for instance, PR_Internal and PR_Public. 
• Since AIM places security at the Document Category level, you can specify which users may access the Internal

documents and which users may access the Public. 
• When you search documents, you will be able to immediately narrow your search parameters by selecting one

or the other.

 
 
 
 
 
 
 
 



 

 

 
 

AIM Document Types
 
Within Document Categories and a level below, are Document Types. 

 
Here is where you define specific documents.

 In our payroll example, we have already seen two examples of Document Types:  a Form W9 and an Electrician’s

License. 

 
At this level you can:

 
#     Determine whether or not you want to attach documents to one or more Sage 300 C.R.E. records and specify

those records.  If you select to attach to Sage 300 C.R.E. records, scanned AIM documents will be attached the next

time a user exports.

 
#     Grant document type security, further restricting specific documents within a category

 
#     Choose which fields you would like associated with each document to further categorize them and facilitate

searching

 
#     Create Custom Fields to expand your ability to categorize a document beyond what is provided by Sage 300

C.R.E.  As an example, Service Management, Purchasing and Inventory do not have records with the ability to

attach documents.  However and by creating corresponding categories and custom fields, you can expand the

power of these modules with searchable documents for each.



 

 

AIM Security
 

With AIM Version3 there is now the ability to add security to AIM documents at the Field Level. 

 
• With AIM V1 and V2, users inherited SEARCH rights to fields they had rights to from Timberscan routing of AP

invoices.

 
• Those rights are GONE in V3 – no SEARCH rights in AIM are based on any Timberscan routing rules for AP

invoices with one exception:

 
• Users who can see/approve/review AP invoices will also be able to search for them in AIM Search using Category = AP

and Document Type = Invoices.

 

AIM Security can now be defined using the following:

 
• View All
• User part of a Rule

 

If a user is named in a Rule (routing stage) for a particular document, that user inherits SEARCH RIGHTS

to that document that matches the specific coding from the rule.

 
Explicit rights may be granted to a Document Category and/or Type.  If rights are granted at the

Document Category level, the user has SEARCH RIGHTS to all Types underneath

 
• Category
• Document Type

 
 

Field Access helps to control the documents a user may see in AIM SEARCH.  Field Access DOES NOT

affect document coding

 



 

 

• Field Level

 
What a user sees in Search is based on one of the following four combinations:

• The user has rights* to an entire Category OR
• The user has rights* to a Document Type OR
• The user has rights* to one of the Field values on the document OR
• The user has rights* to ALL of the field values on a Document Type

 

*Either inherited or explicit rights

 
Granting Field Access, Category or Document rights alone is the least restrictive method and will provide the most search

results

• Giving only Job/Property rights to specific jobs or properties is a VERY wide open door:
• User might see any legal or financial documents coded with that job/property
• User might see any sensitive payroll documents coded with that job/property
• Giving only Category rights opens up that entire Category
• Granting access to a Document Type and all of its fields is the MOST restrictive and should be used where there are

sensitive documents in the system

Field and Document Type access is per data folder.

 
 
TimberScan criteria is only used as security as to what invoices a user can see in the AP Category for vendor invoice related

documents.  Security as to what documents a user can see can be added as described below.

 
• Users should not be assigned to Document Categories or Document Types if you want to restrict the documents they can

search for to be limited to those coded/indexed to the criteria assigned to their routing rules and/or those indexes/codes

assigned to them in AIM Users menu button – Field Access.
• If users should only access documents based on certain criteria/ index coding and are not in an approval workflow, the

criteria for what they can search for would be added in AIM User menu button – select the Field Access tab > Add Field

Access button > Select the field and the value.  Then in the document types tab – select the document types that can be



 

 

accessed based on the field values selected.   Fields can be assigned to limit what documents can be accessed for that

document type
• If a user can access all documents within a particular Document Category regardless of coding, the user is added in

the Document Category setup > Assigned Users tab.  If a user can access all document of a particular document type,

regardless of coding, the user in added in the Document Type setup > Assigned Users tab.
• Users who can access all documents in AIM would have the AIM View All permission checked in the User Maintenance

screen

 



 

 

View All
AIM View All permission overrides everything

 
When signed in as Admin you can give the user AIM View All permissions.  Be CAREFUL.  This permission gives the user

rights to view every document in AIM even confidential documents, for example, payroll documents. 

 
• Every AIM document regardless of Category, Document Type or Field can be viewed by the User with AIM View All.

 



 

 

User is part of a Rule
 
If a user is named in a Rule (routing stage) for a particular document, that user inherits SEARCH RIGHTS

to that document that matches the specific coding from the rule. 

 
In the example below,

 
A workflow exists for Document Approval with users PM01 and PM02. 

The Routing Rule is Job1Rule

The Routing Group is PROPPROJ

The Criteria for this Routing Group is Job 14-001, Job 14-002 and Job/Vendor 10-001/AC001

The Document Types for this rule are: Purchase Orders, Subcontracts and Owner Change Orders

 
 
In this Rule, PM01 and PM02 will have Search Rights to PO's, Subcontracts and Owner Change Orders for Jobs 14-001 and

14-002 and those documents with the Job/Vendor combination 10-001/AC001.

 
Workflow

 

 
Routing Rule/Routing Group



 

 

 

 
Routing Rule/Document Types

 

 
 



 

 

 



 

 

Document Category/Document Type
 

Explicit rights may be granted to a Document Category and/or Type.  If rights are granted at the

Document Category level, the user has SEARCH RIGHTS to all Types underneath.

 
• Category

In the example below, Doug Moffe, Robert Jones and Michael Perkins have AIM rights to ANY document coded to

Project Management. 

 

 
• Document Type

 
Reebeca Gibson can see any documents coded as Project Checklist BUT she can NOT see the other documents

coded to Project Management. 

 



 

 

 
There are 4 document types under Project Management.  Doug, Robert and Michael can see all 4 of them. 

 
Reebeca Gibson can only see Project Checklists, however, she can see ANY project checklist.  To further restrict any user,

Field security could be used.

 
 
             

 
 
 
 



 

 

Field Security
 
Field Access helps to control the documents a user may see in AIM SEARCH.  Field Access DOES NOT

affect document coding

 
• Field Level

 
What a user sees in Search is based on one of the following four combinations:

• The user has rights* to an entire Category OR
• The user has rights* to a Document Type OR
• The user has rights* to one of the Field values on the document OR
• The user has rights* to ALL of the field values on a Document Type

 

*Either inherited or explicit rights

 
Granting Field Access, Category or Document rights alone is the least restrictive method and will provide the most search

results

• Giving only Job/Property rights to specific jobs or properties is a VERY wide open door:
• User might see any legal or financial documents coded with that job/property
• User might see any sensitive payroll documents coded with that job/property
• Giving only Category rights opens up that entire Category
• Granting access to a Document Type and all of its fields is the MOST restrictive and should be used where there are

sensitive documents in the system
• Field and Document Type access is per data folder.

 
Field Access Setup
 
• Via Field Access, you may grant users explicit rights to certain data
• Field Access is set up by user and is performed in the AIM window under AIM Users
• User window will reflect all fields to which the user has been granted access either by virtue of having been specified in a

rule or by explicit definition:



 

 

 
You can choose to give Bob Evans field access by Job below:

 

 
And then select which job(s) Bob will be able to see all documents for.  In this example, Bob will be able to see all AIM

documents with Job = 13-001. 

Be very careful, this would include any confidential documents with job = 13-001. 

 
 



 

 

 
 
 
 
 
 
 
 
 



 

 

Rules Based Routing
 
Rules-Based routing adds power to existing Admin workflows. 

Rules-Based routing cannot be performed using User workflows.

 
Composed of three components:

• A set of Document Types to which the rule applies

 

 
 

 
• A set of Routing Value Groups which contain fields and a set of values for those fields to which the rule applies. Think

Timberscan Approval Group Criteria.  Example:  Vendor AC001 and  Job 10-001

 



 

 

 
 
 
• An Admin Workflow for the Rule

 

 



 

 

In Summary, the Document Types indicated WITH the field values indicated in the Routing Group will be sent through the

above Workflow (Approval from PM01 and PM02) in Sequential Order if designated. 



 

 

AIM PaperClip
 
How are attachments stored in Sage 300 CRE?

 
There is a single field in every ‘attachable’ record in Sage 300 CRE.

 
 

 
This one field stores a list of the file paths of all attachments.  Each member of the list (path) is separated from the next

member by the ‘pipe’ character:  |

 
 



 

 

 
Why do we Need Paperclip?

 
• The Invoice_File_Links field is quite large and can accommodate an almost infinite number of files when written to

within Sage 300 CRE.
• HOWEVER, when written to via ODBC, there is a max limit of 1000 characters.
• With the power of AIM, we saw fairly quickly that clients were bumping up against the 1000 character limit and getting

attachment errors.
• We needed a way to get around that limit.
• What we write now is a separate link to the AIM Paperclip viewer which opens in a new window.

 
 
 



 

 

AIM PaperClip Viewer
• Navigate to a Sage 300 CRE record with an attachment.  Note the file naming convention and the word “Shortcut”. 

This is the PaperClip link.

 
Double-click the link.  The first thing you see is the Timberscan ‘splash screen’.  Note that the version number may be

different from the ‘main’ Timberscan version.

 
• Select a document for viewing and click “View”:

 



 

 

 
• Document opens in TimberViewer (which needs to be installed.)

 



 

 

 
• Remember, this is a viewer only and provides no other function other than to open the selected document in

TimberViewer. 
• Any changes made to the document in TimberViewer are permanent, just as with any document opened directly from an

attachment.

 
 
 
 
 



 

 

PaperClip Setup
 

• AIM setup extracts a Viewer.exe.file into the TimberScan folder

 
• New setting in System Setup – should be automatic:

 

 



 

 

Aim Security
 
Comprehensive document security is a combined effort on the part of AIM software AND the Windows Server operating

system.

 
AIM security controls search results within AIM.  Windows operating system security controls access to attached

documents in Sage 300 CRE.

 
Windows Security:

 
Each AIM document type will have its own folder under the TimberScan Image folder where all document images are

stored on the server. Appropriate security should be placed on each AIM document type folder.

For example:

          \\SERVER\TimberScan\Images\Timberline Construction\lien waiver\

          \\SERVER\TimberScan\Images\Timberline Construction\W2\

 
 
AIM Security:

 
In AIM, security is established for:

 
•     AIM users - field level

•     TimberScan users

•     AIM Document Workflows

•     Document category

•     Document type

•     Company data folder (if applicable)

 
AIM Users in TimberScan User Maintenance:

 
There are four permissions in admin setup that determine whether an AIM user can (1) Acquire, (2) Entry (code), (3) Edit

and/or (4) Search for a document. Addition permissions include AIM Approve, Route on the Fly, Override Route, Cancel

Workflows, Send To, Reject Tasks, Attach Documents, Delete Documents, Remove and Add pages, and View All.



 

 

 
NOTE: In AIM version 1, only the AIM user who acquireed the document could code the document.  This has changed

in AIM v3 as documents acquired are sent to an entry queue where any user assigned to that entry queue can enter the

indexing (coding).

 
 
TimberScan Users:

 
•     Any TimberScan user with the “admin” login has full rights to all AIM setup options.

 
•     TimberScan user rights are inherited. Users who see invoices based on coding will see all documents for

that coding.  For example, a TimberScan user who has rights to access invoices for job 03-001 will see all AIM

documents for that job.  Similarly, a user who has security to see invoices for a particular GL Prefix (Company)

10 will see all AIM documents for Company 10. To avoid inherited security, substitute an AIM Custom Field for

the Sage 300 CRE field. In the examples cited above, use of a custom job or GL company field will mean that

documents coded with those fields will not inherit any search rights based on TimberScan invoice viewing rights.

This applies to Approval Groups as well as individuals. AIM V3 introduces other methods of security that include

by document type or field access security that would allow the user to access all documents that have the value of

that field indexed to it and that is assigned to that user.

 
 
NOTE: The “View All” permission in User Maintenance does confer search rights in AIM.   With “View All”, a user can see all

AP Invoices automatically indexed by AIM.

 
Document Category: 

 
Users assigned to an AIM category can see ALL documents for that category regardless of how the document is coded. For

example, users assigned to an Internal Payroll category will have search rights to all documents in this category, such as W4s

and other sensitive documents.

 
Document Type:

 
Users assigned to an AIM document type can see ALL documents for that type regardless of how the document is coded.

This narrows the search from the category level. For example, in a Public Payroll category, if a user is assigned to a type



 

 

called Certificates, that user will only be able to search and have access to documents in the Certificates folder and no other

folders in that category (unless assigned).

 
Company Data Folder:

 
In the case of multiple companies in multiple data folders, AIM search is limited to only documents within the logged-in

company data folder.

 
Security Notes:

 
Users should not be assigned to Document Categories or Document Types if you want to restrict the documents they can

search for to be limited to those coded/indexed to the criteria assigned to their routing rules and/or those indexes/codes

assigned to them in AIM Users menu button – Field Access.

 
If users should only access documents based on certain criteria/ index coding and are not in an approval workflow, the

criteria for what they can search for would be added in AIM User menu button – select the Field Access tab > Add Field

Access button > Select the field and the value if the user can access ALL document types that have the selected value. In the

document types tab – select the document types that can be accessed. Fields can be assigned to limit what documents can

be accessed for that selected document type

 
If a user can access all documents within a particular Document Category regardless of coding, the user is added in the

Document Category setup > Assigned Users tab. If a user can access all document of a particular document type, regardless

of coding, the user in added in the Document Type setup > Assigned Users tab

 



 

 

AIM Setup
 

Getting Ready to set up AIM - map out your setup

 
• AIM Permissions - Set up AIM specific permissions for existing TimberScan users and add AIM only users.

 
• AIM Maintenance

 
Document Categories  - Assign Users to Document Categories

 
Document Types - Assign Users to Document Types

 
Custom Fields

AIM Data Entry Groups 

Workflows 

Switch Workflow User 

 
AIM Users

Routing Rules 

Routing Values Groups 

Routing Fields 

 
 
 
 

 
 

 
 
 

 
 
 



 

 

 
 
 
 
 
 



 

 

Getting Ready to set up AIM
Now that you know how AIM is structured and how security works, you are ready to begin mapping out the setup of your

AIM file cabinet.

 
1) Determine user permissions. Some users may have “search only” rights.

 
2) Map out your file cabinet.

 
Mapping of the File Cabinet

 
•     Document Category – define your category names and who should have access to which categories. This is

a critical                                                    non-reversible decision. Once documents are assigned to categories, the

Category cannot be deleted.

•     Document Types – define the document types for each category and who should have access to which types.

This is a critical non-reversible decision. Once documents are assigned to types, the Types cannot be deleted.

•     For each category/type, identify which records in Sage to attach to.

•     For each category/type, identify which index fields to utilize for document coding and document search.

•     Identify any custom fields needed to (1) attach to non-Sage records such as PO purchase orders and SM work

orders and/or to (2) limit or enhance search capabilities. You will need to identify the field ID, type and length.

 
The following examples are designed to help you map out your file cabinet:

 
Category - Job Cost – only assign users who can access all documents in the Category

     Type – Commitments – assign users who can access all documents for this type

          Sage Attachment – Commitment

          Fields available –  , Date (perhaps custom), Issued by (custom)

 
Type – Commitment C/O – only assign users who can access all documents for this type

          Sage Attachment – Commitment

          Fields available – Job, Commitment, Change Order, Date, Issued by

 
     Type – RFI – only assign users who can access all documents for this type

          Sage Attachment - ?

          Fields available - ?



 

 

 
Category – AP – only assign users who can access all documents in the Category

     Type – Insurance Certificates – only assign users who can access all documents for this type

Sage Attachment – Vendor

          Fields available – Vendor, Type of Insurance, Effective Date, Expiration Date

 
Category – Property Management – only assign users who can access all documents in the Category

     Type – Tenant Lease – only assign users who can access all documents for this type

          Sage Attachment – Tenant Lease

          Fields available – Tenant Lease ID, Property, Unit, Tenant Name, Lease Start Date & Exp.

 
     Type – Property Insurance – only assign users who can access all documents for this type

          Sage Attachment – Property

          Fields available – Property, Effective Date, Expiration Date

 
Approval Routing setup:

 
          Determine what type of documents you want to route – routing is based on Document Type

 
          Determine how documents be routed for approval – each workflow would be given a name

 
               Document types that are routed to the same approvers for all documents of that type –

 
               Ex. Payroll time cards will be approved by the same approvers – workflow would               

assigned to the Document Type

 
Documents that will be routed based on rules & what the rules are based on – each workflow is given name and

the workflow Criteria is assigned a name

 
Ex. POs will be approved by the PM and their Division Mgr. – document types would be assigned to the User in

Routing Rules

 
Ex. Routing based on Jobs assigned to that PM – Criteria would be setup in routing rules

 



 

 

 
 



 

 

AIM Role Permissions
 
Before a user begins working with the AIM functionality, you must assign one or more AIM permissions in Admin >

Maintenance > Role Permissions. Once the role is assigned, it should be applied to the user(s) in Admin > Maintenance >

User Maintenance.

 

 
NOTE: You can assign AIM permissions to an existing role or you can first establish a new role for AIM users in Admin >

Maintenance > User Roles.  

 
 

Check the appropriate AIM permissions for each desired role: 

 
 



 

 

 
 

 
AIM Permissions:

 
 

• AIM Add Pages - for those users who can add pages to an AIM document

 
• AIM Approve - for a user who will need to approve a document.

 
• AIM Acquire - for users who can Acquire documents into AIM

 
• AIM Attach Documents - for user in an AIM workflow who have the right to attach documents to records in Sage

300 CRE



 

 

 
• AIM Cancel Workflows - for users who can cancel an AIM workflow

 
• AIM Data Entry - for users who can be assigned to AIM entry groups to enter the initial coding for a document

 
• AIM Delete Documents - for those who can delete an AIM document

 
• AIM Edit Document - for users who can add or change the coding for a document

 
• AIM Maintenance - this is an Administrative permission to be given only to users who can set up AIM

functionality

 
• AIM Override Route - apply to anyone who can route on the fly and override an existing workflow that would be

used based on the criteria

 
• AIM Reject Tasks - for users who have the permission to reject an assigned task

 
• AIM Remove Pages - for those users who can remove one or more pages of an AIM document

 
• AIM Route On Fly - apply to anyone who can create a new workflow on the fly (a workflow that is not currently

setup)

 
• AIM Search - for users who can Search for documents in AIM; subject to a user's security restrictions on

documents that can be searched for

 
•



 

 

AIM Send To - apply to users who can send AIM documents to other users/approvers. A Send To button displays

for selection.

 
• AIM View All - for users who can search for all documents in AIM, no restrictions.

 



 

 

AIM Viewer Setup (Paperclip)
 
Reference files will be stored within a folder titled 'attachments', specified by the 'TimberScan System Setup'

screen in TimberScan. AIM documents in TimberScan are accessed via the AIM Search function. To view the

same images in Sage, go to the record and select the Attachment button. The File Links tab opens.

 

 
Click on the viewer or select Open to reveal a list of all images attached via AIM to the record.

 

 
The following setup will be performed during your initial software installation.

Under the setup tab, clicking the System Setup button will open a window titled 'TimberScan System Setup'. 

 

 



 

 

 
On the 'Image Settings' tab there is an option titled 'Image Folder'.  This field is used to specify where the

attachment files will be stored.

If the checkbox titled 'Store Images With Timberline Data' is checked, the attachment files and their

corresponding links will be stored within the Timberline Data folders. 

 
Otherwise, the files will be stored in the folder specified by the 'Image Folder' text field. 

 
Changes to the attachment file locations should be kept constant during migrations by utilizing shares. 

 
If this location is changed the old reference files will still exist, but may no longer be found by TimberScan without

using the migration under the Maintenance -> Timberline Attachment Maintenance. 

 

l %22_Timberline_Attachment_Maintenance%22


 

 

 
The TimberScan viewer application is named Viewer.exe.  This separate application should be installed in a

single location and remain there for the duration. 

 
Client's will be required to keep a the PaperClip Viewer.exe in a constant path which is configurable but should

be in the same folder as the TimberScan '.XFS' file.

 
Note:  Users should not rename or move the PaperClip Viewer.exe file.

 
 
 
 
 



 

 

AIM Maintenance
 

Document Categories
 

Assign Users to Document Categories
 

Document Types
 

Assign Users to Document Types
 

Custom Fields
 

AIM Data Entry Groups
 

Workflows
 

Switch Workflow User
 

AIM Users
 

Routing Rules
 

Routing Values Groups
 

Routing Fields



 

 

Document Categories
 
Navigate to the selection on the menu bar labeled AIM Document Types. In admin > AIM Maintenance > Document

Categories

 

 
Select Add > Enter a Category (drawer) name

 

 
 
 
 
In this screen, you may add a new Document Category or Edit an existing one.  Let’s add a new category by clicking Add.  In

the box next to name, simply type your Document Category name.  Keep in mind that these names must be unique.

 

 
Now let’s add some security to this Document Category by clicking on Add Users in the tab below. 



 

 

 
• The user you add will have access to ALL document types in this category. 

 
• Note that the list of users contains all of the users already set up in TimberScan.  Add an assigned user by

selecting the user in the list and clicking Add. 

 
• Remove a user by clicking on a user in the Assigned users list and clicking Remove.

 

 
 

 
Once you select Close, you will return to the window for your newly created category and you will see the list of users you

have just assigned.  Click Save to exit this window and to return to the list of existing Document Categories.

 

 
You may also add and remove Assigned Users by navigating to an existing Document Category and selecting Edit.



 

 

 This will bring you to the same Document Category window we saw for adding a new Document Category and it

works in the same way.

 
 
Lastly, you may delete a Document Category but only if it does not have Document Types already assigned to it.

 

 
 
 
 



 

 

Assign Users to Document Categories
 
 
 

 
You may  add and remove Assigned Users by navigating to an existing Document Category and selecting Edit.

 This will bring you to the same Document Category window we saw for adding a new Document Category and it works in

the same way.

 

 
 



 

 

Document Types
 
Once you have all of your Document Categories created, you can begin to create Document Types to go under them. 

 
Let’s look at Document Type Creation by clicking on Document Types in the AIM Doc Types drop down in Admin >

AIM Maintenance > Document Types

 

 
 
Start by selecting the Document Category in which you want to work. 

Let’s begin by selecting PR, a Type we have previously defined and let’s create a new Category by clicking Add in

the upper left-hand corner of the screen.

 

 
The first step in creating a new Document Type  is to provide it with a unique name.  For the purposes of this

demonstration, we will be creating a document type for Form W9 and that is what we will enter in the Name field.  Note

that if you change your mind at this point regarding the Document Category under which this Document Type will fall, you

can change your selection here.  You can also create an entirely new category to house this Document Type by selecting

Create New Category from this window.  This will bring you to the Add Category window we saw earlier.

 



 

 

 
 
Now that the Document Type has been defined, we can begin creating its properties.

 
Let’s start with the Attach To tab to define which Sage 300 CRE records will receive attachments of this document. 

Click Add Records to come to the record selection screen.  Note the list of Sage 300 CRE records to which

attachments can be made.  Each record also contains a description of how a specific record is identified. 

In the case of the AP Invoice record for instance, a specific invoice will be identified by the combination of

vendor and invoice.  In each case, the record identification is equal to the list of Sage 300 CRE key fields. 

 
For our new Form W9, we want to attach to the PR Employee Record which we can select either by clicking Add or

by double clicking the record name.   In this case, we are only interested in attaching to a single record so we are

done and can click Close in the lower right hand corner of the screen.

 



 

 

 
Now it is time to further categorize this document by selecting the fields which best describe it. 

 
These fields will be used to search for this type of document down the road.  In this case, we want simply to

identify the Form W9 by Employee.  Click Add Fields to begin the field selection.  Note the list of Sage 300 CRE

fields on the left.  This list is hard coded within AIM and cannot be changed.  The list has three columns:  Name,

which corresponds to the name of the field in Sage 300 CRE, Data Type and Field Type.  Note that all three columns

can be sorted by clicking on the green column header.  The columns can be filtered as well by clicking in the blank

box at the top of each column.

 



 

 

 
 

 
Select a field by double clicking or highlighting and selecting Add.  Remove a field by typing Remove.  Remember,

each field you choose will be coded when you categorize an AIM document.  You want to make sure you have all of

the fields you may want to search by but not so many that coding becomes complicated.  You can check selected

fields to be required in AIM data entry.

 
Now let’s create the Document type for an Electrician’s License.  Certainly we will want the client number and the license

expiration date although neither is available in Sage 300 CRE so we will need to add Custom Fields.  We can create those

right from the field selection window by selecting Create new Custom Field.

We will begin with expiration date. 

Start by assigning the field a unique name.  In this case, we need a date so we will choose DateTime but note that

you may also choose Alpha, Numeric, CheckBox or Drop Down Item.  The last will be familiar to Sage 300 CRE. users

who use customized lists from Custom Descriptions.  Finish the creation of the custom field by clicking Save.

 



 

 

 
Now we need to add this new field to the document so that we can categorize license images by expiration date and

eventually search for licenses based on expiration date.  Add either by double clicking or by highlighting and selecting Add. 

And again, if you select a field in error, click Remove to delete it.

 

 
Let’s repeat the process for the License number. 

 



 

 

 
We are done selecting fields so let’s click Close in the lower right hand corner.

 
Now we can select Assigned Users for this Document which further refines the security at the Document Category level. 

You can assign users here or by selecting the icon "Assign users to document types" in AIM Maintenance.

For instance, if most of the documents within this Type are public but you have a single document that you wish to

further restrict, you can select an Assigned User to override the selection and the higher Category level. 

 

 
Optionally, you can create workflows and routing rules and assign these to Document Types. See the sections below to

learn about Workflows and Routing Rules.

 

 
 



 

 

In the Workflows tab you can assign approval workflow only when this document type will always go through the same

approval workflow

 
In the Routing Rules tab you can select a Routing Rule(s) if applicable. This will assign what Criteria to use in routing

documents through this workflow. If no routing rules are selected then all documents for this document type will go

through the workflow selected.

 
Click Save to exit out of Document Type selection and return to the main admin menu.

 
 



 

 

Assign Users to Document Types
 

 
We can select Assign Users for Document Type which further refines the security at the Document Category level. 

For instance, if most of the documents within this Type are public but you have a single document that you wish to

further restrict, you can select an Assigned User to override the selection and the higher Category level. 

 



 

 

Custom Fields
 
There is a second location from which to add Custom Fields and that is from the icon directly on the AIM Doc Types menu.

 

 
Start by assigning the field a unique name.  In this case, we need a date so we will choose DateTime but note that

you may also choose Alpha, Numeric, CheckBox or Drop Down Item.  The last will be familiar to Sage 300 CRE.

users who use customized lists from Custom Descriptions.  Finish the creation of the custom field by clicking Save.

 



 

 

AIM Data Entry Groups
 
An AIM Data Entry Group is a group of users who have AIM DATA Entry Permission. 

Files acquired using AIM Acquire are sent to an AIM Data Entry Group for categorization/coding/data

entry. At least one Data Entry Group is required.

 
 
 
 
 

 
You must be an Administrator to set up AIM Data Entry Group. AIM Maintenance > AIM Data Entry Groups

 

 
You can Add or Delete AIM Data Entry Groups .  The Delete Option will only be available if

the  group has

not been used. 

 
Click "Add" to add a new group.  Give the Data Entry Group a unique name and then you can add users to this group.

 
 



 

 

 
Only users with AIM Data Entry Permissions in User Maintenance will be available to add to the Group. 

 

 
NOTE:  Once a user is added to the group, they are members regardless of changes in permissions.  If a user had the

Data Entry permission revoked, the admininstrator will need to manually remove the user from the AIM Data Entry

Group Window. 

 
Add users by selecting a user from the list of Available Users and clicking "Add". 

 



 

 

To Remove a User, select the user from Assigned users and click "Remove" .

 

 
 
 
 
 
 
 



 

 

Workflows
 

 
While workflows are optional in AIM, they can provide powerful attributes to the AIM approval process. A

Workflow is a series of tasks, Workflow Tasks, through which a Document passes.

 
Each Workflow task must be completed before the workflow is completed. 

 
Workflow Tasks may be ordered where each Workflow Task is assigned and completed sequentially in

the order specified by the user. 

 
Workflow Tasks may also be assigned all at once and completed without order. 

 
• Users can set up a Workflow..

 
• Users can then assign Workflows to Document Types

 
• Users an also assign Workflows to Document Type Routing Rules. 

 
Real World Use:

 
John at Integrity Software just closed a deal for fifteen licenses of Integrity's Package.  His client just signed the

contract and John scanned it in.  The contract is on the network share serer.  John knows that his manager, Bob

Evans and others want to see all final sales contracts. 

 
John opens AIM and signs in.  He opens the AIM Acquire Window, finds his sales contract, drops it into the AIM

Acquire Window, and clicks the Done button.  Hope opens the AIM data entry window so she can categorize the sales

contract.  She selects Signed Sales Contract as the Document Type and enters the data into the required fields. 



 

 

 
Since management has assigned a workflow to the Signed Sales Contract Document Type, John's sales contract will

automatically be routed to Bob Evans and then to the controller (GL user) for final processing. Furthermore, anyone

with appropriate permissions can easily find the Sales Contract using AIM Search and there is a History of the entire

process. 

 
This Real World Case needs the following set up prior to setting up a Workflow:

 
Users in the Approval Workflow need to have AIM approval permissions.

 

 
 



 

 

Navigate to AIM Maintenance > Workflows

 

 
 
Click on "Add" to set up a Workflow

 

 
 
Give the workflow a name and click on "Add workflow tasks"

 

 
 
Workflow tasks are defined by AIM.  There are three Workflow Tasks from which to choose:

 
Document Approval

 
Attach Document

 



 

 

Export Supporting Document (when the Document Type for the Workflow Task exists as a Supporting Document from

TimberScan). 

 

 
When you add a task you will be prompted to select a user.  The available users will depend on their AIM permission.

 
 

 
Select a user and you will see the task in Assigned workflow tasks. 

 



 

 

 
You can add another user now or close the workflow. 

 

 
The Export Supoprting Document workflow task applies to Document Types under the AP Category which derived as

Supporting Documents from TimberScan. Selecting this option will automatically set up the AIM document as a Supporting

Document in TimberScan. This way, purchase orders (packing slips, etc.) can be indexed in AIM and exist in TimberScan

waiting to be attached as a Supporting Document to the vendor invoice.

 
When selecting the Export Supporting Document task, you will be prompted to (1) select an AP Document Type (a list of

Supporting Documents displays); (2) enter an email address for notifications and (3) select a TimberScan data entry group:

 



 

 

When you "Close" out of Workflow Tasks, you can choose "Sequential workflow" if you want the tasks to occur in a

sequential order.

 

 
 
Users may move the Workflow Tasks up and down by selecting the task and dragging the task up or down.

 
Now that you have a workflow set up, you can add the workflow to a Document Type. 

 
AIM Maintenance > Document Types

 
 
 

 
 
Click on "Workflows" tab and "Add workflow"

 



 

 

 
Select the workflow you want to use for this Document Type.  You can also use the "Create workflow" to create a workflow

on the fly.

 

 
 



 

 

Workflow Hierarchy
 
 
 
Hierarchy for what approval workflow will be used when indexing includes values in multiple workflows

 
1. When in data entry we first check to see if there was an On the Fly route specified, routing directly from the data entry

window.

 
2. If the user has not specified an On the Fly route then the routing rules for the document type are evaluated.

a. If there are routing rules that match the document then the document is routed via the routing rules.

 
3. If there are no such routing rules then the document is routed via the workflows assigned to the document type.

 
4. If there are no such workflows then the document is not routed.

 
So, if you wanted to route a certain document type the same way every time then you would assign a workflow to that

document type and nothing else.



 

 

Switch Workflow User
 

The Switch Workflow User window allows users to replace a user

assigned to one or more workflow tasks with a different user.

 
 
 

 
Select the Workflow user you want to replace, and then choose the new user you want to switch to.  Then click "Switch"

 

 
In the Switch Workflow User Window the "Switch Workflow User" is populated with users assigned to one or more

Workflow Tasks.  The "To User" is populated with all users who have Approve Documents permission.

 
Switch Workflow User allows you to easily substitute one user for another in an AIM workflow. For example, when a user

goes on vacation, Switch Workflow User allows a different user to complete the vacationing user's workflow tasks.

 



 

 

 
 

 



 

 

Aim Users
AIM Users window allows users to View all AIM Users. 

 
The AIM Users window also gives you access to edit an AIM user where Roles, Field Access, Document Types Access and

Document Type Fields access can be assigned or removed.  

 

 
 

 
 

Field Access can be assigned for AIM users:

 



 

 

 

 
Document Types can be added or modified for AIM users:

 

 
 

 
 



 

 

Routing Fields
The Routing Fields window allows users to view, create, and remove Routing Fields.  A Routing

Field is a field or a combinations of fields used as templates for a Routing Value Groups. 

 

 

 
 

The Routing Fields in the Routing Fields list box are ordered according to the order Routing Fields will be evaluated

when determining which Routing Field Value to route a Document by. 

 
If we want to Route Sales Contracts for Large Customers differently than small customers, we could set up a Routing Field

for Customer Level (A Custom Field).

 



 

 

 
You can have one or multiple fields using "Add & close" or "Add & continue"

 



 

 

 

 
When the field(s) have been added you can move them up or down based on their priority.

 



 

 

 
 



 

 

Routing Values Groups
 
 

Routing Value Groups can come from two different sources:

 
Routing Value Group:  Set up in AIM

• A distinct set of Routing Values that can be assigned to a Routing Rule using the

   Routing Rule Routing Value Groups Tab of the Routing Ruless Setup Window

 
Timberscan Approval Groups:  Set up in Timberscan. 

• A Routing Values Group is created for each TimberScan Approval Workflow using the Approval Criteria

assigned to the TimberScan Approval Workflow. The Routing Values Group Name will be the Approval

Workflow GroupID and the Approval Criteria assigned to the Approval Workflow will be the Routing Values

assigned to the Routing Values Group.

 
• Any time a new TimberScan Approval Workflow is added via the TimberScan Approval Workflow

window, a corresponding/matching Routing Values Group will be added in AIM. The TimberScan

Approval Workflow GroupID will be used for the name of the AIM Routing Values Group.

 
• Note: Deleting a TimberScan Approval Workflow has no impact on its corresponding Routing Values

Group

 
• You may add additional fields to any AIM Routing Value group originating from TimberScan Approval

Criteria. However, keep in mind, ANY values added in AIM Routing Values do not flow back to

Timberscan Approval Criteria.

 
 
Each Routing Value Group consists of a unique Name and a set of Values.

 
A given value may only be added to one Routing Value group.  i.e. Employee 101 may only be in a single group. This

mirrors Timberscan Approval Criteria Members where a given value, once assigned, may not be selected again

 



 

 

In the example below a Routing Values Group has been set up for "LargeCust"

 

 
Where "LargeCust" is defined as Customers with sales over $1,000,000.

 
 

 
 Defined in Timberscan AIM using a Custom Dropdown Field. 

 

 



 

 

Routing Rules
 

Rules Based Routing allows users to send documents through a Workflow,

based on the field (index) values in that document. 

 
 

 
 
In the example below, AIM documents will be sent through the "salescontract" workflow only when AIM Document

Types = "Signed Sales Contracts" have been coded using the "LargeCust" Routing Group.  That Routing Group specifies

Customer Levels coded using Dropdown box "Customer Level" = over $1,000,000.

 
In this case, the field value is the AR Customer level over $1,000,000. 

 

 
Here's a sample of other Routing Fields available.  See the Section above on Routing Fields for even more options.

 



 

 

 
More Routing Rule Guidelines

 

• A Rule may apply to more than one Document Type – put another way, the same document type can be specified in

multiple Rules.

For example, One rule may apply to Subcontracts, Purchase Orders and Owner Change Orders

 
• A Rule may contain multiple Routing Value groups

Bob's Jobs and Doug's Jobs for example

 
 
 
 
 



 

 

Routing Rules Priority
 
• Routing Rules Priority

 
• The order of the fields in the group determines the evaluation priority
• If there is more than one Rule that applies to a given document, the one with the highest priority will take effect

 
For example

A Purchase Order Document Type is created with four Document Type Fields: Job, Vendor, Amount, Date

Created

The Purchase Order Document Type also has two Routing Rules assigned

 
Purchase Order Rule 1

Job: 03-002

Vendor: 102

Vendor-Job 102|03-004

 

Purchase Order Rule 2

Vendor-Job: 102 | 03-002

Job: 03-004

 
In this example the Purchase Order Rule 1 and Purchase Rule Order Rule 2 contain 3 Routing Fields:

Job, Vendor, and Vendor-Job.

 
Assume these Routing Fields were ordered in the Document Type Routing Fields Window as

follows:

Vendor-Job

Job

Vendor

 
Then a Document is entered using the Purchase Order Document Type containing

 
Job 03-002



 

 

Vendor 102

Amount 100

Date Created 7/11/2014

 

Rule 2 will be executed because it has a matching Routing Value with the highest priority Routing

Field, Vendor-Job 102|03-002

 
 



 

 

Reindex AIM
 

 
Reindex AIM is only to be used in conjunction with an AIM specialist from Core Associates.

 



 

 

AIM Workflow
 
• AIM Acquire

 
• AIM Data Entry

 
• AIM Workflow Tasks

 
• AIM Stop Workflows

 
• AIM Search

 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 



 

 

AIM Acquire
AIM Documents are acquired from their own AIM menu "AIM Acquire". 

 

 
You can Drag and Drop AIM documents onto the AIM Acquire Window, including attachments from emails.You can also

"Select Files" to retrieve AIM documents from your computer or network directories.  When using drag and drop with email

attachments, you have the opportunity to separate AIM documents.

 

 



 

 

You must select a data entry group, similar to the group for TimberScan data entry, except these are only for AIM

Documents.

 
After Selecting the data entry group, click "Process" and you are ready to code your AIM Document.

 
 
Drag and Drop onto the AIM main windows opens AIM Data Entry, acquiring the document automatically into your default

AIM data entry group:

 



 

 

 
Files can be acquired in their "native" format. They do NOT need to be acquired in PDF or TIFF format first.

 
Built-in Word and Excel Editors

 
AIM offers an editor for Word and one for Excel built in. You can now open and view Excel and Word documents even when

the associated programs are not installed. When a Word or Excel file is opened, the related editor is automatically enabled.

 
NOTE: Only recent versions of Word and Excel – those with extensions .docx and xlsx - are supported.

 
Word documents and Excel spreadsheets will automatically display in AIM Acquire and AIM Data Entry. In AIM Search and

Search Grid, clicking on VIEW will enable the external related applications, Word and Excel. The built-in Word/Excel viewer

is designed for acquiring and editing these documents for the purpose of tracking the image changes. (Tracking changes

(versioning) is an AIM enhancement which will be released later.)

 
NOTE: The built-in viewer in TimberScan does not open when selecting the View button in Search.

 



 

 

NOTE: Annotations apply to TIFF/TIF documents only. This is because other documents open in their related

applications. For example, a PDF may open in Adobe. If you have rights to annotate in Adobe, you will be able to add

annotations to the document in AIM using Adobe software.

 
Combine/Split Pages & Documents

In AIM Acquire, it’s easy to combine pages from one document into another document or to split multiple pages in one

document into multiple documents. Highlight the page to be moved, right mouse click and select Split file here.

 

 
The original 6-page W9 document is now split into two documents – one with 4 pages and a new one with 2 pages from the

original document.

To combine files, highlight the page you want to move and use the left mouse button to drag it to a different document or a

different page position in the same file. 



 

 

 
The two files above (w9-2 and Processed_...) have been combined into one file. When all pages have been removed from a

document, the empty document will display in red. Right mouse click to remove the empty file:

 
The Undo function acts like Undo in Microsoft Office – the last step performed is undone.

 



 

 

AIM Index/Data Entry/Code
The Data Entry icon will let you know how many un-coded AIM documents are waiting.  Double click to open the AIM Data

Entry window. Additional menu items include View File, Add Page, Workflows and Route. Some of the available options are

dependent on a user's permissions in User Maintenance.

 
Let’s take a minute to explore this window.  At the top of the window, you will see icons for Saving, Printing and Emailing.  As

in other areas of TimberScan, you may email the original image or send as a PDF.  You can choose the History button to see

what has been done with this document or add a note.And, there are four navigation buttons to take you through all of the

un-coded images.

 
 
 



 

 

On the right hand side of the screen are the familiar image annotation and correction icons and down the left hand side of

the screen, thumbnails for each page in the image.

 
NOTE: Annotations only apply to TIFF/TIF files. In AIM, annotations pertain to TIF/TIFF documents only. This is

because other document types open in their related application. For example, a PDF may open in Adobe. If you have rights

to annotate in Adobe, you will be able to add annotations to the document in AIM using Adobe.

 

 
 
 
Start coding by selecting a Category. Alternatively, select a Document Type and the Category will automatically prefill. The

Type drop-down list displays without having to enter a category first. In addition, the selected category and document types

remain onscreen until changed by the user.

 
Let’s start coding a new Electrician’s license by selecting a Category. In this case, we will choose PR. This narrows down our

selection in Document Type and shows us only those types defined within the selected category.

 



 

 

 
 

Once a document type is chosen, we see the fields we defined earlier for this type of document. When you choose a Sage

300 CRE. field, you will see an ellipsis (three browse dots) to the right of the field box. Clicking on the ellipsis opens a lookup

window which displays data available fom your Sage 300 CRE database.  In our case, we see the list of employee IDs,

names as well as the city of residence.

 
Let’s select Employee 101, Robert Jones. The Electrician’s License number is a custom field and we enter that number

manually.Lastly, we need a license expiration date.Because we defined this as a date field, clicking inside that window will

bring up the calendar and you may select a date from the calendar window or enter one manually.

 



 

 

 
When you are finished coding, you may save your changes by navigating to the next document and answering “Yes” to save

changes or by selecting Save in the upper left hand corner of your screen.

 
NOTE: After saving the coding on a document in AIM Data Entry, the index fields for the prior coded category and type will

display for data entry on the next document in the queue. This speeds up data entry when coding multiple documents for the

same category and type.

 
Duplicate Document Indexing

 
A setting in admin can check for duplicate coding on documents in AIM Data Entry. When checked, you can be warned of an

duplicate entry - an existing AIM document with the exact same data for the same document type.

 



 

 

 
 
Let’s review some of the other options available in AIM Data Entry.

 
MENU BUTTONS

 

Save

 
Saves coding information on a document.

 
View File

 
Opens a file in its native format (Adobe Reader, Word, Excel, etc.)

 
Print File

 
Prints the a file displayed onscreen.

 
 
Add Page (User Permission)

 
Can add a page to an acquired AIM TIFF document (does not apply to any other document type)

 
 
Email

 



 

 

The Email button allows users to email the current document.  A local copy of the document will be copied into the users My

Documents folder and that copy will be attached to the email.  The copy will be deleted after the document is emailed.

 
Delete (User Permission)

 
Delete the document displayed onscreen.

 
History

 



 

 

 
Other items in History can include information on rejected documents, workflow such as acquire, data entry, routing

information, notes, etc.

 
Image History items start to accumulate when the document is first opened. They are added to the Document History once

the user clicks the Save Button.

 
 
In AIM Data Entry and Acquire, annotations pertain to TIF/TIFF documents only. This is because other documents open

in their related application. For example, a PDF may open in Adobe. If you have rights to annotate in Adobe, you will be able

to add annotations to the document in AIM using Adobe.

 
When TIF/TIFF files are opened the following events will be tracked:

 
• Annotation Added
• Annotation Removed
• Annotation Resized
• Annotation Moved
• Annotation Text Changed
• Page Rotated
• Page Deskewed
• Page Despeckled
• Hole Punches Removed
• Borders Removed

 



 

 

 
     

Workflows

 
Selecting the Workflows button opens the Document Workflows window for the document loaded in the Data Entry window.If

there are no Workflows for the existing coding on a document, the Workflows button is disabled.

 
Route (User Permission)

 
The Route Button will be visible for users with AIM Route On Fly permission. Clicking the Route button opens the Routing

window where the user can select a Workflow for routing the document.

 
If a selected Workflow is not assigned to the coded Document Type, the document will be routed using the selected

Workflow in the routing window after the document is Saved. 

 

 
If the coded Document Type already has an assigned workflow assigned AND the user has the 'Override Route" permission,

the user is permitted to overrides the assigned Workflow when the Document is Saved.

 



 

 

Add Note

 
Notes are added to the document history.

 
Navigation Commands

 
First, Previous, Next and Last documents in AIM Data Entry.

 
Document Classification
 
Document Category Drop Down

The Document Category drop down list allows users to filter what Document Types display in the drop down list.  The field

is populated with all the Categories assigned to the user. When the user selects a Category first, the Document Type drop

down list displays only the Document Types within the selected Category. 

 
Document Type Drop Down

The Document Type drop down list allows users to select from Types assigned to the user. The Document Category will

automatically prefill when selecting the Document Type first.

 
Both Document Category and Document Type remain selected for any remaining documents until changed by the user.

 
Indexes for the Document Type

The fields available for input depend on the fields set up for the selected Document Type. The fields may or may not be

required based on the Document Type set up as well.

 



 

 

 
OK – we’ve set up AIM, acquired and coded documents, now it’s time to see the power of AIM at work.

 



 

 

AIM Workflow Tasks
 

Workflows are executed when a new document has been categorized. After a user selects the Save Button on the Data

Entry Window, the document is automatically routed through the Workflows assigned to the Document Type. If there are no

assigned Workflows for the coded Document Type, the user may 'route on the fly' and select a Workflow if he/she has that

user permission.

 
Workflow tasks are queued in the user's Workflow Task queue.

 
 

 

 
The Workflow Tasks queue gives users the ability to view and complete any Workflow Tasks sent to them for completion. 

Each Workflow Task in the Workflow must be completed by the user assigned to the Workflow Task before the Workflow is

considered complete.

 

Click the "+" key to view the document's indexing. 

 



 

 

 
 
Double-click on a line item to open a Workflow Task.

 
 NOTE: Some of the options dispayed in the Approve window (shown below) are dependent on user permissions.

 



 

 

 
The user may complete an Approval Workflow Task by clicking theApprove Button on the Approval Window.Alternatively,

the user may opt to click the Cancel button (user permission) to indicate they are not ready to complete or approve the

Workflow Task. These actions add to the document history.

 
Indexes can be revised from Approve.

 



 

 

NOTE:

Annotations only apply to TIFF/TIF files. In AIM, annotations pertain to TIF/TIFF documents only. This is because

other documents open in their related application. For example, a PDF may open in Adobe. If you have rights to annotate in

Adobe, you will be able to add annotations to the document in AIM using Adobe.

 
If the Workflow Task was created from a Workflow triggered by a Routing Rule then Rules Based Routing Rules will be

evaluated using the nex indexes.  If the Document changes to a new Workflow after re-evaluating the Routing Rules then a

warning message is displayed telling the user the Document will be routed to a new Workflow.

 
When the user has completed or canceled a Workflow Task, they are returned to the refreshed Workflow Tasks queue

window. This continues until the user has completed all Workflow Tasks in the queue.

 
Reject

 
If given the Reject Tasks user permission, the user can send reject the document back to a task that was previously

completed. The action is recorded in the document history.

 



 

 

 
History

 
The History button displays all actions assigned as a history item to a document. Actions in acquire, data entry, and

workflows, including routing, rejecting and cancelling workflows are included in document history.

 



 

 

 
 
• In addition to tracking the date and type (acquired, entered, workflow started, etc.) of history item, the Message column

displays the user assigned to the item as well as the name of any Workflows tasks and associated Document Types.

 
Workflows

 
Displays information on the workflow associated with the document.

 

 
 
Add Note

 

 



 

 

 
Send To

 
Allows for routing or transferring a document to another user.

 

 
Other options a user may have include View File, Print, Add Page, Email, and Delete.

 
Stop Workflows

 

 
Stop Workflows Window allows users to view and delete any of the Workflows that are executing. The Stop Workflows Icon

is only available for users with AIM Kill Workflows Permission.

 
The Stop Workflows Window displays all the executing workflows, workflows that have one or more incomplete tasks, in the

Workflows to Stop List box.

The Workflows to Stop Listbox contains columns: Details(+), Workflow Name, Start Date, and Stop.

The Details(+) column is a button column that when clicked expands the row to display the Workflow Tasks Listbox for the

Workflow.



 

 

The Stop column is a button that when clicked: completes any Workflow Tasks that are not completed, adds a Workflow

Task Stopped History Item to the Document History of the Document for which the Workflow is executing, completes the

Workflow, Adds a Workflow Stopped History Item to the Document for which the Workflow is executing, and removes the

Workflow from the Workflows to Stop List.

 
Built-in Word and Excel Editors

 
AIM has an editor for Word and one for Excel built in. You can now open and view Excel and Word documents even when

the associated programs are not installed. When a Word or Excel file is opened, the related editor is automatically enabled.

NOTE: Only recent versions of Word and Excel – those with extensions .docx and xlsx - are supported.

 
 



 

 

AIM Search
 
• What a user sees in Search is based on one of the following four combinations:

 
• The user has rights* to an entire Category OR
• The user has rights* to a Document Type OR
• The user has rights* to one of the Field values on the document OR
• The user has rights* to ALL of the field values on a Document Type

 
*Either inherited or explicit rights

 

 
Narrow your search results by: Category and Document Type

 
Let’s navigate to the AIM Search window and begin a new search.  We are going to look for all existing Electrician’s

licenses.  So we start by selecting our PR Category and a document type of Electrician’s License.  We can hit

“Search now” and AIM will return all copies of all documents coded as Electrician’s Licenses.

 



 

 

 
You can enter multiple categories and/or multiple document types in a single AIM search.

 
Search results display in the middle of the screen window.  From here, we can view original images where we can

annotate or adjust, email or scroll through all images.  We can add a note or view all the notes related to an image. 

 



 

 

NOTE: Annotations only apply to TIFF/TIF files. In AIM, annotations pertain to TIF/TIFF documents only. This is

because other document types open in their related application. For example, a PDF may open in Adobe. If you have rights

to annotate in Adobe, you will be able to add annotations to the document in AIM using Adobe.

 
 

 



 

 

The details for each line in the search window are automatically expanded to view coding information for each

document.

We can also view the related document Workflows and selectively choose which images to print or print all images.

If the search returns more records than fit on a single screen, use the navigation buttons in the lower left hand

corner to move from one results screen to the next.

 

 
Select a Condtion to narrow your search further:

 
Let’s find all licenses expiring next year by creating a condition.  Start by selecting the field we want to filter on.

  In our case, this is the License Expiration Date.  Next, let’s select an operator.  In our case, the “greater than”

sign.  Finally, we have to select a criteria.  This is a date and again, we can use the date displayed or enter a date

manually.

 
 



 

 

 
Once you refine your search, you can save this search by clicking the Save Current Search button in the upper right

portion of the window. You will be prompted to name your search. The next time you go into AIM search, this saved

search will be available and you can run it by browsing for it and selecting it in the Select Saved Search window.

 
Note that you may string multiple conditions together by selecting a value in the AND/OR box at the end of the last

criteria row. You may also remove all conditions or just one. Over time, you will build a library of saved searches to

save typing and make your document retrieval that much easier.

 



 

 

 
ADDITIONAL INFORMATION IN AIM SEARCH:

 
A count of search results displays at the bottom of the window. The user can also adjust the number of items per page to

display.

 



 

 

 
Edit  (User Permission)

 

 
 



 

 

 
 
The Edit button allows a user to:

 
•  Add or change the index coding
• View, print and/or email the document
• Add a page or note
• Delete a document
• Route a document on the fly if it needed to be Approved and did not initially go through an approval process
• View Workflow information as well as History

 
Workflows

 
The Workflow Button displays the workflow of a document and, if applicable, who approved it as well as the status of

a document that is currently in the workflow process.

 

 
You can also View Images, View Notes and add Notes. You can change the sort order by clicking on a column heading.



 

 

AIM Search Grid
 
The AIM multi-function Search Grid offers you many of the same functions available in TimberScan inquiries, including an

export to Excel.

 

 

 
 
 
 
The grid is similar to the TimberScan inquiries you are familiar with. All columns pertaining to the invoice, including

distribution fields, are displayed. Data can be sorted by column headings and the functions available in TimberScan

inquiries are also available here.

 
Difference Between Search and Search Grid

Search: Data sort is limited to columns for Acquire Date, Acquired By and Document Type:

 



 

 

 
 
Search Grid: The search grid displays all columns related to a document type. For invoices, you can sort and filter by any

column heading, such as job for example:

 

 
When you change the document type, the columns change to display the index fields for the new document type:

 



 

 

 
 
The functions you are familiar with in TimberScan inquiries are also available in the AIM Search Grid:

 

 
You can move columns around via drag and drop, like TimberScan inquiries.

To add or remove columns, click on the Field Chooser icon on the far left of the column row and a list of fields automatically

displays in alphabetical order:

 

 
 
You can even use the Group feature:



 

 

 

 
 
 



 

 

Paperclip
Accumlates AIM documents into one shortcut.

 

 
When you select an AIM paperclip in Sage, all documents attached to the Sage record will display in a

window where you can select the specific document you need.

 
 

 



 

 

The user will click View beside a document which will attempt to open the document with the program associated with this

document type. This program is assumed to be available in  the user’s environment.

 
This features allows AIM to bypass Sage's restriction on the number of characters in can accomodate in

the Sage File Links.

 
 



 

 

Capture
 

Capture Video
 

http://www.screencast.com/t/x9JBIYMw. 


 

 

 
 

     

 
Introduction

 
 

We are very excited to welcome you to the benefits of utilizing OCR technology.  On the following pages

you will find some key information – including definition of terms, tips and best practices - that will ensure

you experience your return on investment quickly and enjoy the efficiency OCR technology brings.

 
 



 

 

Overview
 

Welcome to Capture OCR Technology!

 
Capture reduces data entry by automatically turning scanned invoices into coded invoices using OCR

technology.

 
OCR Success Rate –

 
1)     Best Practices would target a goal of 80% of electronic invoices.

2)     OCR Technology for paper documents is greatly influenced by the quality of the scanned image.

There may be certain fields that would continue being input from the data entry screen.

 
The best results are obtained when you use pdfs that are electronically produced (those emailed to you

or downloaded from a vendor’s site). When invoices are scanned, the scanning process often degrades

the quality of the image.  We understand that some invoices will need to be scanned; this process still

produces good results - typically just not as good as electronically produced pdfs. Remember, OCR

results are based on the quality of scan.

If scanning, scan each invoice as a separate pdf. Scan them as a pdf, in black & white at 300 dpi. 

 
Advising your vendors that you now require/prefer invoices emailed is highly recommended. PDF

format works the best.

 
Multiple Distributions & Coding will continue to be done in the data entry screen by your data entry

person.   Although Capture will recognize a job number and/or commitment ID on the invoice that will

populate the data entry screen, multiple distribution lines and coding will need to continue to be done in

TimberScan’s data entry window.

 
Communicating best practices to your team is highly recommended as this helps all staff understand

Capture’s role in the A/P process and the role that the data entry personnel will continue to play.

 
Capture Implementations     

 



 

 

1)     Data-Entry personnel play a very important part in the implementation of Capture.  Their

understanding of the long range benefits fosters their support and is integral to a successful

deployment.

2)     The person assigned to building and tweaking templates also plays a key role.  Their knowledge,

time and patience during the setup process are vital in a well-supported implementation.

 
System Requirements

Capture requires the same hardware and software requirements published for TimberScan.

 
Capture Users in TimberScan

Any TimberScan user who has the ‘Acquire Invoices’ permission can also acquire Capture invoices.

However, ONLY a licensed Capture user can process Capture invoices.

Templates are created by data folder. While templates may be copied from one data folder to another,

the invoice coding on the template may need to be modified.

 
 
 
 
 
 
 



 

 

Definition of Terms
 
Template – a user-defined master pattern or model that identifies locations of information on a vendor

invoice image so that OCR technology can match an acquired image to a defined template. Data

to be recognized include vendor, invoice date, invoice amount, etc. Normally there is a one-to-one

relationship of template to vendor. However, if the vendor has multiple invoice formats, you may set up

multiple templates.

 
 TIP: Name the template for a vendor to match the vendor name.

 
Profile – a unique coding differentiation for a template. At least one profile is required per template.

You may create multiple profiles to automatically prefill coding information on a vendor template. For

example, a job or GL prefix may be associated with a vendor address or account. The profile name

displays in a list under the vendor template. When there is a single profile per template you may choose

to label the profile the same as the template.

 
Anchor – a unique field that can distinguish one vendor invoice from another. For example, when there

is one coding profile for a vendor, the vendor name may be a good anchor to distinguish this vendor’s

invoice from all others. The anchor on a template helps Capture match the image to a template. If there

is low matching confidence, Capture is going to make its best guess based on content.  Therefore, best

practice calls for ensuring that the content of the anchor is as unique as possible. Do not use words

such as your company name, “Invoice”, “Due Date”, “Date” or anything else that it is likely to appear on

every single vendor’s invoice. A small number of anchors with unique content is preferable to a larger

number of anchors with very generic content.

 
Identifier – a unique field that distinguishes one profile from another. A profile must contain an identifier.

The identifier prefills on the template profile. When there is a one-to-one relationship between a profile

and a template, the identifier can be the vendor name. When creating multiple profiles for a single

vendor template, each identifier must be unique so Capture can match the image to the template-profile.

For example, if there are multiple vendor accounts (or addresses), each signifying a unique coding

profile (for a specific job or General Ledger prefix), select the account (or address) as the identifier.

 
Single v Multi-Page Template – identifies where the invoice total is located on the invoice image. ‘Single’

signifies the total is always on the first page of the invoice image; ‘multi-page’ implies the total is always



 

 

on the last page. This designation has nothing to do with the number of pages in the invoice image. A

multi-page template, for example, may be defined as a ‘single’ page when the invoice total is located on

the first page.

 
     TIP: Think of the template-profile as a parent-child relationship. At least one profile is required

for a template. Each template can have multiple profiles. The anchor differentiates templates while the

identifier discerns the profile(s).



 

 

Capture Setup
 

Capture Administration Settings
 

Capture Templates
 

Copy Templates
 

Capture Licensing File
 
 
 
 



 

 

Capture Admin Setup
Administration Settings:
 
For most clients, the default Capture settings should be sufficient.

 
To view/change these settings, you must be logged into the Admin Menu. Navigate to Settings > System Settings.

 
Below you will see the Capture settings:

 
 
 
Image Resolutions

 
Capture - you have the option to specify whether the Capture documents that you are going to scan/acquire should have

a resolution of 300 dpi or 600 dpi. We strongly recommend using 300 dpi as the higher 600 dpi resolution provides no

appreciable benefits when recognizing the text in a document and results in significantly larger image files.

 
The Final Resolution -  the permanent resolution that the images will be stored as after the Capture process. Again,

we recommend 300 dpi as that is generally considered to be archival quality, however, to save space the images can be

downgraded to 200 dpi. It is not possible to upgrade the Final Resolution to a higher resolution than the Capture resolution.

 
Capture Settiings in admin > System Settings

 
Processing Method -   The Processing Method defaults to Original; the Proofing Grid is under development.

 
Accounting Date Usage -   The three options are “Invoice Date”, “Current Date” and “Acquire Date”. Regardless of the

method that you choose for calculating this date, it can always be changed at any time before being exported to Sage 300

CRE.

 



 

 

The Invoice Recognition Percent - should never be changed unless so advised by a TimberScan support representative.

 
Remove Leading Zeroes - Check this option if you do not want your vendor invoices starting with zeroes.  This option

removes the zeroes and the invoice number starts with the first digit not zero. 

 
Default Invoice Date Format:  MM/DD/YYYY is the most common date format in the United States while DD/MM/YYYY is

commonly used in Canada and Europe and other countries. 

 
Two Types of Capture Users
 
Capture-Licensed Users

A licensed Capture user can perform the following:

• Process own acquired images as well as processing acquired Capture images from non-Capture Licensed users
• Create and modify Capture templates and profiles

 

Non-Capture Licensed Users

• Any user with “Acquire” permission may acquire invoices for Capture
• Must specify the Capture-licensed user on acquire

 
User Settings :

 
There are only a few settings that need to be addressed relating to Capture. 

 



 

 

"Hide Deskew Prompt" , "Auto Deskew with Prompt", Acquire Invoices and Process Captured Invoices

 

 
 
Acquire Invoices - is required to be able to capture OCR invoices.

 
Auto Deskew with Prompt - Automatically deskews invoices when acquired.           

 
Hide Deskew Prompt - If Deskewing is desired but the user wants to hide the prompt, this option can be chosen.

 
If neither option is selected above, the user will have to manually deskew documents acquired. 

 
Process Captured Invoices - This will be available if the user is licensed for Capture. 

 



 

 

 
 



 

 

Capture Templates
 
 
The first step in preparing your system for Capture is to create templates for recognizing documents.

 
These templates are used to associate Sage 300 CRE vendor codes with the scanned documents as well as where to find the

information on these documents that is to be extracted.

 
If you are an existing TimberScan user, you can use invoices that have been acquired and exported to Sage 300 CRE as the

basis for the templates, providing  they are the same resolution as the Capture Image Resolution in System Settings.

 
Your company’s system administrator can tell you where to find these images. If you have been acquiring these images at

less than 300 dpi, you will have to scan new originals to use as templates.

 
An error message will be displayed if you attempt to use an image with the incorrect resolution.

 
There is no direct scanning or 'drag and drop' into the Template definition screen

 
Capture Templates v Copy Templates:

Select Capture Templates to create and/or modify Capture templates and profiles. The Copy Templates selection allows

you to copy one or more templates from the current data folder to one or more different data folders. You can also use this

feature to export/import templates created by a third party into your Capture template inventory.

 
To begin, from the Main Menu go to Acquire >Capture Templates.

 

 
A listing of existing templates will be displayed. This will of course be empty when you are starting.

or



 

 

 
Press the “Create” button and the “Acquire Capture Templates” form will be displayed.

 
Template Description: Enter a unique template name such as the vendor name or ID.

 
Profiles are stored with their corresponding Template Names. 

 
Each Template must have at least one Profile.  In the example below, Home Hdwe has 3 profiles.  This allow for one invoice

form with multiple job and/or properties so that with the "identifier" noted on the invoice Capture can code the invoice

automatically.

 



 

 

 
From this window you can perform the following:

 
• Create a New Template from a new Image.

 
• Add coding or Edit an existing Template

 
 
If you are currently highlighting a profile you will see additional options at the bottom of the window, creating additional

options for the Parent Template. 

 
•   New Profile - Blank Coding . for use with the parent template

 
•   Copy Profile - Brings up the coding window for the highlighted profile.

 
•   Delete Templates

        Deletes all profiles as well

 
Delete Profile(s)

Note: Deleting the last profile will also delete the Template to which it belongs.

 



 

 



 

 

Capture Template Screen
 
To begin, from the Main Menu go to Acquire >Capture Templates.

 

 
Capture Templates Screen:
 
Multiple Profiles  - Think of the template-profile as a parent-child relationship. At least one profile is required for a

template. Each template can have multiple profiles. The anchor differentiates templates while the identifier discerns the

profile(s).

 
Multi-Page - identifies where the invoice total is located on the invoice image. ‘Single’ signifies the total is always on the

first page of the invoice image; ‘multi-page’ implies the total is always on the last page. This designation has nothing to do

with the number of pages in the invoice image. A multi-page template, for example, may be defined as a ‘single’ page when

the invoice total is located on the first page.

 
PDF Text - In the early learning stage, you may choose to ‘Bypass Failed Doc’ queue if many images are going

unrecognized and you need to code the invoices for export to Timberline. Later on you can modify the template to have any

rejected/unrecognized invoices flow to the Unrecognized Capture Documents queue.

 
ByPass Fail - In the early learning stage, you may choose to ‘Bypass Failed Doc’ queue if many images are going

unrecognized and you need to code the invoices for export to Timberline. Later on you can modify the template to have any

rejected/unrecognized invoices flow to the Unrecognized Capture Documents queue.

 
 
 



 

 

 
Press the “Create” button and the “Acquire Capture Templates” form will be displayed.

 
 
 
It is a Capture Best Practice to define templates for each vendor prior to first processing invoices for that vendor.

 
1. Template Description: Enter a unique template name. 

 

 
 
2. Create Invoice Number - If your vendor does not have an Invoice number, you can still have use Invoice Number by

having Capture create one for you.

 
Invoice Number Options:

 
• From Invoice - The option above, moving the colored square over the invoice # field on your invoice.

 



 

 

• YYYYMMDD99999 - This Option will create an invoice number using the date format selected with a five digit

sequence # starting with 00001.

 
• Prefix YYMM99999 - You can also use your own Prefix with a date and 5 digit sequence # starting with 00001.

 
• Prefix 99999 - An invoice number can be created using a custom prefix and sequential number starting with 00001.

 
• YYYYMMDD - This option will simply use the date as an invoice number.  This is not a good idea if you the Vendor

submits multiple invoices in one day and can result in a duplicate invoice error. 

 
3. Load Single or Multi-Page Invoice - Load the invoice template that you want to use. If you have vendors who send

both single and multi-page invoices, you will need to determine how they should be created. If the balance due is always

on the first page, regardless of the number of pages, select 'Load Single.' If the balance due is always on the last page,

select 'Load Multi-Page' Invoice. When the balance due is not always in the same location you may need to create separate

templates for the vendor.

 
Once you have selected the document you want to set up you will see the Acquire Capture Templates Window: This Window

is divided into Tabs at the Top

 
Anchors

Identifier

Invoice Number

Invoice Date

Balance Due

Description

Job

Commitment

Review

 
The Tabs contain information instructing Capture where to find specific information on your invoice.   

 



 

 

 
3. Date Format

What format is the date on your invoice in? 

 
4. Allow Multiple Coding Records and ByPass Fail

 
a. Allow Multiple Coding Records - Has to be checked if you are using the same invoice format with multiple

identifiers and invoice  coding options.



 

 

b. ByPass Fail Force  - If this box is checked and the Template is found but coding data does not match:

Invoice will be sent directly to Data Entry with the invoice header information ONLYcoded.  No

distribution information will be coded. 

If this box is unchecked, an invoice with a matched Template but unmatched coding will go to the failed

document queue as usual. 



 

 

Anchors
 
From the Acquire Capture Templates Window

 
Anchors consist of at least 10 highlighted words. The Locations and positions relative to each other form the basis of how

Capture recognizes and distinguishes one invoice from another.  

 

 
The selection of anchors is crucial to obtain the highest degree of accuracy. 

 
Some Keys to selecting to Anchors:

 
• Space the anchors across the page.

 
• Pick Anchors that will be in the same position every invoice.



 

 

 
• Use Anchors that will have the same words for every invoice, for example, the Vendor address.Choose words that are

unique to the invoice/vendor. Do not use common words such as invoice, PO, Inc. etc.

 
• Don't use too many Anchors.  It is required to use at least 1 anchor. Best practice calls for using as few anchors as

possible. The ideal situation would be to have one anchor for each template. In some cases, you may need more than one,

two to three at the most.

 
 
 
Words in Blue in the Select Anchor window can be used to create an Anchor. Those highlighed in yellow below have been

chosen as Anchors.

 
To select a word as an Anchor, click on the word until a "cross hair" appears and then drag to the end of your

anchor.  It will highlight when selected. 

 



 

 

 
Capture will let you know when you have selected enough words with the following message. 

 

 
Select Continue to move on to the next tab.

 
 



 

 

Identifiers
 

Identifiers are used to further distinguish one invoice from another when they might be identical

otherwise.  For Example, utility invoices with different account #s, or invoices with the same account

numbers but coded to different jobs, etc. 

 
To select an Identifier for THIS invoice, click the pink box and drag it to the information you want to use as the identifier. 

 
The white squares around the pink box can be used to resize the box to fit the identifier you want to use. 

 

 
Select the "Read the text" option that best suits your identifier. 

 
Verify your selection by referring to the Result. 



 

 

 

 
 



 

 

Invoice Number
 

Click on the colored box and move it to the Invoice# on your invoice document.

 
 

 
If your Vendor does not use Invoice Numbers, you can still use an invoice number by having Capture create an invoice

number for you.

 

 
Invoice Number Options:

 



 

 

• From Invoice - The option above, moving the colored square over the invoice # field on your invoice.

 
• YYYYMMDD99999 - This Option will create an invoice number using the date with a five digit sequence # starting with

00001.

 
• Prefix YYMM99999 - You can also use your own Prefix with a date and 5 digit sequence # starting with 00001.

 
• Prefix 99999 - An invoice number can be created using a custom prefix and sequential number starting with 00001.

 
• YYYYMMDD - This option will simply use the date as an invoice number.  This is not a good idea if you the Vendor

submits multiple invoices in one day and can result in a duplicate invoice error. 



 

 

Invoice Date
 

Select the Invoice Date like the other tabs before this. 

 
Move the colored box to the field that contains your invoice date. 

 
Select the Date Format at the bottom right corner.

 



 

 

Balance Due
 

Similar to the tabs before, drag the colored box to the invoice balance due amount. 

 

 
 
 
 
 
 



 

 

Job
 
Drag the colored box to the field you want to use for Job. In order for the job to be recognized it must be in the Sage

specified format.

 
If you do not want Capture to automatically code your invoice to a job, you can click continue or skip. 

 



 

 

Commitment
 
Drag the colored box to the field you want to use for Job.

 
If you do not want Capture to automatically code your invoice to a commitment, you can click continue or skip. 

 



 

 

Review
 
When you done setting capture template fields you can Review the results of all the tabs in one place. 

 

 
If you need to change any of the template fields, simply return to the tab and change the values. Afterwards select Continue

to save your changes so they appear in Review.

 



 

 

Invoice Coding
 
To Complete the template, click on Invoice Coding at the bottom of the template screen. 

 
Start by entering a unique Profile Name.

 
This Screen allows you to enter additional coding data for the invoice and the distribution.  You can specify default data

where it is NOT specified on the invoice.  Profile Name, Identifier and Vendor are REQUIRED and must be filled in for you

to save the profile. 

 
The Three white browse dots in green boxes look up data in Sage 300 CRE.  

 



 

 

 
Invoice Retrieval Rules will always take precedence. 
 
• If you code a template with a job and tax group, different than the tax group on the job record in Sage 300 CRE, the

invoice will be changed to match the job record in Sage 300 CRE.

 

 

OCR Values take precedence over Invoice Coding Data:

If you have a template with Job and/or Commitment fields found, those values will be used instead of the Job and/or

Commitment in Invoice Coding Data.

 



 

 

 
 



 

 

Copy Templates
 

 

 
 



 

 

Capture Licensing File
 
 
Licensing for the OCR function is linked to a user and a separate Glyphreader license is required for each user that will be

processing Capture documents. Whichever workstation the licensed user is on is considereed the Capture procedssing

workstation. While documents for Capture can be acquired from any TimberScan workstation or Citrix or Terminal Server

instance, the OCR processing can only be done on a licensed workstation. Processing on Citrix or Terminal Server would be

a violation of our license agreement with Atalasoft.

 
The TimberScan license file (TimberScan.lfs) will need to be modified to include Capture. In addition, we store items 2, 3

and 4 below in a separate XCAT file. The following data is included:

 
1.     A Flag indicating that Capture is authorized for the client

2.     A Capture Expiration Date for trial versions

3.     The number of workstations that can be used for OCR processing

4.     The Capture Anniversary roll-over date

 
Encrypted tables in the TimberScan SQL database will hold information pertaining to each OCR licensed workstation. Other

encrypted tables will contain information pertaining to running document counts, annual allowable documents and any

overage processing documents remaining.

 
Licensing of the individual for OCR processing is a menu item in admin > User Maintenance. When selected, the software

will check to make certain that there are still OCR licenses available then prompt the user if they want to license that

user. Upon an affirmative response the information will be recorded in SQL. If the user is already licensed, the menu item

displayed will be grayed out.

 
 



 

 

Capture Workflow
 

Acquire Capture Invoices
 

Data Entry for Capture Invoices
 

Unrecognized Capture Documents
 

Troubleshooting Tips
 

 



 

 

Acquire Capture Invoices
 

All TimberScan users with the Acquire permission may Acquire Capture Invoices but only those licensed for Capture

Processing may create Templates and both Acquire and Process Capture Invoices. 

 
Each user that is licensed to Process Captured Invoices is specifically identified by a checkbox in admin > User Maintenance.

 
To Acquire Capture Invoices, Acquire > Acquire Capture Invoices

 

 
 
 
The Acquire Capture Invoices Screen looks identical to the normal Acquire screen except for the Title bar "Acquire OCR

Images" and Image Type can not be changed.

 
Also, Deskewing will occur based on User Settings. In addition, the user can choose the Deskew setting when Acquiring

even if the settings have not been checked in admin.

 



 

 

 
Because Capture Acquire is only for regular invoices, this option is set as a default and cannot be changed. Documents for

all other image types must be acquired via AIM or the standard acquire process in TimberScan.

 

 



 

 

 
You can separate pages acquired in a single pdf file into multiple invoices. Right mouse click on an invoice to display a

selection menu. In the screenshot below, you can separate the 7 pages into 4 invoices for the same vendor by selecting the

‘Pages per file’ option and entering a 2:

 
 

 
 

 



 

 

 
 
 
Clicking on Process will invoke the Capture Matching Process behind the scenes.  IMPORTANT: Do not exit out of the

Acquire window until you receive the message summarizing what has been processed. Exiting from the window before the

message is displayed will not save the documents and they will not be moved to Invoice Entry.

 
 
 



 

 

Data Entry for Capture Invoices
 
Now we can open the Invoice in Invoice Entry Window and see the results of our Capture Matched Invoice. The Fields set

up in Data Coding will be highlighted on the image and the corresponding date entry fields color coded to match.  You may

change any column necessary. Capture will prefill only with the fields indicated on the template. To complete invoice coding

you may need to tab through the distribution fields in order to prefill Sage defined data such as the GL account number. You

can always override or add to fields that Capture has prefilled.

 
Once the invoice is accepted in Invoice Entry it will be treated like any other invoice in the Timberscan data entry system.  

 



 

 

Unrecognized Capture Documents
 
If Acquired Capture Invoices are NOT recognized, they will be found in the Unrecognized queue for further review.

 

 
The Failed Invoices can be filtered by reason:

 
Template Not Found:  The Captured invoice could not be matched to a Capture Template and Profile. 

 
Low Confidence: This is indicative of an "Incomplete" match.

 
Coding Data not found:  The image has been matched but the specific invoice coding identified on the invoice does not

match any coding on any capture profile for this Template. 

 
Duplicate Invoice: Capture recognizes the invoice as a duplicate.

 
 
Options to deal with the Unrecognized Capture Invoices.



 

 

 

 
Delete:  If this is a duplicate then you will want to delete it.

 
Move to Data Entry:  If this is a rarely used Vendor you may want to move the invoice to Data Entry to be coded there. 

 
Define New Template: If this will be a commonly used Vendor you may want to create a new template. 

 
Use Existing Template:  Use an existing Template it the template was defined in the Capture Templates Window.

 
 
 
 
 
 
 



 

 

 
 
 



 

 

Troubleshooting Tips for Capture
 

     Once a document has been successfully recognized and moved to TimberScan data entry, select

the F8 key to display a log of Capture notes.

 
     Capture maintains a log file similar to the TimberScan user log. These files are located in the

Timberscan\LogFiles directory on the server. The file name begins with the TimberScan user ID,

followed by OCR and the date. The extension is log.

 
     There are three reasons a document will move to the ‘Unrecognized Capture Documents’ queue:

1) The template is not setup or recognized.

            2) A coding profile is not found

            3) The invoice already exists (duplicate invoice)    

 
ADDITIONAL TROUBLESHOOTING TIPS

 
1)     When creating a template and the result does not read the field, click on the anchor tab and see if that field is

highlighted in green. If that field is black, OCR will not read it. However, while it might be in black on that sample invoice, it

may be read when processed because of the PDF text layer.

 
2)     If invoices are successfully routed to data entry but no fields are coded, try selecting different anchors for that

template.

 
3)     When selecting anchors, try not to select something with too many dashes, or an area near logos, handwriting or

graphics.

 
4)     Make sure that the anchors you select are unique for that vendor. If your invoice is accessing the wrong template, go

back and change your anchors. The anchor you selected is one that appears on multiple templates. You want to select one

that is unique for that vendor. Generally vendor name or address or phone numbers or web address work best.

 
5)     You do not need to use new unprocessed invoices to create  your templates. You can use any invoices from that same

vendor as long as it is in the same format (either .pdf or .tiff) as the sample that was used to create the template. However,

to test the results of the template, you will need to Acquire a new invoice.



 

 

 
6)     Make sure your sample is typical for that vendor. If a vendor has multiple invoice formats, you can create multiple

templates for that vendor. However you will need to find and select unique anchors for the different templates.

 
7)     If Capture is consistently not reading a field, select the item in a different location for the template. For example,

amount due might appear in several areas on the sample. If the amount due in the body is floating or not able to be read,

use the one on the payment stub.

 
8)     If the other fields are not read, then compare the highlighting on the image screen with what is actually coded to see

where it might be off. You might need to tweak the range in the template

 
9)     If you find that all the invoices for that vendor are off in exactly the same way (for example, the highlighted fields

are lower or higher than the actual fields), then you might need to go back to the template and reload a different sample

invoice. You would not need to recreate the template but just need to process the new sample and select all the fields

again.

 
10)     Sometimes when you normally will receive an invoice for a vendor where job ID is indicated but on the sample, it is

blank, put the highlighting in that field anyway. You don't have to skip as you can still select the next item at the top of the

menu. If you do not need the field, move the highlighter to a blank area and click 'Skip'.

 
11)     If you have leading zeros in invoice number and you did not check remove leading zeros (in admin > Settings >

Systems Settings>Capture settings), uncheck the Remove Spaces box on the top of the create Capture screen otherwise

Capture will drop off leading zero in invoice number.

 
12)     If you have a hyphen or dash in invoice number, Capture will not pick up that hyphen or dash. Uncheck Remove

Spaces will leave a space in the invoice number where the hyphen/dash normally appears.

 
13)     Make sure that your highlighting range is wide enough to accommodate larger numbers or amounts otherwise

amounts will be truncated. However, if the highlighting range is too large, OCR can pick up values close to the box. So if

there are values adjoining the field, make the range as tight as possible even if it appears to truncate the field.

 
14)     If  the fields in the invoice are very close together and tight, zoom in to give a little more control in selecting.

Remember to make sure highlighting does not extend outside the field on top or bottom otherwise pdf text layering might

pick up the adjoining fields.



 

 

 
15)     When creating a template, if you initially skipped a field and want to go back to select something for that field, make

sure to click continue on the bottom of the screen. Then in Review, you should be able to see the new field in the summary.

 
16)     If certain fields are not OCR readable, try clicking on the Deskew button. This feature is available beginning with

version 3.8.3.45. This should optimize the document. Now see if the field is readable and highlighted in green. If it is not,

you can reload the original.

 

17)     If you are working with a standard form, either AIA or a form created by your company that every vendor needs to

submit, create one template for that form with multiple profiles for the different vendors.

 
18)      Try logging into another workstation and test the template. Sometimes, the issue might be on your workstation.

 
19)     When need to create multiple profiles, first create template for single profile. Once you test and template works, then

add the additional profiles.

 
NOTES:

Any TimberScan user who has the ‘Acquire Invoices’ permission can also acquire Capture invoices. However, ONLY a

licensed Capture user can process Capture invoices.

 
Templates are created by data folder. While templates may be copied from one data folder to another, the invoice coding

on the template may need to be modified.

 
If the invoices in the pdf are all an equal number of pages, you can select the middle option to separate the invoice into X

number of pages

If the invoices in the pdf have variable number of pages,  you need to separate them manually

 
In the Acquire process, you can drag and drop a page within an invoice that has been separated but you cannot drag and

drop a page from 1 invoice to another nor delete a page.

 
The reason for this is that when you Acquire the invoice, you are separating the pages on the Tiff file in the TimberScan

Acquire screen.  While TimberScan is able to “mark” the pages as new invoices on the pdf as you are doing that in the

Acquire screen, what can’t be done is pages that you might move on the Tiff file cannot be moved in the same way in

the original PDF.  If you do that, the way the pages are now displayed in TimberScan Acquire would not be in the same



 

 

order as the PDF, therefore when Capture is reading the PDF text layer from the original PDF, it would not be looking at the

same page that was moved on the Tiff.  The same is true that if you delete a page in the Acquire process, that page is not

removed from the original pdf.  If a page needs to be removed, it can be done in the Invoice Entry Screen.

 
 
One very important diagnostic tool in understanding the success or failure of template/coding recognition is the Capture

log.  Capture logs are located in the client’s LogFiles folder and appear as follows: Files start with the user login ID followed

by a “.” and the word OCR.  Pressing F8 from the data entry grid for a captured invoice will display the log as well.   Any time

Capture does not return the expected results, the first step is to look at the Capture log file for that user’s session.

 
Many times the log will give insight into something specific within the scanned document and allow you to  work on

tweaking the template.  For instance, if the job is not recognized you may decide to pull the job from a different location on

the invoice or hard code it in the coding profile.  It will also yield further visibility into the recognition process.

 
It is also important that the Capture log be attached to any Capture cases you create on the customer portal.

 
 
 



 

 

Best Practices and Additional Tips
BEST PRACTICES
1.     Use electronically produced pdf images whenever possible

The success of OCR technology depends on the quality of the image. As noted above, the best results are obtained when

you use pdfs that are electronically produced (those emailed to you or downloaded from a vendor’s site). When invoices

are scanned, the scanning process often degrades the quality of the image.

 
2.     When scanning, be sure to scan in black and white at 300 dpi.

 
3.     Verify System Settings in TimberScan admin:

     • Invoice Recognition Percent – set to 50

     • Image Resolutions for Capture and Final – set to 300 dpi

     • Remove Leading Zeroes from Invoice Number – check if your vendors use leading zeroes on invoice numbers and you

do not want them to prefill on Capture invoices

     • Accounting Date Usage – select an option to default on Capture invoices

     • Default Invoice Date Format – select a format to default on Capture invoices

 
4.     Creating Capture templates is a learning process. Keep the number of templates small and manageable; test out each

template to ensure Capture can read it effectively. Before creating a large number of profiles for a vendor or a large number

of templates, consider limiting the number of profiles (and/or templates) and testing each for success. Spend your time

learning to be an efficient template producer.

 

TIP: There is a “trade-off” with creating templates and profiles. Do you want to spend your time creating, for

example, 50 profiles for one vendor or create multiple templates for many vendors?

 
5.     In the early learning stage, you may choose to ‘Bypass Failed Doc’ queue if many images are going

unrecognized and you need to code the invoices for export to Timberline. Later on you can modify the template to

have any rejected/unrecognized invoices flow to the Unrecognized Capture Documents queue.

 
ADDITIONAL TIPS:

 
     Look for instructions and messages as well as your results in the left panel of the create templates

window.



 

 

     Keep the box size you draw on a template as tight as possible. Capture’s pdf text layering reads the image

multiple times and can pick up ‘extraneous’ markings which may cause the template to go unrecognized.

 
     The default for reading text in a box – ‘Closest to the center of the box ‘– usually works best. When the

location for the Balance Due varies (what we call a floating total), draw a long box down the page and choose

‘Closest to the bottom of the box.’

     When skipping a tab, you do not have to position the colored box in a blank space on the template image.

You may skip ‘Invoice Number’, for example, if your invoice numbering schedule is so unique it does not match

any of the options in Capture.

     Drag the mouse from left to right to easily highlight multiple words.

     To remove highlighted text, simply highlight the text again and mouse click.

     Use the Ctrl + mouse wheel, like you do in TimberScan, to zoom in and out of an image.

 
TROUBLESHOOTING

     Once a document has been successfully recognized and moved to TimberScan data entry, select the F8

key to display a log of Capture notes.

 
     Capture maintains a log file similar to the TimberScan user log. These files are located in the Timberscan

\LogFiles directory on the server. The file name begins with the TimberScan user ID, followed by OCR and the

date. The extension is log.

 

There are three reasons a document will move to the ‘Unrecognized Capture Documents’ queue:

1) The template is not setup or recognized.

     2) A coding profile is not found

     3) The invoice already exists (duplicate invoice)    

 



 

 

TimberScan Productivity Tools
 

• eForms
 



 

 

eForms for TimberScan
 
 

eForms Video

https://www.dropbox.com/s/l1iw282cwjw0dbr/Timberscan%20eForms%20Final.mp4?dl=0
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